# Contents

Introduction ..................................................................................................................................... 9

Section 1: Safety guidelines .......................................................................................................... 10
   Lifting and carrying ................................................................................................................... 10
   Using step stools .................................................................................................................... 10
   Using cutting tools .................................................................................................................. 11

Section 2: General handling guidelines ........................................................................................ 11

Section 3: Preservation ................................................................................................................. 14

Section 4: Accessioning ................................................................................................................ 16

Section 5 – Processing .................................................................................................................. 18
   Preliminary sorting .................................................................................................................... 18
   Make a box list .......................................................................................................................... 20
   Arrange the records ................................................................................................................... 22
   Numbering and abbreviations .................................................................................................. 28
   Separating items ....................................................................................................................... 29
   Restricted items ......................................................................................................................... 29
   Special media ............................................................................................................................ 30
   Storage ....................................................................................................................................... 31

Section 6: Naming guidelines ....................................................................................................... 32
   Subject headings ....................................................................................................................... 32
   Name authorities ....................................................................................................................... 32
   Date and time formats ............................................................................................................... 32
   Local controlled vocabulary for physical description ............................................................... 33
   Local controlled vocabulary for subject access points ............................................................. 34
   Electronic file naming ............................................................................................................... 36

Section 7: Description ................................................................................................................... 38
   RAD higher-level description ................................................................................................... 39
   Finding aids - example of a series and file list ......................................................................... 43
   Finding aids - example of an archival description ..................................................................... 44
   Template for archival description ............................................................................................. 47
Section 16: Instructions for making a PDF/A ................................................................. 123
Section 17: Digitizing audio .......................................................................................... 125
  Standards for audio ...................................................................................................... 125
  Gathering information for audio digitization .............................................................. 126
  Condition assessment .................................................................................................. 127
    Table 4 Signs of damage ......................................................................................... 130
Section 18: Workflow for audio digitization ................................................................. 131
  General workflow for audio digitization .................................................................. 131
    File naming .............................................................................................................. 131
    Preparing playback equipment .............................................................................. 132
  Recording ................................................................................................................... 133
    Testing audio .......................................................................................................... 133
    Using Audacity software ....................................................................................... 134
    Adding metadata: required fields ......................................................................... 149
      Table 5 Metadata chart ....................................................................................... 151
  Splicing instructions ................................................................................................ 152
    Figure 1: An audio cassette .................................................................................. 152
    Figure 2: Anatomy of audio cassette .................................................................... 153
    Figure 3: Equipment ............................................................................................. 153
    Figure 4: Broken tape .......................................................................................... 154
    Figure 5: Placing tape .......................................................................................... 155
    Figure 6: Trimming left side ................................................................................ 155
    Figure 7: Trimming right side .............................................................................. 156
    Figure 8: Matching ends at the angle ................................................................. 157
    Figure 9: First piece of splicing tape .................................................................. 157
    Figure 10: Before smoothing ............................................................................. 158
    Figure 11: Reverse side taping .......................................................................... 158
    Figure 12: Winding .............................................................................................. 159
  Convert a born digital WAV file to an MP3 file ...................................................... 159
Section 19: Digital preservation .................................................................................. 161
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formats</td>
<td></td>
<td>162</td>
</tr>
<tr>
<td>Open Archival Information System model</td>
<td></td>
<td>162</td>
</tr>
<tr>
<td>Section 20: Workflow for digital preservation</td>
<td></td>
<td>163</td>
</tr>
<tr>
<td>Digital preservation system overview</td>
<td></td>
<td>163</td>
</tr>
<tr>
<td>Accession numbers</td>
<td></td>
<td>163</td>
</tr>
<tr>
<td>Archives submission system</td>
<td></td>
<td>164</td>
</tr>
<tr>
<td>Workflow for digital preservation</td>
<td></td>
<td>167</td>
</tr>
<tr>
<td>How to use Data Accessioner</td>
<td></td>
<td>171</td>
</tr>
<tr>
<td>How to use DROID</td>
<td></td>
<td>172</td>
</tr>
<tr>
<td>Make profile</td>
<td></td>
<td>174</td>
</tr>
<tr>
<td>Run DROID</td>
<td></td>
<td>174</td>
</tr>
<tr>
<td>Create reports</td>
<td></td>
<td>175</td>
</tr>
<tr>
<td>How to make an access copy</td>
<td></td>
<td>176</td>
</tr>
<tr>
<td>Run Metadata Transformer</td>
<td></td>
<td>176</td>
</tr>
<tr>
<td>Normalization</td>
<td></td>
<td>177</td>
</tr>
<tr>
<td>How to use Bagger</td>
<td></td>
<td>177</td>
</tr>
<tr>
<td>Run Bagger</td>
<td></td>
<td>177</td>
</tr>
<tr>
<td>Describe digital records</td>
<td></td>
<td>179</td>
</tr>
<tr>
<td>Run integrity checks</td>
<td></td>
<td>181</td>
</tr>
<tr>
<td>Creating disk images</td>
<td></td>
<td>181</td>
</tr>
<tr>
<td>Section 21: Archiving websites and social media</td>
<td></td>
<td>182</td>
</tr>
<tr>
<td>Using the Internet Archive Wayback Machine</td>
<td></td>
<td>182</td>
</tr>
<tr>
<td>Using Conifer</td>
<td></td>
<td>183</td>
</tr>
<tr>
<td>Metadata fields for websites</td>
<td></td>
<td>184</td>
</tr>
<tr>
<td>Section 22: Records management for archives</td>
<td></td>
<td>185</td>
</tr>
<tr>
<td>APPENDIX I</td>
<td></td>
<td>187</td>
</tr>
<tr>
<td>Common series</td>
<td></td>
<td>187</td>
</tr>
<tr>
<td>APPENDIX II</td>
<td></td>
<td>188</td>
</tr>
<tr>
<td>Types of metadata</td>
<td></td>
<td>188</td>
</tr>
<tr>
<td>Metadata standards</td>
<td></td>
<td>188</td>
</tr>
</tbody>
</table>
Index ........................................................................................................................................... 238
Introduction

While all the examples, and the work processes in this manual are drawn from the Congregation of the Sisters of St. Joseph in Canada consolidated archives, the same processes apply to other archives. While each archive may have a different system of arrangement, each should follow the archival principle of respect des fonds, use a content standard, such as the Canadian Rules for Archival Description known as RAD for description, and ensure preservation and safe handling of records.

“None of us is as smart as all of us.” ~ Dublin Core Metadata Initiative. This manual will always be in beta. It undergoes revision whenever someone finds something worth changing. Thanks to our wonderful, amazing practicum students for their comments and suggestions. A huge debt of gratitude is owed to Chris Gonzaga and Lisette Costa formerly of the City of Toronto Archives, for their patient guidance and willingness to share their expertise in helping us understand image digitization. We are grateful to Krista Jamieson for her advice on audio digitization, and Jennifer Vickers for her work on developing our audio digitization workflow. We are hugely indebted to Ben Lalande for his technical expertise on helping build our digital preservation system, and to Grant Hurley for his feedback on our workflow. And we are very grateful to Lisa Macklem, Western University, for reviewing the copyright section and policy. We are thankful that Mary Grace Kosta devoted 12 years to writing and revising this manual. And lastly, thanks to the Sisters of St. Joseph for their continued support.

We are happy to receive feedback. Please send your comments, and report any errors or omissions to the Archivist, Congregation of the Sisters of St. Joseph in Canada, csjarchives@csjcanada.org
Section 1: Safety guidelines
Lifting and carrying

Prevent injury to your lower back. Follow these rules for lifting objects:

- Place your feet so that they are shoulder width apart with the load between them.
- Keep arms and elbows close to sides.
- Bend your knees and hips keeping your back straight.
- Hold the load close to your body.
- Lift smoothly and slowly. Use your thigh and leg muscles, not your back.
- Pivot with your feet.
- Make sure your path is clear and that you can see over the load.
- Put the load on the edge of a shelf and push it into place.
- Push a load rather than pull it.
- Always use a cart for a heavy load.

Using step stools

- Carry objects so that you have a clear view and can climb up and down.
- Keep hands above knee level when reaching down.
- Keep navel in center of stool when reaching sideways.
- Don’t lean backward.
- Don’t stand on tiptoe when reaching up.
- Keep both feet on stool.
- Lift object below shoulder height with two hands when it is up to 12 kg (26 lb.).
- Lift object above shoulder height with two hands when it is up to 8 kg (18 lb.).
Using cutting tools

- Keep the blade sharp because dull blades are more likely to cause your hand to slip.
- Keep the blade as short as possible.
- Retract the blade when not in use.
- Cut at an angle away from your body so your hand moves away from your body if it slips.
- Apply a firm pressure, use your arm to move the blade deliberately, and concentrate on the material you are cutting as you always watch the blade.
- You can cut half-way through, flip the material, and cut the other side. Or you can use several shallow cuts rather than one deep cut. Either way is safer.
- Keep your thumb away from the blade.
- Put your other hand away from the blade to avoid cutting it.
- Expose the blade to the next hatch mark and grip the blade with pliers to remove it.
- Store used blades in sharps container.

Section 2: General handling guidelines

1. No food or drink, or candy, or chewing gum is allowed in the archive.

2. Wash hands before working in the archive and after eating. Don’t use hand cream. Remove jewelry. Avoid touching your hair and face when you work.

3. Use only soft pencils, not pens, in the archive. Use a white Staedtler eraser only. You can cut off the blackened bits using an Olfa knife.

4. Always wear cotton or accelerator free nitrile gloves when handling photographs, textiles, and artifacts. Damage results when oils and acids on your hands get on the materials, as shown in these pictures:
5. Handle all photographs and negatives by the edges only. Do not pick up artifacts by their handles but support these from the bottom.

6. Store materials in acid and lignin free, legal size, full tab file folders. When materials are folded or stored in acidic enclosures, paper tears and becomes brown and fragile, as shown in these pictures:
7. Label the enclosure, not the item, using a pencil. Do not write on anything that has items within or below it, such as on an envelope containing a photo, or on a folder on top of another folder.

8. Cover items not in use with paper to avoid exposure to light, dust, and water.

9. Do not use PVC (polyvinyl chloride) plastic, tape, post-it notes, staples, rubber bands, metal paper clips, rubber cement, cardboard, and coated plastics. These pictures show damage from rubber bands and tape:

You can check if plastic is safe by sending it to a lab for a photographic activity test, but this costs money. If the plastic has a recycling symbol, you can also check it. The only safe plastics to use are:

- polyethylene such as ziplock bags (HDPE 2 or LDPE 4)

- polyester like mylar film (PET 1)

- polypropylene like VHS boxes (PP 5)

10. Prepare the work area in advance and plan your route before moving objects. Check the object for damage before moving. Always use two hands. Support any object by holding from the bottom or using a support such as matboard or coroplast.
11. Do not set heavy items on top of other items. Do not let items hang off the sides of the work surface. Do not put items or file folders in your lap.

12. When removing an item from a folder, remove the folder from the box or cabinet before removing the item.

13. Remove books from the shelf by grasping the sides, not the spine.

14. Never use the automatic feeder on photocopiers or scanners.

15. Keep your work area clean. Dust off eraser crumbs using a brush, not your hands.

Section 3: Preservation

1. Check that there is no pest or mold infestation.

2. Remove paper clips, rubber bands, coil bindings, binders and folders made of acidic materials. Leave fasteners that are of historic value such as ribbons with seals. Although we don’t usually remove staples, if you must do so, use a micro spatula, not a staple remover. These pictures show why we remove metal fasteners:
3. Flatten items. Some items may need humidification to flatten. Do not try to flatten fragile or brittle items or photographs. These will need conservation.

4. Rehouse photographs into unbuffered envelopes or mylar sleeves after dusting with a soft brush.

5. Store bound items spine down in boxes or on the shelf.

6. Separate newspaper clippings from other materials with an acid free paper sling or move to a separate folder.
Section 4: Accessioning

Accessioning is a way to create a preliminary inventory of the materials received, as well as a shelf list.¹

When new material comes into the archive, you want to ask these questions:

a) Who created the material?

b) Who donated or transferred the material?

c) What is the custodial history and did this cause any physical changes to the records?

d) Are these the original folders?

e) Is the material in the original order?

f) Are there any conservation issues?

g) Are there any access restrictions, e.g., imposed by the donor, due to privacy, or due to the fragility of the materials?

Make sure you complete a *Deed of Gift* agreement if the incoming material is a donation. This establishes legal control over the material. If the incoming material is a transfer, there should be a *Records Transfer to Archives* form with it. Give each new lot of material that is received, whether by donation or transfer, a new accession number. Each new donation or transfer is assigned an accession number which applies to the whole lot, not to separate items in the lot. Every accession number assigned must be recorded in the accession number log. For example:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2013-01</td>
<td>Jubilee photographs for 2013</td>
</tr>
<tr>
<td>2013-02</td>
<td>Associate newsletters 2012</td>
</tr>
<tr>
<td>M2019-01</td>
<td>Jamaica Annals</td>
</tr>
</tbody>
</table>

¹ This discussion benefitted from the Society of American Archivists Arrangement and Description workshop, Pam Hackbart-Dean and Anne Ostendarp, 2021.
Create an accession record in the AtoM database. The accession record is a skeletal record which gives contextual information about the donation or transfer.

Fill in these fields in the AtoM database by clicking on the + button at the top and choosing *Accession records* from the drop-down menu:

You will see several areas:

Under **Basic info** enter data in these fields:
- Accession number
- Acquisition date
- Immediate source of acquisition
- Location information (give a temporary location which may be changed later after processing is complete)
Under **Administrative area** enter data in this field:

- Dates

When you are finished click on the **Save** button at the bottom.

**Section 5 – Processing**

**Preliminary sorting**

As you create a skeletal accession record, you also begin processing. How long will processing take? You can usually estimate 25-35 hours per box (15” x 12” x 10”).

Remember the guiding principles of archives known as *respect des fonds*. This is the principle that archives from different creators (the provenance) should not be intermingled, and that the original order in which materials were created and used should be respected.

You start by making a box list when the material is accessioned. As you work, make notes on what series you identify, and what date ranges you encounter. This will be the basis of your arranged series and file list. Follow these steps:

1. Look over the accession and make notes:
   a. Identify the order and organization of files, if any.
   b. Identify the types of materials but do not rearrange yet.
   c. Note the beginning and end dates of the entire accession.
   d. Do a rough sort on paper by series or record type. Keep the folders as they are. Note duplicates and personal information.
   e. If there is anything you are not going to keep, make a note in the accession record.

---

2 This discussion benefitted from the Society of American Archivists Arrangement and Description workshop, Pam Hackbart-Dean and Anne Ostendarp, 2021.
2. Remove materials from the box, making sure not to disrupt the original order of the records, if there is any. Do basic preservation work on the materials as noted in the preceding section.

3. Continue sorting. Remove any unwanted materials such as duplicates, blank sheets of paper, plastic, or duo tang folders. Discard these materials.

4. As you sort, collect information about the creator, subject, functions documented, significant people, places, and events, major correspondents. It can help to have an organizational chart, resume, retention schedule, or published works.

5. Note if there are any gaps.
Make a box list
The next step is to make a box list.

6. Re-folder if needed. You may need to put items in one file in one or more separate
folders if one folder won’t hold them all. In this case, number the folders as follows: 1 of
2, 2 of 2, and so on.

7. Improve or supply file titles where needed and pencil these onto folders. Remember these
points when you name files:

a. Do not repeat the higher-level title in the file name, e.g., Mother Margaret
Coughlin series – Mother Margaret Coughlin correspondence with Bishop should
be simply Correspondence with Bishop.
b. Use upper case only for the first letters in proper names and first word in a title,
and lower case for all following words in the title.
c. Do not put supplied titles in square brackets. Give a phrase that describes the
contents, and if there is different types of material in a file, note in order of
predominance, e.g., Photographs and memorabilia 1970-1990.

8. Avoid special characters in file titles like ampserand &, square brackets [ ], and slash /
because these show up in the URL in AtoM (the archival description database).


The rules given in the ANSI/ARMA 1-1990 standard should be followed when having to supply
new titles. Hyphens and apostrophes may be used but not periods. Use a hyphen after a date to
show the date is open (e.g., to the present). Only capitalize proper names and the first word of a
title.

Use religious title as written

Pope John Paul II
Sr. Mary Jo Fox

20
Use official name St. Paul’s Hospital not Rimbey Hospital
Spell out abbreviations Worker’s Compensation Board not WCB
Use only local approved abbreviations Use RAD abbreviations (RAD B.14) for locations
Delete the word “the” Keg Restaurant The
Avoid slang, ambiguity, colloquialisms Alcoholism not Drunkenness
Be consistent with subject terms Use Sisters but do not use Nuns and Women Religious
Put date last St. Joseph’s Hospice 2013

If there is a title on the folder, check that it accurately reflects the contents of the folder. Record the date range of materials in the folder in the title. Use upper case only for the first word in the title and proper names. Be sure to record any title changes on the box list.

When writing the title, use RAD abbreviations (RAD B.14) for locations. Put any additions of your own in square brackets.

<table>
<thead>
<tr>
<th>London, Ont. not London, ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>2012- date followed by hyphen for an open date</td>
</tr>
<tr>
<td>School of Music [1965]</td>
</tr>
</tbody>
</table>

Using a soft pencil, write the file title on the folder tab or envelope. The title on the folder must match the title on box list, including capitalization and punctuation.

10. Put the folders back in the box in the original order and make a list of all the folders in the box. Add the box list to the accession record. See example of a partial box list below:


**Accession box 3**

Federation Surveys  
London Associates Reports to Federation  
Federation correspondence and reports 1991-2012 [1/2]  
Federation correspondence and reports 1991-2012 [2/2]

Dialogue correspondence 2011  
Agrégée Membership 2006-2011  
Associate leadership correspondence 2016-2017  
Leadership process correspondence 2014-2015  
Animator Team endorsement 2000-2010  
Animator endorsement 2011  
Animators’ ballots and correspondence 2011

**Arrange the records**

The next step is to arrange the records and make a finding aid. Remember the hierarchical arrangement we use in archives. This diagram may help:

---

**Archival arrangement**

11. Determine the level of arrangement. You can arrange just at the fonds level for small accessions, and not arrange into series and subseries. However, if the accession is large, or lacks original order, you can do more in-depth arrangement to the series and file levels.
12. Make a series and files list. To identify the series in a fond or sous-fonds, look for separate activities carried out during business or daily life. A series is made up of records that were created, received, or used in the same activity. Try to see what series or subseries were originally there, in other words if the materials were already arranged into some order.

13. Only physically re-arrange materials, if necessary, for example to restore chronological order of meeting minutes. Do not spend time on arranging the items within a folder. Make sure you make notes about whether you were able to keep the original order of the materials or had to impose an order. You will need this information for the archival description.

Series may reflect aspects of a creator’s life, or a similar source or common activity, or similar content. Here are some common types of series and subseries:

a) *Activity or function*: minutes, land deeds, correspondence
b) *Physical qualities*: photographs, maps, bound volumes
c) *Creator*: family member, an office in an organization, a corporate branch
d) *Time frame*: retirement years of an individual, term of public office
e) *Place*: a member unit within a larger region
f) *Artificial or assembled*: photographs, audiovisual material, printed material, digital media

Subseries are units within a series which contain files. You will always have two subseries if you have any, otherwise you just have a series. Files are units within a series and may be organized chronologically, numerically, alphabetically, or by topic. Items are individual records within a file, such as a letter or map. See Appendix I for types of common series.  

---

3 This discussion benefitted from the Society of American Archivists Arrangement and Description workshop, 2021.
Artifacts can be a separate series. Digital records can be a separate series or subseries (see Section 20). Accruals can be added as a separate series (see Section 7).

_Do not include dates in the fonds title_. The fonds title should be the name of the creator of the fonds. It is important that the _official_ name is used. For example, Rimby Hospital is the common name, but St. Paul’s Hospital is the official name.

Do not put dates in the higher-level title, e.g., St. Joseph’s Hospital, Galahad (Alta.). without any dates.

The series titles should reflect the function/activities that created each series. _Do not repeat information given in the fonds title in the series title or information given in the series title in the subseries title._

If there is no original order, you need to impose an order. In this case, choose to place files in ascending order in the series, e.g., Yellowknife annals 2012 would precede Yellowknife annals 2013 on a file list.

Remember a _file_ is an intellectual construct that can consist of more than one folder or enclosure. And remember that an _item_ does not have to have a corresponding file, but it may have.

14. Physically arrange the materials into series and files and number the series and files.

   Revise the box list to create a series and file list (known as a finding aid). See example of the first draft of arranged series and file list below:
F01 SF17 Associates Program DRAFT ARRANGEMENT

Accession box 3

Federation
Federation Surveys
London Associates Reports to Federation
Federation correspondence and reports 1991-2012 [1/2]
Federation correspondence and reports 1991-2012 [2/2]

Leadership
Dialogue correspondence 2011
Agrégée Membership 2006-2011
Associate leadership correspondence 2016-2017
Leadership process correspondence 2014-2015
Animator Team endorsement 2000-2010
Animator endorsement 2011
Animators’ ballots and correspondence 2011

Check over the series and file list. This is an important step before labelling, to make sure your numbering is correct. Also, this is your chance to make sure the fonds title, series titles and file titles do not duplicate each other, and that date ranges are correct. The titles on the file list must exactly match the titles on the physical files.
Make the labels. Put the complete fonds, sous-fonds, series, subseries and file number. (See the section on numbering and abbreviations below.) Underneath the fonds-sous-fonds-series-subseries-file number, put the fonds, sous-fonds, series, and sub-series title. The file title should already be printed in pencil on the folder, so you don’t add it to the label. Abbreviate the fonds title for *Congregation of the Sisters of St. Joseph in Canada-London* as *CSJ London* and for the *Congregation of the Sisters of St. Joseph in Canada* as *CSJ Canada*. Here is an example:

<table>
<thead>
<tr>
<th>F01-</th>
<th>SF10-</th>
<th>S004-</th>
<th>01-</th>
<th>01</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSJ London-Sr. Margaret Ferris-Education-Diplomas and certificates</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(The file title “University of Western Ontario B.A.” is already on the folder.)

Apply the label with the number on the right front corner of the folder.

Here is an example of a final series and file list:
<table>
<thead>
<tr>
<th>Box 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>F01-SF17-S010</strong> Federation</td>
</tr>
<tr>
<td>F01-SF17-S010-01 Federation Surveys</td>
</tr>
<tr>
<td>F01-SF17-S010-02 London Associates Reports to Federation</td>
</tr>
<tr>
<td>F01-SF17-S010-03 Federation correspondence and reports 1991-2012 [1 /2]</td>
</tr>
<tr>
<td>F01-SF17-S010-03 Federation correspondence and reports 1991-2012 [2 /2]</td>
</tr>
<tr>
<td>F01-SF17-S010-04 Federation meetings May 2016, May 2017 [2020-4]</td>
</tr>
<tr>
<td><strong>F01-SF17-S011</strong> Leadership</td>
</tr>
<tr>
<td>F01-SF17-S011-01 Dialogue correspondence 2011</td>
</tr>
<tr>
<td>F01-SF17-S011-02 Agrégée Membership 2006-2011</td>
</tr>
<tr>
<td>F01-SF17-S011-03 Associate leadership correspondence 2016-2017</td>
</tr>
<tr>
<td>F01-SF17-S011-04 Leadership process correspondence 2014-2015</td>
</tr>
<tr>
<td>F01-SF17-S011-05 Animator Team endorsement 2000-2010</td>
</tr>
<tr>
<td>F01-SF17-S011-06 Animator endorsement 2011</td>
</tr>
<tr>
<td>F01-SF17-S011-07 Animators’ ballots and correspondence 2011</td>
</tr>
</tbody>
</table>
Numbering and abbreviations

Use these conventions for numbering and abbreviations.

<table>
<thead>
<tr>
<th><strong>ACCESSION NUMBER</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>2013-1 or M2013-1 Accession</td>
</tr>
<tr>
<td>(use prefix “M” for main archive)</td>
</tr>
<tr>
<td>ART1 Artifact</td>
</tr>
<tr>
<td>ART1.2 Artifact item in set</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>FONDS NUMBER</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>(Use M prefix for main archive, H prefix for Hamilton archive, and no prefix for London archive. The Pembroke archive has its own numbering system.)</td>
</tr>
<tr>
<td>F01 or MF01 or HF01 Fonds</td>
</tr>
<tr>
<td>F01-SF01 or MF01-SF01 or HF01-SF01 Sous-fonds</td>
</tr>
<tr>
<td>F01-S001 or MF01-S001 or HF01-S001 Series</td>
</tr>
<tr>
<td>F01-S001-01 Sub-series</td>
</tr>
<tr>
<td>F01-S001-01-01-001 Sub-series and File and Item</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>LOCATION CODES</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>A-1 Shelf unit A, shelf 1</td>
</tr>
<tr>
<td>VF 4-2 Vertical file cabinet 4, drawer 2</td>
</tr>
<tr>
<td>HF 1-1 Horizontal file cabinet 1, drawer 1</td>
</tr>
<tr>
<td>Map 1-3 Map cabinet 1, drawer 3</td>
</tr>
<tr>
<td>Cab 1-2 Cabinet 1, shelf 2</td>
</tr>
<tr>
<td>Book Bookshelf (archive office)</td>
</tr>
<tr>
<td>Access Storage Offsite storage</td>
</tr>
</tbody>
</table>
Separating items

You may need to remove some items which are fragile or oversized and store them separately. In this case, separation sheets are used to link the item with its original location in the series. Make a folder for the separation sheet and give the folder a label with the number and title, just as if the item was still in the folder. Put a separation sheet with the item, and a separation sheet in the folder. Be sure to note the location of the separated item in the finding aid in a note. In AtoM, use the Location of originals field in the Notes area.

<table>
<thead>
<tr>
<th>SEPARATION SHEET</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Items:</strong></td>
</tr>
<tr>
<td>St. Joseph’s School of Nursing, Chatham graduation class – 1916 [photo]</td>
</tr>
<tr>
<td><strong>Original location:</strong></td>
</tr>
<tr>
<td><strong>Current location of items:</strong></td>
</tr>
<tr>
<td><strong>Reason for removal:</strong></td>
</tr>
</tbody>
</table>

Restricted items

If access to any items is restricted, there must be a Withdrawal Form added to the file. See Section 11 on Privacy.
Special media

When numbering photographs, write the number lightly on the back (verso) right hand corner using a Stabilo pencil. Slides are labelled on the lower right corner of the cardboard or plastic frame. If you have arranged the records, on the enclosure, indicate the fonds, series, file and item number(s) and the number of photographs, slides, or negatives in the enclosure.

If you have arranged the records, and there are photographs in a file, create a photograph information sheet that gives the fonds and series title, the fonds, series and file number, and the extent of the photographs. Place this sheet in the folder with the photographs. This will be very helpful when you describe the records.

<table>
<thead>
<tr>
<th>Photographs</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Fonds and series title</td>
<td>Jamaica Annals- Correspondence</td>
</tr>
<tr>
<td>Number</td>
<td>HF01-S002-02-07</td>
</tr>
<tr>
<td>Extent</td>
<td>2 photos: b&amp;w</td>
</tr>
<tr>
<td></td>
<td>1 photo: col.</td>
</tr>
</tbody>
</table>

Label artifacts using an acid free tag, or acryloid and a pigma pen. Label textiles with a tag made of twill tape and sew the short edges of the tag onto the textile.

For framed and matted works, label with a pencil on the back (verso) right hand corner. It is generally preferable to remove items from frames and store flat.

Label scrapbooks and albums on the inside of the front cover or the first page with a pencil, or with a tag. Never take photo albums or scrapbooks apart. If necessary, interleave them with acid free tissue and tie with cotton twill tape, or make a phase box to store the item inside.
Storage

The last step is to put the materials in storage.

15. Place folders in an acid and lignin free box and label the box with the fonds/sous fonds number and fonds/sous fonds title. Make sure to number the box since there may be several boxes with the same name. Use a spacer if the box is not full. Do not pack the box too tightly.

16. Label and number the box and record its location in the accession record and spreadsheet or database. Use standard abbreviations for storage locations. See example below:

| F01-S010       | General Superior Office 1995-2012 Box 2 | B-1  |
| F01-S010       | General Superior Office 1995-2012 Box 3 | B-1  |
| HF01-S002      | Jamaica Annals Box 1                   | Offsite storage |
Section 6: Naming guidelines

Subject headings
To find subject headings, go to Library of Congress Authorities (http://authorities.loc.gov/). Click on the link Search Authorities. Choose Search Type “Subject Authority Headings.” Enter text in the Search Text box. Click on the tab Begin Search. When you get your results, choose only the Authorized Headings tabs. For more information, see Appendix II.

Name authorities
Use only authorized or official names. Check the Library of Congress Name Authorities at https://authorities.loc.gov/ and select Search Authorities. In the “search text” field, enter the name with the surname first, and select Name Authority Headings from the drop-down menu. Click on Authorized Heading next to the appropriate search result and click on the link to view the full record. The authorized name is given in the 100 field. You can also consult the Virtual International Authority File at http://viaf.org/ for authorized names.

Give surname first, for example: Kirwin, Mary Leo.

<table>
<thead>
<tr>
<th>Approved local abbreviations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSJ – for The Congregation of the Sisters of St. Joseph in Canada, e.g., CSJ London, CSJ Canada</td>
</tr>
<tr>
<td>Sr. for Sister, Fr. for Father, St. for Saint</td>
</tr>
</tbody>
</table>

Date and time formats
Use ISO standard 8601 for date when possible. Use zeros in one-digit numbers, e.g., 01, 02…

<table>
<thead>
<tr>
<th>YYYY/MM/DD</th>
<th>2013/09/01</th>
<th>= Year/Month/Day</th>
</tr>
</thead>
<tbody>
<tr>
<td>01:05:26</td>
<td></td>
<td>= 1 hour, 5 minutes, 26 seconds</td>
</tr>
<tr>
<td>Controlled term</td>
<td>USE FOR</td>
<td>Common term</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>audio disc</td>
<td></td>
<td>compact disc, compact disk, CD, vinyl record</td>
</tr>
<tr>
<td>optical disc</td>
<td></td>
<td>optical disk</td>
</tr>
<tr>
<td>CD-ROM</td>
<td></td>
<td>CD-R</td>
</tr>
<tr>
<td>digital video disc</td>
<td></td>
<td>DVD, digital video disk, digital versatile disk</td>
</tr>
<tr>
<td>videocassette</td>
<td></td>
<td>VHS tape</td>
</tr>
<tr>
<td>audio cassette</td>
<td></td>
<td>cassette tape, audiocassette</td>
</tr>
<tr>
<td>audio reel</td>
<td></td>
<td>reel to reel tape</td>
</tr>
<tr>
<td>zip disk</td>
<td></td>
<td>USB drive, thumb drive</td>
</tr>
<tr>
<td>computer disk</td>
<td></td>
<td>computer disk</td>
</tr>
<tr>
<td>architectural drawing</td>
<td></td>
<td>blueprint</td>
</tr>
<tr>
<td>cartographic material</td>
<td></td>
<td>map</td>
</tr>
<tr>
<td>graphic material</td>
<td></td>
<td>artwork</td>
</tr>
<tr>
<td>moving image</td>
<td></td>
<td>movie, film</td>
</tr>
<tr>
<td>object</td>
<td></td>
<td>artifact</td>
</tr>
<tr>
<td>philatelic record</td>
<td></td>
<td>stamp</td>
</tr>
<tr>
<td>sound recording</td>
<td></td>
<td>tape recording</td>
</tr>
<tr>
<td>technical drawing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>textual record</td>
<td></td>
<td>manuscript, document</td>
</tr>
<tr>
<td>photograph</td>
<td></td>
<td>photo, print, color, transparency, slide, negative, carte de visite</td>
</tr>
<tr>
<td>Controlled term</td>
<td>LCSH</td>
<td>Common term</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Sisters of St. Joseph</td>
<td>Sisters of Saint Joseph</td>
<td></td>
</tr>
<tr>
<td>Church work</td>
<td>Church work</td>
<td>Ministry</td>
</tr>
<tr>
<td>Medical care</td>
<td>Medical care</td>
<td>Healthcare, Hospital, Clinic, Nursing</td>
</tr>
<tr>
<td>Music</td>
<td>Music</td>
<td>Band, Orchestra, Choir</td>
</tr>
<tr>
<td>Education</td>
<td>Education</td>
<td>Teaching, Schools</td>
</tr>
<tr>
<td>Spirituality</td>
<td>Spirituality</td>
<td></td>
</tr>
<tr>
<td>Religion</td>
<td>Religion</td>
<td></td>
</tr>
<tr>
<td>Orphanages</td>
<td>Orphanages</td>
<td>Orphanage, Foster Care, Children</td>
</tr>
<tr>
<td>Women</td>
<td>Women</td>
<td></td>
</tr>
<tr>
<td>Poverty</td>
<td>Poverty</td>
<td>Soup Kitchen, Homelessness, Shelter</td>
</tr>
<tr>
<td>Catholic Church -- Missions</td>
<td>Catholic Church -- Missions</td>
<td>Missions, Convents</td>
</tr>
<tr>
<td>Sister</td>
<td></td>
<td>Nun, Woman religious</td>
</tr>
<tr>
<td>Leadership</td>
<td>Leadership, Christian</td>
<td>General Council, Congregational Leadership Circle</td>
</tr>
<tr>
<td>Chapter</td>
<td></td>
<td>General Meeting</td>
</tr>
<tr>
<td>History</td>
<td>History</td>
<td></td>
</tr>
<tr>
<td>Oral history</td>
<td>Oral history</td>
<td>Storytelling</td>
</tr>
<tr>
<td>Annals and chronicles</td>
<td>Annals and chronicles</td>
<td>Annals, Diary, Journal, Accounts, History</td>
</tr>
<tr>
<td>Canada</td>
<td>Canada</td>
<td></td>
</tr>
<tr>
<td>Ontario</td>
<td>Ontario</td>
<td>ON</td>
</tr>
<tr>
<td>London (Ont.)</td>
<td>London (Ont.)</td>
<td>London Ontario</td>
</tr>
<tr>
<td>Hamilton (Ont.)</td>
<td></td>
<td>Hamilton Ontario</td>
</tr>
<tr>
<td>Peterborough (Ont.)</td>
<td></td>
<td>Peterborough Ontario</td>
</tr>
<tr>
<td>Pembroke (Ont.)</td>
<td>Pembroke Ontario</td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td></td>
</tr>
<tr>
<td>Corporate governance</td>
<td>Corporate governance</td>
<td>Policy</td>
</tr>
<tr>
<td>Gifts</td>
<td>Gifts</td>
<td>Donations</td>
</tr>
<tr>
<td>Archives</td>
<td>Archives</td>
<td></td>
</tr>
<tr>
<td>Library outreach programs</td>
<td>Library outreach programs</td>
<td></td>
</tr>
<tr>
<td>Exhibit</td>
<td>Exhibit, Display boards, Display of collectibles</td>
<td>Display</td>
</tr>
<tr>
<td>Publications</td>
<td>Publications</td>
<td>Publication</td>
</tr>
<tr>
<td>Reference services (Libraries)</td>
<td>Reference services (Libraries)</td>
<td>Reference inquiry</td>
</tr>
<tr>
<td>Finding aids</td>
<td>Finding aids</td>
<td>Finding aid</td>
</tr>
<tr>
<td>Research</td>
<td>Research</td>
<td></td>
</tr>
<tr>
<td>Training</td>
<td>Training</td>
<td></td>
</tr>
<tr>
<td>Handbooks and manuals</td>
<td>Handbooks and manuals</td>
<td>Manual</td>
</tr>
<tr>
<td>Guatemala</td>
<td>Guatemala</td>
<td>Guatemala</td>
</tr>
<tr>
<td>Peru</td>
<td>Peru</td>
<td></td>
</tr>
<tr>
<td>Chincha (Peru)</td>
<td>Chincha (Peru)</td>
<td>Chincha Alta Peru</td>
</tr>
<tr>
<td>Chincha (Peru: Province)</td>
<td>Chincha (Peru: Province)</td>
<td>Chincha Baja Peru</td>
</tr>
<tr>
<td>Chiclayo (Lambayeque, Peru)</td>
<td>Chiclayo (Lambayeque, Peru)</td>
<td>Chiclayo Peru</td>
</tr>
</tbody>
</table>

**Note:** when entering tags on Flickr, put multiple word tags such as “Sisters of St. Joseph” in quotes to keep as a single tag.
Electronic file naming

Drives, folders, and files should be named without using spaces. You can use a hyphen or underscore instead of a space.

Do not use special characters such as slashes (/ or \), comma (,), semicolon (;), colon (:), quotation mark ("), possessive mark (‘), exclamation mark (!), at sign (@), crosshatch (#), dollar sign ($), percent sign (%), star (*), plus sign (+), caret (^), ampersand (&), equal sign (=), square or curly brackets ([ or {), or pipe symbol (|).

Do not use periods in the folder or drive names. The only period is before the file extension, for example .docx.

Directory names should not be longer than 21 characters, not including the file extension. The total path length should be less than 207 characters. For example:

```
CSJ-Archives > photos > hamilton > hf01-s005-01-01-001-sjconvent
= 74 characters
```

The directory hierarchy should be less than 8 levels. For example:

```
CSJ-Archives > 400-communication > 440-reporting > 440-10-annual-reports > 2014
= (5 levels)
```

When naming files, give a short name. For example:

```
transcript-2016-19-dmcdermott.docx
hf01-s005-01-01-001-sjconvent.tif
```

Number different versions of the same file. For example:

```
filename.ext  Original file
filename-rev1.ext  Revised file with first set of revisions
filename-rev2.ext  Revised file with second set of revisions
```
The filename for digital images and digital audio will include the identifier. The identifier is a unique name that is encoded in the Dublin Core metadata field Identifier. It persists throughout all versions. For example, f01-s001-02-010.

When saving different formats of the same file, give each file the same name. Differentiate between the versions using affixes.

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hf01-s005-01-01-001</td>
<td>identifier</td>
</tr>
<tr>
<td>hf01-s005-01-01-001-sjconvent</td>
<td>arranged preservation master</td>
</tr>
<tr>
<td>2016-19</td>
<td>identifier</td>
</tr>
<tr>
<td>2016-19-dmcdermott-a.wav</td>
<td>audio preservation master side A</td>
</tr>
<tr>
<td>2016-19-dmcdermott-b.wav</td>
<td>audio preservation master side B</td>
</tr>
<tr>
<td>2016-19-dmcdermott-a-sm.wav</td>
<td>audio service master side A</td>
</tr>
<tr>
<td>2016-19-dmcdermott-b-sm.wav</td>
<td>audio service master side B</td>
</tr>
<tr>
<td>2016-19-dmcdermott-a-ac.mp3</td>
<td>audio access copy side A</td>
</tr>
<tr>
<td>2016-19-dmcdermott-b-ac.mp3</td>
<td>audio access copy side B</td>
</tr>
</tbody>
</table>
Section 7: Description

An archival description is a finding aid to help researchers which gives information about the context and content and organization of a record group. The description goes from the general to the specific. After arranging the records, when there is time, you can create archival descriptions for the fonds/sous-fonds or series.

We initially do minimal description for our record groups, creating only descriptions for the highest level, whether that is a fonds, sous-fonds, or series. Keep the administrative history or biographical sketch brief.

We describe only the highest level, whether that is the fonds, sous-fonds, or series/subseries levels. Later, if time permits, we may return to the description and add the next lower level, which is generally the series or subseries level. We do not describe at the file or item levels.

When doing an archival description, it’s best to quickly look through the records, to get an overview. Don’t spend too much time on this. Then, start with the physical description for each series (or subseries if your highest level is the series.) Note the beginning and end dates for all the records in each series. Discuss what kind of records, and what they are about, in a scope and content note. Only after this is done, fill in the physical description, inclusive dates and scope and content fields for the fonds or sous-fonds level. Finally, do a brief administrative history or biographical sketch, and fill in any remaining fields. Be careful not to get bogged down in detail!

A note on punctuation: in the physical description area, start a new paragraph for each media type. Use a space before and after colons and semicolons. Use a colon before physical details, and a semicolon before dimensions. Use controlled vocabulary in the physical description area (see Section 6 on controlled vocabulary for physical description.)

See Section 20 for how to describe digital materials.
RAD higher-level description

A minimal description would include the fields shown below with starred fields being required and crosswalks shown to various standards:

*Title proper* (ISAD-G 3.1.2, RAD 1.1B, DACS 2.3)

General material designation (RAD 1.1C)

*Level of description* (ISAD-G 3.1.4, RAD 1.0A, DACS 1)

Identifier

Repository

*Date(s)* (ISAD-G 3.1.3, RAD 1.4B, DACS 2.4)

*Physical description* (ISAD-G 3.1.5, RAD 1.5B-1.5D, DACS 2.5)

Name of creator (ISAD-G 3.2.1, RAD 21.1, 1.1B3b, DACS 2.6)

Administrative history/Biographical sketch (ISAD-G 3.3.2, RAD 1.7B, DACS 2.7, 11.2)

*Scope and content* (ISAD-G 3.3.1, RAD 1.7, DACS 3.1)

Note that there are other required fields if you are doing a CSV import into AtoM. Starred fields are required:

*legacyID* (a number which cannot be repeated in this column)

*identifier* (e.g., F01)

*title* (e.g., Dr. F. W. Luney fonds)

*levelOfDescription* (e.g., Fonds)

*culture* (e.g., en)

*repository* (e.g., Congregation of the Sisters of St. Joseph in Canada Archives)

Other fields which are not required but are good to include are:

extentAndMedium (e.g., 89.5 cm of textual records)

eventTypes (e.g., Creation, Accumulation, Contribution, Collection, Broadcasting, Manufacturing, Custody, Publication, Reproduction, Distribution)

scopeAndContent (e.g., Scope and content note)
eventDates (e.g., 1907 – 1974)

Here are the fields for the highest level of description:

<table>
<thead>
<tr>
<th><strong>Title proper</strong> (RAD 1.1B) The title is very important! It is usually based on the official name of the creator followed by the word denoting the type of record group (fonds or sous-fonds or series). Give the authorized form of name for corporate bodies. If the corporation was known by several names, give the official name here, not the name it was commonly known by.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>General material designation</strong> (RAD 1.1C): Choose the type of material that applies to the highest level of description.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Level of description</strong> (RAD 1.0A) Enter “fonds,” “collection,” or “sous-fonds” or “series” depending on what the highest level of the record group is.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Identifier</strong> Enter the reference code for the fonds, sous-fonds, or series.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Repository</strong> Enter “Congregation of the Sisters of St. Joseph in Canada.”</th>
</tr>
</thead>
</table>
**Date(s)** (RAD 1.4A, 1.4B) In RAD, you record two dates: the dates of existence of the records creator, and the dates of the records in the record group. This latter date should encompass all the records included in the record group. RAD states “The date(s) of creation of a unit being described must fall within the range of dates of creation of the unit of which it forms a part.” For example: If 1934-1985 are the dates of creation for a fonds, the dates of creation of a series within this fonds must fall within this span. *Make sure to note two date spans in your archival description – one date span is the beginning and end of the lifespan of the person or institution, and the other is the date span of the records.*

**Physical description** (RAD 1.5A, 1.5B, 1.5C, 1.5D) This includes extent. Always measure height x width in centimeters. According to RAD: “Precede each physical description by a full stop, space, dash, space or start a new paragraph. Precede other physical details (i.e., other than extent or dimensions) by a colon. Separate each part of the description of other physical details by a comma, conjunction, or preposition. Precede dimensions by a semicolon.” For example:

1 photograph : b&w ; 6 x 6 cm + 1 identification key

5 technical drawings : blueprint ; 25 x 42 cm

3 photographs : col.

1 collage ; 20 cm x 20 cm
**Name of creator** (RAD 21.1, 1.1B3b) Give the name of the person or organization responsible for the creation of the records.

**Administrative history/Biographical sketch** (RAD 1.7B) For corporate bodies, include dates of founding and dissolution; mandate; administrative relationships with other bodies; administrative structure; names of chief officers. For individuals, give place and dates of birth and death, occupation, and activities.

**Scope and content** (RAD 1.7D) Give information about the functions and activities that produced the records, the time period, subject, and geographical area. Also give information about the arrangement of the record group and its main format, e.g., minutes, correspondence, etc.

**Notes- location of originals** (RAD 1.8B15a) Note whether the originals are stored in a different location and the location of any separated items.

**-restrictions on access** (RAD 1.8B16a) Note any access restrictions. If none, write “Open.” If there are restrictions, write “Closed” and give the period for which the records are restricted.

**Access points** (RAD 21) Use the subject headings and corporate names indicated in the Controlled vocabulary section of this manual, as well as Library of Congress subject headings. Do not repeat subject headings from a higher level of description at a lower level. In AtoM, choose from the drop-down menu for access points.
Finding aids - example of a series and file list

This is an example of a partial series and file list for a sous-fonds:

<table>
<thead>
<tr>
<th>F01-SF17 Associates Program</th>
<th>Box 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>F01-SF17-S010 Federation</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S010-01 Federation Surveys</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S010-02 London Associates Reports to Federation</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S010-03 Federation correspondence and reports 1991-2012 [1/2]</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S010-03 Federation correspondence and reports 1991-2012 [2/2]</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S010-04 Federation meetings May 2016, May 2017 [2020-4]</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S011 Leadership</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S011-01 Dialogue correspondence 2011</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S011-02 Agrégée Membership 2006-2011</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S011-03 Associate leadership correspondence 2016-2017</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S011-04 Leadership process correspondence 2014-2015</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S011-05 Animator Team endorsement 2000-2010</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S011-06 Animator endorsement 2011</td>
<td></td>
</tr>
<tr>
<td>F01-SF17-S011-07 Animators ballots and correspondence 2011</td>
<td></td>
</tr>
</tbody>
</table>
Finding aids - example of an archival description

This is an example of an archival description for the same sous-fonds:

<table>
<thead>
<tr>
<th>F01-SF17 Associates Program</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title proper:</strong> Associates Program</td>
</tr>
<tr>
<td><strong>General material designation:</strong> Multiple media</td>
</tr>
<tr>
<td><strong>Level of description:</strong> Sous-fonds</td>
</tr>
<tr>
<td><strong>Identifier:</strong> F01-SF17</td>
</tr>
<tr>
<td><strong>Repository:</strong> The Congregation of The Sisters of St. Joseph in Canada</td>
</tr>
<tr>
<td><strong>Date(s):</strong> 1987-2018</td>
</tr>
<tr>
<td><strong>Physical description:</strong></td>
</tr>
<tr>
<td>101 cm of textual documents</td>
</tr>
<tr>
<td>5 photographs: col; 16 x 11 cm (6 x 4 inches)</td>
</tr>
<tr>
<td><strong>Name of creator:</strong> Associates Program (London, Ont.)</td>
</tr>
<tr>
<td><strong>Administrative history:</strong></td>
</tr>
<tr>
<td>On July 9th, 1987, the Sisters of St. Joseph in London approved the movement towards having an Associates Program complete with a candidate process and formal training process. The program began on April 4th, 1989, in London, Ontario. The Associates Program was originally founded by Sister Doreen Kraemer and later administered by Sister Janet Zadorsky. After Sister Janet Zadorsky ended her involvement with administering the Associates Program, as of April 2017, two associates were given stipends by the Associates to serve as mentors for two years, during a bridging stage. They prepared a document, “Midwives to Our Future,” and after this, the Associate program evolved away from the Sisters being directly involved. The program is now autonomous but still connected through a Congregational liaison, but the Associates make their own decisions.</td>
</tr>
</tbody>
</table>
The Associates Program currently (as of 2022) has an Associate Leadership Circle with a representative from each of the areas: London, Sarnia, Windsor-Chatham, Simcoe-Woodstock, and Zaña, Peru. There are Animators for each region who assist with spiritual development. There is a Core Team who look after business matters, including event planning. Together, these form the Joint Animating and Core Team. Every leader has a term of two to three years. There is also a congregational liaison who provides a communication channel between the Associates and the Congregational Leadership Circle. Members are recruited by means of a “seekers” process and are provided with instruction and allowed to discern their commitment over a two-year period, at the end of which there is a “charism connection” ceremony, and they are given a pin and sign an agreement. There are two annual events held: a retreat, and the Annual General Gathering. As well, there is a representative who attends Federation meetings of Associates from Hamilton, London, Peterborough, Pembroke, Toronto, and Sault Ste. Marie.

Scope and content:
This sous-fonds contains directories, newspaper clippings, financial records, correspondence, presentation talking points, photographs, photo albums, promotional materials, a survey, handbooks, crafts, history timelines, meeting minutes, and reports. These records relate to the administration and operation of the Associates Program.

The sous-fonds contain the following series:

F01-SF17-S001  Directories and Lists
F01-SF17-S002  Newsletters
F01-SF17-S003  Finance
F01-SF17-S004  Communications
F01-SF17-S005  Events
F01-SF17-S006  History
F01-SF17-S007  Administration
F01-SF17-S008  Peru Program
<table>
<thead>
<tr>
<th>F01-SF17-S009</th>
<th>Meetings</th>
</tr>
</thead>
<tbody>
<tr>
<td>F01-SF17-S010</td>
<td>Federation</td>
</tr>
<tr>
<td>F01-SF17-S011</td>
<td>Leadership</td>
</tr>
<tr>
<td>F01-SF17-S012</td>
<td>Candidate Process</td>
</tr>
</tbody>
</table>

**Notes:**

**Restrictions on access:** This sous-fonds is partially restricted to access by the public.

**References:**


Template for archival description

<table>
<thead>
<tr>
<th>IDENTIFIER______________</th>
<th>TITLE__________________________________________</th>
</tr>
</thead>
</table>

**General material designation:**

**Level of description:**

**Identifier:**

**Repository:** Congregation of the Sisters of St. Joseph Consolidated Archives

**Dates of creation:**

**Physical description:**

**Name of creator:**

**Administrative history:**

*(Put administrative history in General note field for series level description)*

**Scope and content:**

*(Also include list of subseries or files)*

This fonds/sous-fonds/series contains the following subseries/files:

**Notes:**

**Title notes**

**Source of title proper**

Title is based on the contents of the fond/sous-fonds/series.

**Immediate source of acquisition**

**Arrangement**

**Location of originals**

**Restrictions on access**

*(Note which files are restricted to the public and why)*

*(Include boiler plate text)*

The Archives reserves the right to restrict access to the collection depending on the condition of the archival material, the amount of material requested, and the purpose of the research. The use
of certain materials may also be restricted for reasons of privacy or sensitivity, or under a donor agreement. Access restrictions will be applied equally to all researchers and reviewed periodically. No researcher will be given access to any materials that contain a personal information bank such as donor agreements or personnel records, or to other proprietary information such as appraisals, insurance valuations, or condition reports.

**Conditions governing use**

*(Include boiler plate text)*

Permission to study archival records does not extend to publication or display rights. The researcher must request this permission in writing from the Archives.

**Finding aids**

Series and file list available.

**Accruals**

No further accruals are expected **OR** Further accruals are expected.

**References:**

**Accruals**

You may get more material transferred that needs to be added to an existing record group, even one which has been already arranged and described. In this case, you will need to add a new folder with a consecutive file number to an existing series or create a new accrual series added to the end. You will also need to make corrections to the description by:

- Revising dates
- Revising physical description
- Revising the scope and content note
- Noting whether any of the new material has access restrictions
- Revising the note on arrangement if there was one.
Section 8: How to use AtoM

AtoM is the database we use for our archival descriptions. The instance supported by the Archives Association of Ontario is called Archeion. AtoM is a web-based open-source application for standards-based archival description and sharing access. AtoM was built around International Council on Archives data content standards: ISDIAH (International Standard for Description of Institutions with Archival Holdings), ISAAR (International Standard Archival Authority Record for Corporate Bodies, Persons, and Families), and ISAD-G (General International Standard Archival Description). However, AtoM works with other descriptive standards like RDA, DACS, RAD, Dublin Core, and MODS.

AtoM supports the hierarchical arrangement of record group or collection/fonds/series, file, and item. There are three main types of records in AtoM: archival institution records, authority records, and archival description records.

The archival institution record provides a description of the repository. This is based on ISDIAH. Archival descriptions are linked to the archival institution as holdings.

The easiest way to create a catalog record in AtoM is to first create a basic authority record with the administrative history OR biographical sketch. Next, create the archival description record. Last, link the authority record to the archival description through choosing it as the creator from a drop-down menu of authority records in the archival description.

You add a new authority record or archival description record from the main menu using the + button at the top of the screen. When you add a creator to an archival description, the administrative history/biographical sketch in the authority record will flow into the archival description. This creator will be inherited by all lower levels of description.

If you are entering a series level description, you can just enter the catalog record in AtoM and then link to an existing authority record.
Your archival descriptions are saved as drafts and remain hidden to the public until you publish them. Your authority records are visible to the public once you’ve made them.

*Clear the cache before you use AtoM. Make sure to frequently click “Save” as you are entering data into AtoM.*

To make sure you have paragraph breaks, end a paragraph with two spaces and then hit the Enter key.

Before publishing, make sure the URL for the authority record and the archival description look good.

**How to enter an authority record**

Only create an authority record if there is not already one. If the record group is a series, there is likely already an authority record.

A minimal authority record would contain the fields shown below. Starred fields are required, and crosswalks are shown to different content standards:

* **Type of entity** (ISAAR 5.1.1, DACS 10.2)
* **Authorized form of name** (ISAAR 5.1.2, RAD 22.2A, DACS 2.7.13, 10.1)

**Other form(s) of name** (ISAAR 5.1.5)

* **Maintaining repository** (ISAAR 5.4.2)

**Dates of existence** (ISAAR 5.2.1, DACS 2.7.15, 11.1)

**History** (ISAAR 5.2.2, RAD 1.7B, DACS 2.7, 11.2)

**Authority record identifier** (ISAAR 5.4.1, DACS 13.2)

The authority record contains the information about the person or organization that created the records. Check first to see if there is an existing authority record that you can associate with the
records. If not, click the Add icon at the top right of the web page and choose Authority record. You will see many links, each of which if clicked on, open the area to show its fields.

First, click on the Identity area. Enter data in the Type of entity field. You will generally choose corporate body or person.

Click on the Authorized form of name field. Enter the official name of the creator of the records, but do not enter any dates. For Sisters, choose the name they were known by at death, either their religious name, or their birth name. If there is another form of name, for example for a Sister, you can separately enter her birth name or her religious name or her post-Vatican II name with “Sister” preceding in the Other form(s) of name field, e.g., Marie Anne Eveline Gagner. When entering a name for a person, enter the surname then first name e.g., Gagner, Eveline. Don't enter dates of existence in the authorized form of name field.
Next, click on the **Description** area. Enter the dates in the **Dates of existence** field. These dates are the lifespan of the individual or organization only, not the dates of the records in the fonds, e.g., *July 3, 1917-June 15, 2020*.

The **History** field is where you enter the administrative history/biographical sketch. The administrative history fields in the archival description will automatically be filled in from this field in the Authority record.

Sometimes the span of dates of existence of the individual or organization does not match up with the date span of the records. For example, the *St. Joseph School of Music* was in existence from 1954-2005. However, this sous-fonds had some records from the former *Sacred Heart School of Music*, which was its precursor, dating back to 1914. It also had only records dating to 1988 from the successor. This meant that the dates of existence for *St. Joseph’s School of Music* were 1954-2005, but the dates of creation (of the records) were 1914-1988. In this case, enter the dates of existence for the organization as 1954-2005 in the authority record, and later, in the fonds level description, enter the dates of creation for the records as 1914-1988.

Do not worry about entering anything in the **Description identifier** field in the authority record. (It will give you an error message later, but disregard this.)

Do not give bibliographical references in the authority record. Give these in the description record.
In the **Relationships area**, you can connect the authority record with an organization. Click on the **Add new** button and complete the fields in the popup screen. In this area, if you are recording information for a Sister, give the dates from her entrance date (or reception date if entrance date is unknown) to her death date.
In the Access points area, you can add access points for subject, place, and occupation by selecting from the drop-down menu.
In the **Control area**, make sure to complete the **Maintaining repository** field. In the field for Authority record identifier, you can give the VIAF permalink URL if it is available.

![Control area table]

Click **Create** or **Save** at the bottom when you are done.

**How to enter an archival description for the highest level of the record group**

The highest level of description for the record group may be a fonds, or a sous-fonds, or a series.

Click on the **Add tab** as you did to create an authority record and choose the **Archival description** link. You will see many links to choose from, each of which contain many fields. Each link is an area that, when clicked, displays fields. Enter data in the fields as indicated below. Do *not* put the date in the **Title proper** field. You can ignore all **Institution identifier** fields.

**Title and statement of responsibility area**
Title proper – Enter the name of the creator followed by the word referring to the record group, for example “fonds,” e.g., “Stettler Hospital fonds.” Use lower case for the word referring to the record group, e.g., “fonds.”

General material designation – Enter the type of material, e.g., “Multiple media” if the record group contains textual records and photographs. Scrapbooks are “Multiple media,” but photo albums are “Graphic material.”

Level of description – Choose the type of record group from the drop-down menu.

Repository – Start typing “Congregation of the Sisters of St. Joseph in Canada” and when it shows up, select it. *Don’t keep typing once it shows up because you will create a new entry!*

Identifier – Enter the record group number only, e.g., “F02” or “F12”, etc. (The AtoM instance supported by the Archives of Ontario will automatically add our repository Archeion code which is CA ON00279).

**Dates of creation**

This is the area that links the authority record with the archival description record. Once it is completed, the administrative history/biographical sketch for the creator of the records will be filled in automatically from the authority record.

Click [Add new] and a popup screen will open showing fields.

Actor name – Start typing the name of the authority record (e.g., the creator of the records) and click on it when it appears in the list. *Don’t keep typing once it shows up or you will create a new entry!*

Event type – Choose “Creation” from the drop-down menu.

Date – Enter the dates of creation of the records. This is a required field. Use RAD conventions, for example:

If the dates are uncertain, e.g., ca. 1990-199?, you must enter the closest dates in the Start field and in the End field, e.g., 1990 and 1999.

**Physical description area**

Enter the physical description in a list with each entry on a separate line, not separated by commas. Use metric measurements. Enter black and white photographs as: 10 photographs : b&w. Enter color photographs as: 10 photographs : col. Give dimensions as height x width. For example, 1 photograph : b&w ; 20 x 25 cm. Note the spacing between colon and semicolon.
Archival description area

Scope and content – This field must be completed.
Access points area

You do not repeat access points at lower levels, so what you enter at this higher level applies to lower levels. You can add access points for subject, place, genre, and name.

Control area

Sources – Enter any references used to write the archival description. See the Section 9 for citation style.

Administration area

Display standard – Select “RAD.”

Click Create to finish the higher-level description.
The archival description will be automatically saved as a draft. To publish it, you need to go to the bottom of the description page and click the More button. Click on “Update publication status” in the drop-down menu, and you can then choose to publish or save your work as a draft. If you do not want to publish the description immediately, for example for privacy reasons, save it as a draft.

If your description has child levels, e.g., for subseries or files, you can publish these at the same time as the higher-level description. Check the “Update descendants” box. If you do not do this, the lower-level descriptions remain in draft status.

You can always go back and edit the description using the Edit button at the bottom.

Photos can be uploaded to the Archives Association of Ontario instance of AtoM. At the bottom of the record, click More and select Link digital object. Upload a photo in JPEG format (under 100 MB). Then click Create. You can add alt text to a digital object by clicking More and then Edit digital object. Alternatively, you can link to an image on another site, such as Flickr Commons. Choose Link digital object and then Link to an external digital object and enter the URL.

How to enter child levels

You can enter child levels in AtoM, for example, for example, series level descriptions connected to a fonds level or file levels connected to a series level. To do this, in the Title and statement of responsibility area, go to the Add new child levels field.
Now you can fill in the identifier for the series, subseries, file, or item, and choose the level from a drop-down menu. You can enter the title, as well as the dates of creation. To add multiple child levels, just click on the Add new button. The new child levels will appear to the left of the archival description.

If you have more than one folder for a single file, enter each folder as a separate child level with the same identifier for each folder.

Do not put a hyphen at the beginning of the identifier.

Enter dates in the date field at the child level.

Do not put the accession number in the file title. Put it in the Other notes field and choose “Alpha numeric designations” from the drop-down menu.
You can then click on the link and edit the archival description for the child level you just created.

**NOTE:** Don’t add the creator again to child levels in the **Dates of creation** field. It only needs to be added once to the highest level (parent) archival description.
How to enter an archival description without an authority record

There will be cases where you enter an archival description without creating an authority record. For example, in the case of a collection, or of a series which is linked to the authority record for the institution. In these cases, the administrative history or biographical sketch is given in the General note field. You can still include a Name access point, and that will allow you to create an authority record. For example, we have a collection about Mother Ignatia Campbell, and created a name access point in the archival description which then allowed us to create an authority record for Mother Ignatia.
Title and statement of responsibility area

Title proper: Collection about Mother Ignatia Campbell

General material designation: Multiple media

Title notes: Source of title proper: Title is based on the contents of the collection.

Level of description: Collection

Repository: Congregation of the Sisters of St. Joseph in Canada

Reference code: CA ON00279 F01-5001

Dates of creation area

Date(s): 1856 (photocopied 1987-7-2005) (Collection)

Collector: Congregation of the Sisters of St. Joseph in Canada (London, Ont.)

Physical description area

Physical description: 4 cm of textual records
9 photographs: b&w
7 photographs: col.
4 negatives: b&w
2 negatives: col.

Archival description area

Scope and content: This is a collection of material related to the life and work of Mother Ignatia Campbell which comprises two subseries. It includes several biographical chronologies and summaries of her work which were considered in the drafting of her profile in the...

Notes area

Arrangement: These records were collected by the archivist of the London congregation.

Location of originals: The records are located at The Congregation of the Sisters of St. Joseph in Canada Archives.

Restrictions on access: The Archives reserves the right to restrict access to the collection depending on the condition of the archival material, the amount of material requested, and the purpose of the research. The use of certain materials may also be restricted for reasons...

Terms governing use, reproduction, and publication: Permission to study archival records does not extend to publication or display rights. The researcher must request this permission in writing from the Archives.

Finding aids: Subseries and file list available.

Generated finding aid: Collection about mother-ignatia-campbell.pdf

Accruals: No further accruals are expected.

General note: Catherine Anne Campbell was born in Thorah Township, Brock Settlement, Ontario. Catherine Anne's parents were Kenneth A. Campbell (born ca. 1800, died 1877) and Anne McEwan (born 1803 in Scotland, died February 18, 1872). The family lived in the Brock...
You choose the creator or collector and the event type (creation, collection, etc.) from the drop-down menu in the \textit{Dates of creation} field, and in the case of most series, you will choose will be the name of the Congregation, e.g., \textit{Congregation of the Sisters of St. Joseph in Canada (Hamilton, Ont.)} and either “Creation” or “Collection.”
Section 9: Guidance on references

When referencing archival sources, identify the item, give the title of the record group, give the name of the archive, and the location of the archive. Reference other sources as follows:

Single-authored book:


Book with multiple authors:


Book with editors:


Article in an edited book:


Article in an academic journal:


Website:


Interview


---

4 This style manual is adapted from the University of Dundee Master of Archival Studies program guidance.
Section 10: Copyright
The archive must follow Canadian copyright law. Physical ownership is not the same as owning the intellectual property rights. For items still under copyright, the intellectual property rights must be transferred in writing by the creator or person/organization who holds the copyright. The archives should send the “Assignment of Copyright by Photographer” form to the photographer and request that it is signed and returned to the archives. A record should be kept of all efforts to obtain copyright permission.

If you are unable to locate the copyright holder, include a disclaimer that the item may be under copyright and the user is responsible for all copyright issues.

Photographs, audiocassettes, film, optical media, and VHS tapes that are under copyright may be digitized for preservation but must be accessed onsite and not published online.

Copyright and copyright duration
Unpublished materials are protected by copyright. Any author holds copyright from the moment the work is fixed in a tangible medium. The copyright holder has the right to publish physical copies of a work for the first time. The publication date is used to determine copyright term along with the death date of author.

Copyright lasts for the author’s life plus 70 years following the year in which the author died, except for Crown works which lasts for 50 years after the calendar year in which the work was first published. If the author is unknown, copyright lasts for 70 years after the calendar year in which the work was first published, or 75 years after the calendar year in which the work was created.

Here is a summary:

---

• Published literary works – if author died on/before December 31, 1971, then the copyright term is year of death plus 50 years.
• Published literary works – if author died on/after January 1, 1972, then the copyright term is year of author’s death plus 70 years.
• Sound recordings – the copyright term is 70 years after release date.
• Photographs taken before 1949 – these are in the public domain.
• Unpublished works where author died before 1949 – these are in the public domain.
• Published Crown works – the copyright term is 50 years after the publication date.
• Unpublished Crown works – these are always in copyright.

In Canada if the work is part of the job for which the author was hired, the employer owns copyright (unless the author is a contractor in which case the contract must state who owns the copyright) - but the employee still owns the moral rights for the duration of the copyright term.

For commissioned work - if the work was made before November 7, 2012, the person who hired the author owns copyright, but after this date, the author is the first owner of copyright and the person who hired the author can only use the work for private and non-commercial use.

Copyright generally lasts for the life of the photographer and the rest of the calendar year in which they died, plus 70 years.

Prior to 2012, some photographs are in the public domain:

<table>
<thead>
<tr>
<th>Before December 31, 1948</th>
<th>Public domain if owned by a person</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before December 31, 1961</td>
<td>Public domain if owned by a corporation</td>
</tr>
<tr>
<td>50 years after publication</td>
<td>Public domain if taken by Crown photographer</td>
</tr>
</tbody>
</table>

Copyright may be assigned to someone else in writing or licensed by someone else. Licenses may be exclusive or non-exclusive.

Only photographs in the public domain should be uploaded to Flickr The Commons. Most photographs taken prior to 1949, are in the public domain in Canada. (Anonymous unpublished works where the author is not commonly known, enter public domain at year of creation +75
years. If the works are published, they enter public domain at either the year of publication +75 years or the year of creation +100 years.)

For oral history recordings undertaken by the Congregation, the copyright is held by the Congregation. These are in the public domain 70 years after the date of recording or publication.

This copyright flow chart from the Copyright Office, University of Alberta is helpful:
Copyright infringement
You can be sued if you violate copyright law. Here is how to protect the Congregation from copyright infringement:

a) Seek copyright permission from photographers for photographs in its holdings. It may not be possible to obtain a reply from a photographer, so it is important to keep documentation showing that efforts were made.

b) Mark copies of materials provided to researchers with a stamp. Researchers must be made aware, by signing the Research Agreement and Request for Reproduction forms, that materials are made available only for research and private study.

c) Ensure the Deed of Gift agreement is signed to ensure that copyright ownership is given to the archive if it is held by the donor.

d) Provide rights metadata when digitizing materials.

e) When taking a photograph or making a video or audio recording of any person, a Release Form must be signed by that person.

f) Take down any material on any website that infringes copyright if a request is received from a copyright owner.

Orphan works
Orphan works are a special case. These are works for which the identity of the copyright holder cannot be determined or for which the owner cannot be located and are known as orphan works. Look at the contextual information in the file in which the item is found and the finding aid to determine the author of the work. If you can’t determine the author’s identity, then it is an orphan work. You will have to decide whether the use you will make falls under the fair dealing provisions of the Copyright Act. If you can determine the author’s identity, try to find out whether they or their heirs are still alive because they hold copyright for 70 years after death. Look for obituaries and genealogical information online and try to track down a surviving family member. Do an Internet search for any archives holding works by the author and contact the repository for information on the author. You can also search professional association websites, for example, Artists in Canada (https://app.pch.gc.ca/application/aac-aic/?lang=en), or
To determine whether the author transferred copyright, you have to look at the clues in the file and finding aid, and check whether the work was published and whether the publisher holds copyright. If you can’t find any evidence of copyright transfer, assume the copyright is with the author. To determine whether the work was made by an employee or contractor, again look for clues in the file and finding aid, check the accession record, and contact the employer for copyright permission.

In Canada, the reproduction rights organization which handles permissions and licenses for copyright is Access Copyright. Some authors may choose to have this organization manage the permissions process, but there are fees associated with these permissions.

If you find the author’s last known address, write to it and request delivery confirmation to document your search. It may not be possible to obtain a reply from a photographer, so it is important to keep documentation showing that efforts were made. Be sure to list all the steps you take and date and record what you find at each step. Keep copies of all correspondence.

**Exemptions for archives**

There are exemptions for archives, but the archives must not be for profit and open to researchers for the exemptions to apply. The exemptions allow the archives to:

- Make a copy of a work for preservation.
- Make a copy for onsite viewing to preserve original.
- Make a copy in a new format to enable continued access.
- Make a copy for cataloguing.
- Make a copy for insurance purposes or police investigation.
- Make a copy if necessary for restoration.
- Make a single photocopy for a patron but must inform the patron that the copy is for research or private study and not make a profit from this.
- Must keep records of copies made for three years.
• Copy unpublished work if notice is given to the donor and the deed of gift does not prohibit this and copying has not been prohibited by any other copyright owner. The archives must inform the patron that the copy is solely for research and private study. A donor can grant copyright to an archives. A donor also may have the deed of gift limit copyright and non-copyright uses by the archives.

Under fair dealing in Canada, copyrighted material can be used for research, private study, education, news reporting, criticism, review, parody, and satire. In Canada, fair dealing must meet several tests: purpose of the use, amount used, such as how much was copied, character of the use such as what was done with it, alternatives to using the material, the nature of the work such as unpublished status, and the economic impact of using the work.

To determine whether the use is fair dealing, think about the purpose of the use, the character of the use (what the patron does with the copies), whether the amount copied is necessary for the stated purpose of the researcher, the nature of the work (if it is factual and not available elsewhere it is more likely fair dealing to make copies), and the impact on the market value by the use.

In our archives, copyright is covered in these policies:

04-Donation
07-Website
15-Copyright

And in these forms:

Copyright Permission
Deed of Gift
Release Form
The next section gives the *Archives Copyright Policy*.

**Archives copyright policy**
The Archive must respect the *Copyright Act* in its outreach work, including publishing, creating exhibits and displays whether physical or digital, and in providing reference services. Usually, the copyright holder is the creator, but in the case of an employee being a creator as part of their work, the employer is the copyright holder. In the case of Crown works, the Crown is the copyright holder. Even if creators are not the copyright owners, they have a right to be associated with their work and not have their work modified or used in a way that would damage their reputation. This is their moral right.

**Public domain**
Copyright does not last forever. A work in the public domain can be used without permission from the copyright holder and without paying royalties.

**Length of copyright**
Generally, the works of living authors are protected by copyright, which lasts for the duration of the calendar year in which an author dies plus 70 years. This is a simple calculation which involves adding 70 to the year following the year of death to find the year in which the work enters the public domain. Copyright was extended for works for an additional 20 years on December 30, 2022. Works which entered the public domain before December 30, 2022, are still in the public domain. Works by authors who died in 1971 are in the public domain because they entered public domain in 2021. Works by authors who died in 1972 are now protected by copyright until January 1, 2043. Photographs taken before 1949 are in the public domain if not Crown works.

A) Photographs

*Commissioned photographs*
Copyright ownership of commissioned photographs rested with the client for works created before November 7, 2012. If created before December 31, 1998, these photographs are in the
public domain at 50 years after the date of creation. Commissioned photographs taken after November 7, 2012, are owned by the author until the year of the author’s death plus 70 years.

Other photographs
Otherwise, all other photographs are in the public domain 70 years after the calendar year in which the last author died.

B) Textual works

Published works
For published literary works, if the author died on or before December 31, 1971, then the copyright term is year of author’s death plus 50 years. If the author died on or after January 1, 1972, then the copyright term is year of author’s death plus 70 years.

Posthumous works
For works unpublished at the author’s death which were then published before December 31, 1998, copyright term is for the longer of either the rest of the calendar year in which the work was published plus 50 years or life of the author plus 50 years.

If the author died between December 31, 1948, and December 30, 1998, and the work was not published before December 31, 1998, copyright term is for the longer of December 31, 2048, or life of the author plus 70 years.

Unknown authors
For works with unknown authors, the work is in the public domain 70 years after the calendar year in which it was published, or 75 years after the calendar year in which it was created.

Joint authors
For works with joint authors, the work is in the public domain 70 years after the calendar year in which the last author died.
Crown works
For Crown works, the work is in the public domain 50 years after the calendar year in which the work was published. Unpublished Crown works never enter the public domain.

Unpublished works
For unpublished works, the work is in the public domain on January 1, 2004, if the author died before January 1, 1949. If the author died between 1949 and January 1, 1979, the work is in the public domain on January 1, 2049. For authors who died after 1998, the work is in the public domain 70 years after the calendar year in which the author died.

For unpublished works with unknown authors, if the work was created before January 1, 1945, the work is in the public domain 75 years after the creation date. If the work was created after January 1, 1945, the work is in the public domain 100 years after the creation date.

C) Sound recordings
A copyright owner holds all rights to reproduction, derivatives, distribution, performance, display, and public performance of sound recordings via digital audio transmission. Sound recordings are in the public domain 70 years after the year in which they were recorded, or 70 years after the year in which they were published.

Definitions

Copyright: A property right that protects the interests of the creator or person/organization to which copyright has been assigned, giving them control over the reproduction, publication, adaptation, performance, or display of the work.

Public domain: Works that are unprotected by copyright law.
Procedure

Copyright permissions
The Archives will make efforts to research the ownership of photographs and request copyright permission from copyright holders for publication and display using the Assignment of Ownership by Photographer form.

Preservation
Archives are allowed under the fair dealing provision of the Copyright Act to reproduce materials for preservation purposes.

Donations
Donors must assign ownership and copyright to the Archives for all donations. If the donor does not hold copyright, the Archives must make determined efforts to contact the copyright owner and obtain assignment of copyright to the Archives. This can be done by sending a letter by registered mail and keeping a copy of the letter and receipt on file.

Websites
The Archives will take down any material displayed on the web if a copyright owner requests this to be done.

The Archives will include this Rights Statement on all its websites:

The photographs featured on this website come from the Congregation of the Sisters of St. Joseph in Canada Archives and, to the best of our knowledge, there are either no copyright restrictions associated with them because they are in the public domain, or there is no known copyright. The rights statement attached to these latter photographs is Copyright Undetermined: Rights Statements. In other cases, the copyright is owned by the Congregation of the Sisters of St. Joseph in Canada. The rights statement associated with these photographs is In Copyright: Rights Statements.
These images are intended for private reference and research, and we cannot assume liability for any other use of these photographs. The images on the website are in jpeg format. The images should not be altered or manipulated in any way. The images must not be used for commercial purposes. Proper credit must be given when any image is used, as follows:

Credit:
Images courtesy of the Congregation of the Sisters of St. Joseph in Canada Archives.

We are committed to observing copyright law. If we have inadvertently infringed on the intellectual property rights of copyright holders with respect to these photographs, please contact us with specific details.

Reference
The Archives will only make one copy of any material requested by a patron under the fair dealing provisions of the Copyright Act for research, private study, education, parody or satire, criticism or review, or news reporting. This includes unpublished material and portions of published material. Other use of copyrighted material is protected by law and requires permission from the copyright holder, whether the material is published or unpublished. Archives patrons will be asked to complete a Research Agreement and Request for Reproduction for all inquiries. For any use of archival materials that does not fall under fair dealing, the patron must obtain written permission from the copyright owner if the material is not in the public domain. If the Archives cannot provide the information about the copyright owner to the patron, it is the patron’s responsibility to determine who owns copyright and to locate the copyright owner.

Review
This policy will be reviewed every three years.
**Benchmarks:**
This policy is effective if copyright ownership is respected including the moral rights of creators, but if not, the congregation risks legal action by copyright owners.

**Responsibility**
This policy is owned and supported by the Congregational Leadership Circle. The Congregational Archivist is responsible for the management and support of this policy. Congregational members and staff are responsible for transferring records to the Archives.

**Documentation**
Copyright Act, RSC 1985, c C-42
Research Agreement
Request for Reproduction
Assignment of Ownership by Photographer

**References**

**Section 11: Privacy**
The Archive should follow best practices when it comes to privacy. The records held by the archive which are the most critical to consider in terms of privacy are deceased and withdrawn Sisters’ personal files; orphanage records; and staff and student records of schools or healthcare institutions.

When processing deceased Sisters’ personal records, ensure that all health records are placed in a folder with the year of death and the label “restricted.” These records are restricted for 50 years after death. All other deceased Sisters’ personal records are restricted for two years after death, and then only available to family members.
For other records of deceased Sisters which are not personal records, these may be open to the public but if there is any sensitive information, that will be restricted for 30 years after death.

No information will ever be released about withdrawn Sisters.

Records related to staff and students of schools or healthcare institutions are only released to the person to whom they pertain or to their authorized representative, or with the written permission of the individual.

Orphanage records are only released to the next of kin if the person to whom they pertain has died, or if the person is still living, to their authorized representative, or with the written permission of the individual. Information about birth parents is not released. Records older than 100 years may be released to any member of the public. As of 2021, this means records from 1921 and earlier.

No information will be released about funding recipients or donors.

Avoid sharing photographs of children or hospital patients if they can be identified, unless the photographs are 100 years old, which means as of 2021, records from 1921 and earlier.

When taking a photograph or making a video or audio recording of any person, a Release Form must be signed by that person.

The Archives Privacy Policy is given in the next section.

**Archives privacy policy**

The *Freedom of Information and Protection of Privacy Act* (FIPPA), applies to provincial ministries and agencies, colleges and universities and municipalities and local boards. Under this legislation, access is not permitted to personal records on behalf of a third party unless consent is given by the person, but the laws permit access 30 years after the death of the person. However, records that are privately donated are excluded and access is governed by a deed of gift. The *Personal Health Information Protection Act* (PHIPA), applies to personal health records under the control of a health information custodian (not an archives). Personal health information is protected until the expiration of the earlier of 120 years after the record was created or 50 years after the death of the individual. For these types of records held in an archives, PHIPA applies.
The Personal Information Protection and Electronic Documents Act (PIPEDA), applies to private sector commercial activities in Ontario. It does not apply to non-profit or charity groups unless they are conducting commercial activities, and then only in that context. It protects personal information for 100 years after the information was collected or 20 years after the death of the person. In Ontario, FIPPA as well as federal legislation (PIPEDA and the Privacy Act) do not apply to religious archives.

The Archives will strive to follow best practices set forth under provincial and federal privacy legislation even when not governed by this legislation. The Archives will also follow the International Council on Archives’ Principles of Access to Archives.

There are records in the Archives which contain personal or sensitive information. These records include deceased Sisters’ records, withdrawn Sisters’ records, staff and student records of educational institutions, staff and patient records of health care institutions, and orphanage records. Sometimes, the information contained in these records is particularly useful for genealogists and serious researchers. Therefore, a balance must be struck which follows the spirit of the law.

For this reason, the Archives has developed a privacy protocol. In general, each request for access must be made in writing, using Research Agreement and Request for Reproduction forms. Each request is then evaluated based on the purpose of the request, who is making the request, and using this Privacy and Access Policy as a guide.

The Archives will put restrictions on records for specified time periods, should records contain sensitive information, or should such restrictions be required following best practices under privacy legislation. These restrictions may be put in place for specific periods of time, or applied only to members of the public, but will be applied equally in all cases, without discrimination based on race, gender, religion, belief, or social status of the patron.

All records transferred or donated to the Archives are subject to this Privacy and Access Policy.
The Congregational Archivist must be knowledgeable in privacy and copyright law. Archives staff may have access to restricted records to carry out their work but must keep confidential any knowledge they acquire in the course of their duties.

**General restrictions**

1. Records containing information, the disclosure of which would violate the personal privacy of a living person, will only be released to the named individual to whom they relate or her/his authorized representative, or with the written permission of the named individual, and that permission will be kept on file. These records are open to the Congregational Leader or her designate.

2. Academic records will only be released to the named individual to whom they relate, or her/his authorized representative, or with the written permission of the named individual, and that permission will be kept on file. These records are open to the Congregational Leader or her designate.

3. Information from orphanage records will only be released directly to the person to whom the records relate, or to his/her authorized representative, or with the written permission of the named individual. If that person is not living, information can be released to their next of kin. However, Ontario law prevents the release of any identifying information about birth parents. Records which are 100 years old or more are open to the public.

4. Identifying information concerning recipients of donations, bursaries, or other charitable works will not be released except to the Congregational Leader or her designate.

5. Consent is required of living persons depicted in photographs, videotapes, or sound recordings and their captions and related transcripts to publish or display. Materials will not be published or displayed if they depict children or people in trouble. A *Release Form* must be signed by the living person.

6. For both living and deceased persons, subject to the discretion and best judgement of archives staff, materials will not be published or displayed if they depict children or people in trouble.
7. Deceased Sisters’ personal files are restricted for two years after death and are open only to the Congregational Leader or her designate. After this period has expired, access is restricted to the Congregational Leader or her designate, and to family members of the deceased Sister.

8. All personal health information of any individual is restricted for 50 years after death.

9. The names of withdrawn Sisters will never be released except to the Congregational Leader or her designate.

10. Materials which contain confidential business and financial information is open only to the Congregational Leader or her designate, until the passage of time is such that the release of the information would not result in harm or prejudice to the parties identified in the materials.

11. Materials containing information about confidential decision making will only be disclosed if the decision has been made public and the nature of the determinations leading to the final decision is known, or the passage of time is such that the release of the information would not impede current decision making, or the public interest in disclosure outweighs the continued need for privacy. These materials are open to the Congregational Leader or her designate.

12. Materials restricted by statute or court order may be disclosed only in accordance with the provisions of the statute or court order.

13. The Archives may collect personal information related to donors, patrons, and volunteers, but this personal information will be kept confidential.

14. No access will be provided to unprocessed collections because this material may not have been reviewed for potential restrictions due to sensitivity or privacy.

Specific restrictions

1. Records donated to the Archives may be restricted for a specific period as agreed to in a Deed of Gift.

2. Restrictions on the records of deceased Sisters which are not their personal files may be put in place for a period of 30 years after death if the material is deemed sensitive.
3. Other access restrictions may be placed on records by the Congregational Archivist if the records are deemed for congregational use only, or as requested by the Congregational Leader or her designate. These access restrictions must specify who is allowed access, and the time period of the restriction.

**Definitions**

Open: There are no restrictions on open records.

Restriction: A restriction is a limitation on the access to archival records by a patron. Such a restriction may involve a period for which access is limited, or it may involve not allowing access to certain individuals. Such restrictions are put in place to protect personal privacy or meet requirements under the law.

**Procedure**

Decisions on restrictions will be noted in the accession record as specified in the *Deed of Gift* or *Records Transfer to Archives* form or via the electronic records submission system.

Restricted records will be noted in finding aids.

Because the Archives does not have space to store restricted records separately, these records shall remain in the fonds and series in which they are arranged. Each file in a series containing restricted records should contain a *Withdrawal Sheet* listing the restricted items.

Electronic records which are restricted may be stored in a separate space on the computer drive and the metadata will clearly indicate the conditions of the access restrictions.

If part of an item can be made available, Archives staff can make a copy of the original and redact the restricted information from the copy by blacking it out, and then providing the patron with a use copy of the redacted copy and placing the redacted copy back in the file with the *Withdrawal Sheet*.

Periodic reviews of specific restrictions should take place to determine whether the restrictions can be removed. When restrictions are removed, the *Withdrawal Sheet* and redacted copies
should be removed from any file in which these were placed, and the finding aid should be updated. The accession record should also be updated.

**Review**

This policy will be reviewed every three years.

**Benchmarks:**

This policy is effective if archival records are open to access but records that contain sensitive or private information are restricted to access, thus protecting the congregation from liability risk.

**Responsibility**

This policy is owned and supported by the Congregational Leadership Circle. The Congregational Archivist is responsible for the management and support of this policy. Archives staff are responsible for ensuring access restrictions are enforced.

**Documentation**

Personal Health Information Protection Act, 2004, SO 2004, c 3, Sch A, Release Form


Withdrawal Sheet

Research Agreement

Request for Reproduction

Records Transfer to Archives

Deed of Gift
Section 12: Image digitization guidelines – general

Overview
The main goals in digitization are to preserve fragile analogue records by providing a surrogate for handling, and to improve access to records. The digital preservation master replaces the analogue record, but the analogue record should always be kept, in case another master needs to be made. It is always best to make the preservation master from the best original, because each succeeding copy loses quality.

Making masters from originals should be infrequent since each time this takes place the original is damaged by handling. It is best to make a service master from the preservation master, and to make access copies from this. The preservation master must be migrated and stored in more than one location to protect against loss. The preservation master should be a high resolution, non-compressed (lossless not lossy), open (non-proprietary) format, with associated metadata to reduce the loss of information and ensure long-term access.

Always keep the original, whether analogue or digital. Also, always keep the digital preservation master.
Standards for photographs and text

Analogue film is a light-sensitive emulsion (often gelatin) on a base (often plastic). Light strikes silver halide crystals embedded in the gelatin, preserving the image. When the film is processed, the developer chemicals used react with the silver halide crystals. The film is rinsed, and a fixer is added which removes crystals that were not exposed to light.

There are two categories of analogue film. One category is black and white or color negative film. This is a reverse image where the blackest parts are where more light hit the emulsion, and the lightest parts are where less light hit the emulsion. Other parts are shades of gray. The negative has light passed through it onto to print onto special paper coated with light sensitive silver compounds. Color film has different layers of emulsion for different colors. It is printed the same way as black and white film.

The other category is color slides (transparency or reversal films). Color slides are direct positive films which means the film that goes in your camera and the slides you get back are the same film. Color reversal film has three color layers.6

We can produce digital surrogates of both types of analogue film using a scanner. The scanner is the input device, and the monitor and printer are the output devices. The scanner scans a black and white image in one channel grayscale, or a color image in three channels. All color in digital images is created by the output devices.

Another name for a digital image is a raster image. Digital images are made up of pixels in a grid. The pixel itself is made up of bits. Bit depth measures the numbers of colors or grays available to represent an image. A bitonal image has only two bits per pixel. A grayscale image has 8-bits per pixel \( (2^8) \), making 256 tones ranging from black (0) to 255 (white) with all 254 shades of gray in between. You can also have a 16-bit grayscale image. A color image has 24-bits per pixel in three 8-bit red, green, and blue channels. With this type of image, you have over 16 million colors \( (256 \text{ per channel} \times 256 \times 256) \). You can also have a 48-bit color image.

---

We save images in an open standard format at high resolution, whether the original is a photo or text. Image resolution is measured by pixels per inch (PPI) or how the height and width of a digital image is represented. The greater the PPI, the more samples of an image are taken, and the higher the resolution of the digital copy. To have an archival quality photo, we need to have higher PPI, larger bit depth, and more bits per pixel for color depth (8-bit for grayscale and 24-bit for color).

With printing, the actual pixels are rendered in ink. Printing resolution is measured in dots per inch (dpi) or the number of ink dots and spaces between dots printed on a square inch of paper. Digital images don’t have a true size until they are printed. CMYK (Cyan-Magenta-Yellow-Black) is the color spectrum for printing but is not used for archival scans. Instead, we use RGB (Red-Green-Blue) or grayscale. RGB is a wide color space used to capture color information about an image and is used instead of sRGB which is a narrow color space used for the web.

If possible, when using a camera, save the image in DNG (raw) or TIFF format. Set the camera to the highest resolution or file size setting which should be 10 mega pixels or higher resolution and 24-bit color depth. Save scans as uncompressed TIFF format for the master whether the source is text or image.
<table>
<thead>
<tr>
<th>Record type</th>
<th>Bit depth</th>
<th>Color space</th>
<th>Resolution</th>
<th>File Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>B &amp; W photo</td>
<td>16-bit</td>
<td>Grayscale</td>
<td>600 ppi (6000 pixels divided by long side)</td>
<td>TIFF for preservation/service master</td>
</tr>
<tr>
<td></td>
<td>(scan at 16-bit and convert to 8-bit for service master)</td>
<td></td>
<td></td>
<td>JPEG for access copy</td>
</tr>
<tr>
<td>Color photo</td>
<td>48-bit</td>
<td>Adobe RGB</td>
<td>600 ppi (6000 pixels divided by long side)</td>
<td>TIFF for preservation/service master</td>
</tr>
<tr>
<td></td>
<td>(scan at 48-bit and convert to 24-bit for service master)</td>
<td></td>
<td></td>
<td>JPEG for access copy</td>
</tr>
<tr>
<td>B &amp; W text</td>
<td>16-bit</td>
<td>Grayscale</td>
<td>300 ppi</td>
<td>TIFF or PDF/A with OCR for preservation/master/service master</td>
</tr>
<tr>
<td></td>
<td>(scan at 16-bit and convert to 8-bit for service master)</td>
<td></td>
<td></td>
<td>JPEG or PDF with OCR for access copy</td>
</tr>
<tr>
<td>Color text</td>
<td>48-bit</td>
<td>Adobe RGB</td>
<td>600 ppi (6000 pixels divided by long side)</td>
<td>TIFF or PDF/A with OCR for preservation/master/service master</td>
</tr>
<tr>
<td></td>
<td>(scan at 48-bit and convert to 24-bit for service master)</td>
<td></td>
<td></td>
<td>JPEG or PDF with OCR for access copy</td>
</tr>
<tr>
<td>35 mm (1 3/8” x 1”) to 4” x 5” negatives and slides</td>
<td>48-bit</td>
<td>Adobe RGB or grayscale</td>
<td>4000 ppi (6000 pixels on long side)</td>
<td>TIFF for preservation/service master</td>
</tr>
<tr>
<td></td>
<td>(scan at 48-bit for color and 16-bit for b&amp;w and convert to 24-bit for color or 8-bit grayscale for b&amp;w service master)</td>
<td></td>
<td></td>
<td>JPEG for access copy</td>
</tr>
</tbody>
</table>
Color management

The workflow for color management involves scanning original photographs using a calibrated monitor and scanner and editing in the Adobe RGB (1998) workspace for color images or Gray Gamma 2.2 workspace for grayscale images.

A color space is a color range, and there are different color spaces for different purposes. Your scanner has a device dependent color space and so does your monitor. This color space includes the colors that can be captured or displayed relative to a set of reference colors. This set of reference colors is either CIE xyz (1931), CIE L*a*b*, or CIE L u'v' (1976).

The information about the color space used by a device (such as a scanner, monitor or printer) is called a profile. This is a color space saved as a document on your hard disk. It describes but does not control or change the device. It defines the relationship between the numeric values of pixels the device receives and transmits, and a standard ICC color space based on the CIE measurement system.

A Color Management Module (CMM) such as Adobe ACE uses the profiles for your scanner and monitor along with the rendering intent you select to translate color in an image file between your devices. The rendering intent tells the CMM how to treat colors which are out of the color range (known as gamut) when translating between color spaces. There are three main rendering intents: perceptual, relative, and absolute colorimetric. Perceptual rendering intent squeezes the colors from a larger color space into a smaller space, and the colors in the smaller space may shift. Relative rendering intent cuts off colors from a larger color space so that there is no change to the colors that must fit into a smaller space. Absolute rendering intent keeps the white point in the larger and smaller color spaces the same.

A working space is a work area which is not tied to any device. The working space constrains colors to a standard range such as Adobe RGB (1998) in image editing programs like Photoshop. Photoshop assigns new image files a profile based on the Working Space options you select in the Color Settings dialog box. The two common working color spaces are Adobe
RGB (1998) and sRGB IEC61966-2.1. (ProPhoto RGB is the widest gamut color space, and sRGB is the smallest.) We use Adobe RGB (1998) as our working space. When editing in Photoshop, we may also choose to display the L*a*b* values when editing slides or negatives.7

Our archive uses a NEC MultiSync P232W LCD monitor. (The monitor displays sRGB color which is a smaller gamut than RGB display.) Make sure the monitor is calibrated to D65 (6500 degrees Kelvin) at 120-140 cdm (120 candelas per square meter), 24 millions of colors, Gray Gamma 2.2. It should be calibrated every month. The Spectra View software and Spectra Sensor Pro colorimeter tool creates the profile for the monitor.

*When using the colorimeter, make sure to position it with the white side (diffuser) facing out towards you and the lens on the monitor surface.* The software will ask the monitor to display color values, and the colorimeter will measure the colors that are produced. If the color values produced don’t match what is expected, the profile that is produced will reflect this and adjust the monitor to get closer to the expected color values.

If you are measuring the ambient light in the room, set the colorimeter on the monitor, put the diffuser over the lens and point it away from the monitor. In this case, both the lens and diffuser face away from the monitor towards you. The ISO recommendation is a room illumination of < 32 lux and 5000 K.

Our archive uses an Epson Perfection V700 Photo Scanner with an optical resolution of 4800 ppi and 6400 ppi. We use an IT8 target and SilverFast software to build an ICC profile for our Epson V700 scanner, and a profile for our Epson Sure Color P400 printer.8 We also have a large format scanner, the Epson Expression 12000XL Graphic Arts Scanner.

---

7 L stands for lightness, *a stands for red green, and *b stands for yellow blue.

General scanning and editing tips

1. For oversize items use the Epson Expression 12000XL Graphic Arts Scanner or a desktop tripod. Place a level on the tripod and on the item being photographed to ensure they are level. Place weights on the tripod to position it if you need to bend it over the item. Use small supports under one side of a book to keep the sides level if the spine is open.

2. Don’t apply any automatic adjustments while scanning, other than Unsharp Mask.

3. The service master is edited only to rotate it if needed, to crop out the color target, and to correct color and tone.

4. In Photoshop, do not use any tools that make automatic or global editing changes.

5. Don’t work on “layers” in Photoshop to make editing adjustments.
Quality control

1. You can check the quality of your scan by double clicking on the image file to open it in Photoshop. Make sure to view the image at a 1:1 ratio. Do this by choosing View > 100% or click 100% in either the Zoom tool or the Hand tool options bar. Compare the scanned image visually with the original image. *It is better to rescan than to try to correct using Photoshop.* Make sure the image is the correct orientation and straight. There should be no dust or dirt spots, no banding or posterization, no moiré patterns and no pixelation. If batch scanning, inspect 10% of the preservation masters.

Compare this well-digitized photo with the poorly digitized version of it that follows:
Banding looks like this on the sky in this photo:

Moiré patterns show up on the pillars and stonework design in this photo:
*Pixelation* looks like the polka dot effect in this photo:

![Pixelated Image]

Once you have finished, if you want, you can upload scanned targets and images to evaluate whether they adhere to Federal Agencies Digital Guidelines Initiative (FADGI) standards at [http://delt.ae/](http://delt.ae/)
Prepare images

Always wear gloves, even when handling the color target and scanner. This is what happens when you don’t wear gloves. The acids on the finger have etched a fingerprint into the emulsion on this photograph:

Remove dust from the image using a blower, compressed air, or brush. For slides and negatives, use a magnetic brush and compressed air.

Use PEC 12 for removing greasy or oily residue on photographic prints. Spray it onto a cotton swab. See Appendix V for more on cleaning photographs.

Let the scanner and monitor warm up for half an hour. Clean the monitor screen with a PEC pad. Clean the scanner white pad and glass underneath the pad first, then the glass platen with a PEC pad or blower.
File naming

The digital file name contains the identifier, which does not have any affixes. Write the identifier without any prefixes or suffixes on the photograph enclosure or base side of slide. See identifiers in bold examples below:

For arranged items, use the archive numbering system. Use hyphens or underscores, not spaces, and lower case.

| f01-s001-01-001-title.tif = filename | mf01-s001-01-001-title.tif = filename |

For non-arranged items, number each subseries and items within the series consecutively. Use hyphens not spaces and lower case. Use prefix lo- for London, pt- for Peterborough, pe- for Pembroke, ha- for Hamilton and ma- for Main archive. Follow each prefix with a consecutive three-digit number for each subseries. Each item is then given a consecutive three-digit number.

| Series = Slides Book 1              | Subseries = lo-002-Concert-Band    |
| Subseries = lo-001-Mount-St-Joseph-Motherhouse | lo-002-001-concert-band.tif       |
| lo-001-001-msj-motherhouse.tif      |                                  |

| Series = Peterborough              | Series = Pembroke                 |
| Subseries = pt-001-St. Joseph’s Hospital | Subseries = pe-001-Music School |
| pt-001-001-sjhospital.tif          | pe-001-001-music-school.tif      |
Metadata
Record metadata in the *Digitization Log*, which is a spreadsheet. The information to record on
the spreadsheet in advance of digitizing is show below, with required Dublin Core fields. Do not
use ending punctuation except in the *Description* column. Do not put a period after an
abbreviation. Also record the measurements of the photograph in the *Digitization Log*.

Use text for the *Date* column in the spreadsheet.

In the *Rights* column in the spreadsheet, indicate if the item is in the public domain. Remember
that anything pre-1949 is in the public domain. We can only upload public domain images to
Flickr Commons and Wikimedia Commons.

Table 2 Metadata fields for images

<table>
<thead>
<tr>
<th>Dublin Core</th>
<th>IPTC</th>
<th>FotoStation</th>
<th>Wordpress library</th>
<th>Wordpress archive items</th>
<th>Photoshop</th>
<th>Flickr</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title</td>
<td>Title</td>
<td>Title</td>
<td></td>
<td>Title</td>
<td>Title</td>
</tr>
<tr>
<td>Subject</td>
<td>Keywords</td>
<td>Keywords</td>
<td>Keywords</td>
<td></td>
<td>Keywords</td>
<td>Keywords</td>
</tr>
<tr>
<td>Creator</td>
<td>Creator</td>
<td>Byline</td>
<td>Creator</td>
<td></td>
<td>Creator</td>
<td></td>
</tr>
<tr>
<td>Rights</td>
<td>Copyright notice</td>
<td>Copyright string</td>
<td>Copyright notice</td>
<td></td>
<td>Copyright notice</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
<td>Description/caption</td>
<td>Caption</td>
<td></td>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Date YYYY</td>
<td>Date created</td>
<td>Created date</td>
<td></td>
<td></td>
<td>Date created</td>
<td></td>
</tr>
<tr>
<td>YYYY-MM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>YYYY-MM-DD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
NOTES ON REQUIRED FIELDS:

Label: **Title**
Definition: An unambiguous reference to the resource within a given context.
Comment: Use the file name. Give the identifier in the file name: e.g., *f01-s001-01-001-title*

Label: **Subject**
Definition: The topic of the content of the resource.
Comment: Use controlled vocabulary and semicolon delimiters. Do not use a comma between words in a phrase. Can also use Library of Congress Subject Headings, e.g., *London Ont.*

Label: **Creator**
Definition: An entity primarily responsible for making the content of the resource.
Comment: Use name of author, photographer, interviewee if known. Otherwise put “unknown,” e.g., *Beta Photos*

Label: **Rights**
Definition: Information about rights held in and over the resource.
Comment: No material should be digitized unless copyright or copyright permission is held by the Congregation, or the material is in the public domain.

Indicate whether public domain, name of copyright holder, or “Congregation continues to research.” The following statements may be used (from: [https://rightsstatements.org/en/](https://rightsstatements.org/en/))

**If no known copyright, and fairly sure item is no longer under copyright, give this statement:** *The organization that has made the Item available reasonably believes that the Item is not restricted by copyright or related rights, but a conclusive determination could not be*
made. Please refer to the organization that has made the Item available for more information. You are free to use this Item in any way that is permitted by the copyright and related rights legislation that applies to your use.

If copyright has not been determined but an effort has been made, give this statement: The copyright and related rights status of this Item has been reviewed by the organization that has made the Item available, but the organization was unable to make a conclusive determination as to the copyright status of the Item. Please refer to the organization that has made the Item available for more information. You are free to use this Item in any way that is permitted by the copyright and related rights legislation that applies to your use.

If likely that item is still copyrighted but unable to locate copyright holders, give this statement: This Item is protected by copyright and/or related rights. However, for this Item, either (a) no rights-holder(s) have been identified or (b) one or more rights-holder(s) have been identified but none have been located. You are free to use this Item in any way that is permitted by the copyright and related rights legislation that applies to your use.

Label: Description
Definition: An account of the content of the resource.
Comment: Use a photo caption, a summary, or describe in your own words, e.g., Callistus Arnbsy in a traditional habit. Use information from the file in which the photograph was arranged and from the finding aid to prepare this description to supply context to the item.

Label: Date
Definition: A date associated with an event in the life cycle of the resource.
Comment: Give the original date the photo or document was created. Use hyphen delimiters. Give in this order: YYYY-MM-DD. If only the year is known, give YYYY. If only the year and month are known give YYYY-MM, e.g., 1900. If the date is approximate, give the earliest approximate date with “circa” before the date.
Section 13: Workflow for print photographs

1. Make sure images are arranged and numbered within a fonds, or according to the established numbering system for non-arranged images. See Sections 6 and 12 on file naming.

   Create a preservation master folder and a service master folder with the collection title (e.g., hf01-s005-sjconvent-preservation and hf01-s005-sjconvent-service). In a later step, you will move the digitized images to these folders.

2. Measure the length and width of each image in inches, not including any borders or the mat, and record on spreadsheet.

3. Photographs are numbered on back (verso) on lower right corner using a Stabilo or soft lead pencil.

4. Make sure the image is straight and oriented correctly on the scanner bed. If not, fix it before scanning. You don’t want to make rotations in Photoshop because this will slightly degrade the image. If necessary, when editing, it is permissible to rotate service masters by 90 degrees, but never preservation masters.

5. Place a black matboard behind prints before scanning. Use the white document mat. Include the color target along the short side of the print when you scan, leaving a space between the print and target so that the target can be cropped out later. The black patch should be on the lower right.
6. We scan the X-Rite Color Checker Mini target along with the color or black and white photograph. This gives us a constant reference point for color and grayscale. For both color and black and white photographs use the Lindbloom chart to compare target values for black ((53-53-53), gray (122-121-120), and white (242-241-236)). These correspond to the color target white, gray, and black patches on the bottom row:

![Image of X-Rite Color Checker Mini target]

<table>
<thead>
<tr>
<th>Adobe (1998)</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>106</td>
<td>182</td>
<td>103</td>
<td>95</td>
<td>129</td>
<td>133</td>
<td>81</td>
<td>149</td>
<td>130</td>
</tr>
<tr>
<td>81</td>
<td>149</td>
<td>122</td>
<td>108</td>
<td>128</td>
<td>189</td>
<td>67</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>67</td>
<td>130</td>
<td>154</td>
<td>69</td>
<td>174</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>194</td>
<td>79</td>
<td>170</td>
<td>84</td>
<td>167</td>
<td>213</td>
<td>121</td>
<td>85</td>
<td>186</td>
</tr>
<tr>
<td>121</td>
<td>91</td>
<td>85</td>
<td>62</td>
<td>186</td>
<td>162</td>
<td>48</td>
<td>97</td>
<td>73</td>
</tr>
<tr>
<td>48</td>
<td>162</td>
<td>97</td>
<td>105</td>
<td>167</td>
<td>57</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>101</td>
<td>152</td>
<td>228</td>
<td>164</td>
<td>63</td>
<td>62</td>
<td>48</td>
<td>83</td>
</tr>
<tr>
<td>62</td>
<td>148</td>
<td>48</td>
<td>199</td>
<td>83</td>
<td>134</td>
<td>149</td>
<td>58</td>
<td>144</td>
</tr>
<tr>
<td>149</td>
<td>76</td>
<td>58</td>
<td>55</td>
<td>144</td>
<td>163</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>242</td>
<td>200</td>
<td>159</td>
<td>122</td>
<td>84</td>
<td>53</td>
<td>241</td>
<td>160</td>
<td>121</td>
</tr>
<tr>
<td>241</td>
<td>200</td>
<td>160</td>
<td>121</td>
<td>84</td>
<td>53</td>
<td>236</td>
<td>159</td>
<td>120</td>
</tr>
<tr>
<td>236</td>
<td>199</td>
<td>159</td>
<td>120</td>
<td>84</td>
<td>53</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

7. Open **SilverFast** software and press the *Start* button.


9. Under the palm tree icon buttons, select *Reflective*, *Positive*, and *48-bit color* for color images and *16-bit grayscale* for black and white images. Do not select the HDR options.

10. Under *Name*, use file naming conventions and add the fonds, series, subseries, file, and item number to the file name. Give the name of the record group as part of the file name, for example, hf01-s005-01-05-001-sjconvent.

11. Set the scanning resolution under *Preset* to scan at 6000 pixels along the long side of the object. For example, to scan a 4” x 5” photograph, set the scanning resolution to 1200 ppi. The formula is 6000 pixels divided by the long side in inches, in this case, 6000 divided by 5” = 1200 ppi.
12. Choose *Prescan*. There should be a red marquee around the image. Move the marquee by pulling from the top left and bottom right corners to set image borders including color target.

13. Select *Scan*. When finished, you will have a preservation master.

14. Open the preservation master folder in *FotoStation*. Complete these metadata fields: title, keywords, byline, copyright string, description/caption, created date. There are two ways to add metadata. You can select all the images in a folder at once and then click on the add metadata icon at the top and add metadata to each image. Or you can select one image at a time and then click on the metadata icon at the top and add metadata. Use the drop-down menu to add subject terms (keywords). You will get a message if a metadata field is missing.
You can copy the metadata from one image to another image. Select the image with the metadata you want to copy, then use the keyboard shortcut CTRL-SHIFT-C and then select the image you want to copy the metadata to, and use the keyboard shortcut CTRL-SHIFT-V.

Note that the title field does not flow in from SilverFast but must be added in the metadata field in FotoStation. If the title is incorrect, you can use the “rename” feature in FotoStation but be sure you enter the correct title in the metadata field. To make global changes across many image files, you can use the “search and replace” feature in FotoStation.

15. Select the image and under Image on the top menu, choose “Open in Photoshop.” Select Window > Info. Select Image > Adjustments > Curves.

In Curves, you will see a graph dialog box. The upper right area of the graph represents the highlights, and the lower left area represents the shadows. The horizontal axis represents the input levels (original image values), and the vertical axis represents the output levels (adjusted values). You can add more points directly to the curve to adjust areas. Dragging a control point up or down adjusts the brightness, and dragging it left or right adjusts the contrast.

You can check and uncheck the Show Clipping box to see if clipping occurs as you work. You can also toggle between the before and after views by checking or unchecking the preview box. If the preview box is checked you see the changes you made, and if it is unchecked you see the original image.

16. Hover over the target patches to see the number value. Check if they match the Lindbloom chart values repeated below, varying only by + or – 10:
If the target values do not match, select the eyedropper tool on the Tools palette on the left side of the screen. Use the CTRL or CMD key and click the gray patch on the target to set a point on the histogram. Hover over the target and use the arrow key on the keyboard to bring the value up or down. The Info panel in the top right corner of the screen will show the original RGB value and the adjusted RGB value, e.g., 48/50 where 48 is the original value. Continue adjusting until the target values match the values in the chart. Follow the same steps to adjust the RGB values for white and black.

<table>
<thead>
<tr>
<th>White</th>
<th>Gray (third from black)</th>
<th>Black</th>
</tr>
</thead>
<tbody>
<tr>
<td>R 242</td>
<td>R 122</td>
<td>R 53</td>
</tr>
<tr>
<td>G 241</td>
<td>G 121</td>
<td>G 53</td>
</tr>
<tr>
<td>B 236</td>
<td>B 120</td>
<td>B 53</td>
</tr>
</tbody>
</table>

17. Another way to correct color images is to choose the eyedropper tool from the toolbar and choose the option Sample Size: 5 by 5 average. With the eyedropper tool, mouse over a white or neutral gray area of the image, and shift and click to create a sample. Check the RGB color values of the sample in the Info panel. For true white or neutral gray, the RGB values should be close. Click on the line in the histogram and drag it down,
checking the sample values in the Info panel. The first value is the original value, and the second is the changed value. Keep dragging until the R value matches the G value. Check the blue channel and increase or decrease. Then click OK. Check the image to make sure it looks correct.

18. You can also correct tone and contrast in color images. First, check the Show Clipping box. Then use the sliders on the histogram in each channel starting with red, then green, then blue. Select RGB to see the result. If you want the image to be brighter, drag the white line in the histogram up from the center.
19. For grayscale images, use the L*a*b* values given in Table 3 below.

Adjust the middle gray first. Choose the eyedropper tool on the *Tools* palette on the side. Use the CTRL or CMD key and click to put an adjustment point on the curve in the center of the grid. Using the eyedropper tool, hover over the part of the image that you think should be middle gray. Use the arrow keys to increase or decrease the value so that the L* value in the Info panel reads 45-55. Then adjust the shadows (black) and highlights (white) by putting adjustment points on the left and right sides of the curve and using the arrow keys to set values as per the L*Ab* chart. The curve should have an “S” shape.
FADGI guidelines state that the darkest part of the image should be no darker than L* 5 and the lightest part no brighter than L* 91-101.
Table 3 L*a*b* values for black and white images

<table>
<thead>
<tr>
<th>Lightness</th>
<th>Texture range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-9</td>
<td></td>
<td>Pure black</td>
</tr>
<tr>
<td>9-18</td>
<td></td>
<td>Near black, with slight tonality but no texture</td>
</tr>
<tr>
<td>18-27</td>
<td>✓</td>
<td>Textured black; the darkest part of the image in which slight detail is recorded</td>
</tr>
<tr>
<td>27-36</td>
<td>✓</td>
<td>Average dark materials and low values showing adequate texture</td>
</tr>
<tr>
<td>36-45</td>
<td>✓</td>
<td>Average dark foliage, dark stone, or landscape shadows</td>
</tr>
<tr>
<td>45-55</td>
<td>✓</td>
<td>Middle gray, clear north sky, dark skin, average weathered wood.</td>
</tr>
<tr>
<td>55-64</td>
<td>✓</td>
<td>Average Caucasian skin, light stone, shadows on snow in sunlit landscapes</td>
</tr>
<tr>
<td>64-73</td>
<td>✓</td>
<td>Very light skin, shadows in snow with acute side lighting</td>
</tr>
<tr>
<td>73-82</td>
<td>✓</td>
<td>Lightest tone with texture, textured snow</td>
</tr>
<tr>
<td>82-91</td>
<td></td>
<td>Slight tone without texture, glaring snow</td>
</tr>
<tr>
<td>91-100</td>
<td></td>
<td>Pure white, light sources and specular reflections</td>
</tr>
</tbody>
</table>

Here is an example of a black and white image before and after minimal editing:
20. To correct tone and contrast on images, check the *Light (0-255)* radio button and check the *Show Clipping* box. Then move the slider on the left side of the histogram until you see clipping. (Check for dots on the background of the image but ignore the borders if these show clipping). Then move the slider slightly back until there is no clipping. Do the same with the slider on the right side of the histogram. Then uncheck the *Show Clipping* box and uncheck the *Preview* box to see the image before your changes. Check the *Preview* box to see the image after your changes.

21. To add contrast, make the histogram curve into an S-curve by clicking on it to add a point for highlights and pulling it up and left. This will make the input value a higher output value and the image will lighten. Then add a point for darks and pull it down and right. This will make the input value a lower output value and the image will darken.

22. Rotate to portrait from landscape if necessary and crop out the color target in print photos. If the image is not straight, you can:

   a. Go to the ruler tool from the *Tool* window by pressing the bottom right corner of eyedropper tool and choosing ruler tool.

   b. Click and drag from the bottom right horizontal corner of the image to the bottom left horizontal corner, drawing a horizontal line.

   c. Click the *Straighten Layer* button at the top, in the options bar.
23. Go to *Window > Actions >CSJ Archives Actions >Create service master and click on it.*

Press the *Play* button. This will run through all the actions required to produce a service master image file and save it in the service masters folder.

24. Go to *Window > Action >CSJ Archives Actions > Create access copy and click on it.*

Press the *Play* button. This will run through all the actions required to produce a compressed JPEG format image file and save it in the access copies folder. **NOTE:** You can skip this step and save time if you want to create access copies from all the service masters at once after you’ve made all the service masters. In this case, choose the “Make access copies” action in *FotoStation.*

25. You will need to move the image files from the preservation master and service master folders. Use the folders which you created earlier (e.g., hf01-s005-preservation and hf01-s005-service). Then select the files and use the “Move” action in *FotoStation* to move the files.

26. Upload the access copies to *Flickr The Commons.* You don’t need to keep access copies because you can create them from service masters again if needed.

27. Bag the preservation master folder for long-term storage on drive A. You will need to assign and record the accession number.
Section 14: Workflow for slides and negatives

1. Make sure images are arranged and numbered within a fonds, or according to the established numbering system for non-arranged images. See following section on file naming conventions (also Section 6).

2. Create and name folders in which images will be stored on the drive.

3. View slides on a 5000K light box. Place the slides on the lightbox emulsion side up. When slides are arranged, number them on the base side.

Slides are labelled on the top of the base side of the cardboard or plastic frame using a Stabilo pencil. Note: It can be hard to tell the base and emulsion sides apart. These tips may help:

- Base side: glossy, shiny, images and words are not reversed in image.
- Emulsion side: less glossy, dull, image in relief, images and words appear backward in image, curls, says “this side toward screen”, says “Kodachrome Transparency.”

4. For slides, remove the white document mat on the inside lid of the printer by gently sliding the mat up and off. Use the slide holder and carefully put one slide into each slot, base (numbered) side facing down. Put the slides in the slide holder in this order with the white arrows facing up on the right side:

<table>
<thead>
<tr>
<th>009</th>
<th>005</th>
<th>001</th>
</tr>
</thead>
<tbody>
<tr>
<td>010</td>
<td>006</td>
<td>002</td>
</tr>
<tr>
<td>011</td>
<td>007</td>
<td>003</td>
</tr>
<tr>
<td>012</td>
<td>008</td>
<td>004</td>
</tr>
</tbody>
</table>
5. **For negatives**, the top of the film should give the name of the manufacturer, the film type, and ISO/ASA. Remove the white document mat. Place the negatives into the negative holder with the shiny base side down. Images and words should appear backwards on the side that faces up. The white arrows on the negative holder will match the arrows on the scanner bed.

6. Open **SilverFast** software and press *Start* button. Set color management. For slides, under *Edit > Preferences > CMS > Profiles*, Input=SF_T (Epson Perfection V700).

7. With **SilverFast**, when you select *Negative*, the *NegaFix* option is enabled. Enter the manufacturer, film type and ISO/ASA. If you don’t know, choose *Manufacturer* = other; *Film Type* = other; *ISO/ASA* = standard.
8. Open **SilverFast** and set preferences for color management under *Edit > CMS > Profiles* and under the palm tree icon buttons, select *Transparency, Positive or Negative*, and *48-bit color* for color images and *16-bit grayscale* for black and white images. (Do not select the HDR options.)

9. Allow the software to assign name “Image 1”, etc. Select *TIFF*. Under *Path*, choose the folder to store the files in. Select *Format > Custom*. For 35 mm slides, set the resolution under *Preset* to 4000 ppi.
10. Choose *Prescan*. Select *Find Frames* > Slide 35 mm holder. Check that slides are correctly oriented and have been scanned base side down. If not, manually fix and redo the *Prescan* and *Find Frames*. 
11. Select Image > Batch Scan. The software will automatically assign a name which you will change in FotoStation. Choose a folder in which to save the image files. When the scanning is complete, this will be indicated in the bottom of the left side menu.

12. Open the preservation master folder in FotoStation. Add metadata to the images. There are two ways to do this. You can select all the images in a folder at once and then click on the add metadata icon at the top and add metadata to each image. Or you can select one image at a time and then click on the metadata icon at the top and add metadata. Use the drop-down menu to add subject terms (keywords). You will get a message if a metadata field is missing.

You can copy the metadata from one image to another image. Select the image with the metadata you want to copy, then use the keyboard shortcut CTRL-SHIFT-C and then select the image you want to copy the metadata to, and use the keyboard shortcut CTRL-SHIFT-V.

13. Rename the images by selecting the images and choosing Image on the top menu bar and choosing “Rename.” If the incremental numbering checkbox is selected, you can add an
incremental number suffix to each image. The numbering will apply depending on the order in which images were selected.


In *Curves*, you will see a graph dialog box. The upper right area of the graph represents the highlights, and the lower left area represents the shadows. The horizontal axis represents the input levels (original image values), and the vertical axis represents the output levels (adjusted values). You can add more points directly to the curve to adjust areas. Dragging a control point up or down adjusts the brightness, and dragging it left or right adjusts the contrast.

You can check and uncheck the *Show Clipping* box to see if clipping occurs as you work. You can also toggle between the before and after views by checking or unchecking the preview box. If the preview box is checked you see the changes you made, and if it is unchecked you see the original image.

15. Compare the original slide on the light table with the scanned file. If there is a color cast, you may need to adjust using *Curves*.

16. To correct tone and contrast on images, check the *Light (0-255)* radio button and check the *Show Clipping* box. Then move the slider on the left side of the histogram until you see clipping. (Check for dots on the background of the image but ignore the borders if these show clipping). Then move the slider slightly back until there is no clipping. Do the same with the slider on the right side of the histogram. Then uncheck the *Show Clipping* box and uncheck the *Preview* box to see the image before your changes. Check the *Preview* box to see the image after your changes.

17. To add contrast, make the histogram curve into an S-curve by clicking on it to add a point for highlights and pulling it up and left. This will make the input value a higher output.
value and the image will lighten. Then add a point for darks and pull it down and right. This will make the input value a lower output value and the image will darken.

18. You can also correct tone and contrast in color images. First, check the Show Clipping box. Then use the sliders on the histogram in each channel starting with red, then green, then blue. Select RGB to see the result. If you want the image to be brighter, drag the white line in the histogram up from the center.

19. Rotate to portrait from landscape if necessary. If the image is not straight, you can:
   a. Go to the ruler tool from the Tool window by pressing the bottom right corner of eyedropper tool and choosing ruler tool.
   b. Click and drag from the bottom right horizontal corner of the image to the bottom left horizontal corner, drawing a horizontal line.
   c. Click the Straighten Layer button at the top, in the options bar.

20. Go to Window > Actions >CSJ Archives Actions > Create service master and click on it. Press the Play button. This will run through all the actions required to produce a service master and save it in the service masters folder.

21. Go to Window > Action >CSJ Archives Actions > Create access copy and click on it. Press the Play button. This will run through all the actions required to produce a compressed JPEG format file and save it in the access copies folder. **NOTE:** You can skip this step and save time if you want to create access copies from all the service masters at once. In this case, choose the “Make access copies” action in **FotoStation.**

22. You will need to move the files from the preservation master and service master folders. Use the folders which you created earlier (e.g. hf01-s005 -preservation and
hf01-s005-service). Then select the files and use the “Move” action in FotoStation to move the files.

23. Upload the access copies to Flickr The Commons. You don’t need to keep access copies because you can create them from service masters again if needed.

24. Bag the preservation master folder for long-term storage on drive A. You will need to assign and record the accession number.

Section 15 Printing photographs

1. When you are ready to print, Open Photoshop. Choose Image > Image Size. Make sure that all three boxes at the bottom are checked: Scale Styles, Constrain Proportions, and Resample Image.

2. Change the Document Size to the appropriate size you want to print to in inches or cm or mm. The Resolution should be 300 pixels/inch.

3. Change the very bottom drop-down choice to: Bicubic Sharper if you are making the image smaller to print.


5. Select:
   
   Printer = Epson C84081 (SC-P400 series)
   Color Handling = Photoshop Manages Colors
   Color Profile = SF8_PrinterCalibrationProfile
   Rendering Intent = Perceptual

Check Scale to fit.
6. Click Print Settings and you will be inside the printer dialog box where options are provided by the printer driver and not Photoshop. Under Paper Settings > Size, choose Photo Series from the drop-down menu and select the photo size. Under Page Layout choose portrait or landscape. Under Media Settings, make sure Mode = Off (No Color Adjustment).

7. To figure out the print size from the resolution, you divide the scan resolution by the print resolution. For example, if a scan has a resolution of 4,800 ppi x 6,000 ppi and the printer requires 300 dpi:

\[
\frac{4,800}{300} \times \frac{6,000}{300} = 16 \times 20\text{-inch print at 300 dpi.}
\]

Section 16: Instructions for making a PDF/A
PDF/A is the preservation standard for digital text based on PDF 1.4. Everything that is needed to view the file is contained within the file and it can be viewed without specific hardware or software in the future. It complies with ISO 32000-1. Metadata like title, author, creation date,
modification date, subject, keywords, can be stored in a PDF/A file. PDF/A-1 files must contain embedded fonts, device independent color and XMP metadata. They may not be encrypted, have embedded files, JavaScript, LZW compression, multi-media, PDF transparency or external content references. Microsoft Word, PowerPoint, and PDF files may all be converted to PDF/A format.

There are several versions of PDF/A each of which supports all the features of the earlier version and includes more features. Each version has different conformance levels. For example, PDF/A-1a preserves the logical structure of the file and Unicode mapping, while PDF/A-1b does not, but is easier to produce. The first version, PDF/A-1, is the most basic version compared to PDF/A-2 and PDF/A-3. It requires that transparency is removed, and layers flattened to create a PDF/A since these features are not found in PDF 1.4. A PDF/A created from a digital text document will have searchable text. If creating a PDF/A from a scanned document, the PDF/A-1b format must be used with OCR. You can create a PDF/A from within a Microsoft Word file, but only PDF/A-1b. You can also create a PDF/A using ABBY FineReader. Verify that the PDF/A conforms to the standard by running Vera PDF software.

To add metadata to a PDF, select File > Properties > Description (and) Additional Metadata. The current PDF/A fields under Properties that match Dublin Core are all required fields:

<table>
<thead>
<tr>
<th>PDF/A</th>
<th>Dublin Core</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Title</td>
<td>Title</td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Author</td>
<td>Creator</td>
</tr>
<tr>
<td>Copyright Notice</td>
<td>Rights</td>
</tr>
<tr>
<td>Keywords</td>
<td>Subject</td>
</tr>
</tbody>
</table>
Section 17: Digitizing audio

Digital audio is a format in which acoustic sound waves are converted into digital signals that can be read by a machine. There is a wrapper, which is the format specified by the file extension, and an encoding method or codec. Digital audio should be sampled 96 KHz and 24-bits. Number of samples per second is measured in Hz. With digital audio files, the bit depth is the dynamic range. The higher the bit depth, the more data. Doubling the bit depth results doubling the file size. A 16-bit file is 65,536 possible values. A 24-bit file is 16.7 million possible values.

What about size and duration? For uncompressed audio, a file that is 1 GB at 24-bits/96 kHz (WAV format) is 1.01 hours in duration. A file that is 2 GB at 24-bits/96 kHz (WAV format) is 2.02 hours in duration. For compressed audio, a file that is 1 GB at 256 kb/s (MP3 format) is 8 hours in duration. A file that is 2 GB at 256 kb/s is 17 hours in duration. What about storage? One archival gold CD-R holds 700 MB. One Zoom H2N recorder digital file holds 2048 MB (2 GB).

Standards for audio

<table>
<thead>
<tr>
<th>File format</th>
<th>Preservation and Service Master</th>
<th>Version</th>
<th>Access and Screen Copy</th>
</tr>
</thead>
<tbody>
<tr>
<td>WAV (Waveform Audio File Format) or BWF (Broadcast Wave Format)</td>
<td>BWF Vers. 0, 1 and 2</td>
<td>MP3 (MPEG Audio Layer III)</td>
<td></td>
</tr>
</tbody>
</table>

| Sample rate | 96 kHz | 48 kHz |
| Bit depth   | 24-bit | 16-bit |
| Codecs (encoding method) | LPCM (Linear Pulse Code Modulated Audio) | MP3enc or Lame |
Gathering information for audio digitization
You will likely digitize audio cassettes, which are magnetic coating on 1/8” plastic film in a plastic container. Most cassettes have four stereo tracks with the recording time indicated, e.g., C-60 which is 30 minutes per side. There are four types of magnetic coating: Type I (Normal), Type II (Chromium Dioxide), Type IV (Metal), and Type III (FeCr). 10

In the photo below, the cassette at the top with write-protect notches covered by tabs is Type I. The cassette below it with additional notches next to the write-protect tabs, is Type II. The bottom two cassettes, which have Type II notches plus an additional pair of notches in the center, are Type IV. The tabs on the bottom tape have been removed so the tape is write-protected.

The manufacturer is listed on the cassette case. The total capacity is given as run times, usually C46 (23 min. per side), C60 (30 min. per side), C90 (45 min. per side), and C120 (60 min. per side). Tapes with longer running times are more prone to breakage because the tape is thinner.

10 The discussion on digitizing audio cassettes is based on the information provided in Irving K. Barber Learning Center, ‘Indigitization,’ http://www.indigitization.ca/indigitization-toolkit/audio-digitization/audio-cassette-tape/planning-before-starting-an-audio-cassette-digitization-project/

Photo and summary by Lgreen-commonswiki
https://commons.wikimedia.org/wiki/File:Cassette_Write_Protect_IV.jpg

126
Record metadata in the *Digitization Log*, which is a spreadsheet. The information to record on the spreadsheet in advance of digitizing is show below, with required Dublin Core fields marked **:

**Identifier** – e.g., *M25*.

**Title** – give information from cassette label.

**Description** – give further information about cassette from label.

**Creator** – give name of interviewee.

**Rights** – note if there are consent forms and copyright permissions on file.

**Date** – give date of recording or date range.

**Extent** – indicate actual recorded time, not cassette capacity, e.g., *1:40:10*.

**Original form of material** – indicate analogue format including tape type (I, II, III or IV), manufacturer, tape run time capacity (C46, C60, C90, or C120).

**Locator** – give storage location.

**Comments** – note if this is a music or voice recording, specific event, autobiography, oral history, religious service, meeting, etc. Later, as you digitize the audio, you will be listening to it, and can record additional notes in the Comments section.

---

**Condition assessment**

1. Use the *Condition Report* for doing a condition assessment. Record all findings in the form, as well as any repairs/cleaning undertaken. See an example of the *Condition Report* at the end of this section.

2. Look for signs of mold, pests, acidity, water damage, and light damage on the storage box and cassette case. *Do not smell or breathe if you suspect mold or pest droppings* as airborne contaminants can be harmful to your health. If problems are found, quarantine the container and its contents in a ziplock bag away from other materials.
3. Look at the audiocassette. Note any damage to the hard shell-like cracks or missing pieces. Look for signs of mold, pests, water damage, and light damage. Only if you do not find any signs of mold or pests, carefully fan the air surrounding the cassette towards your nose and note any smell which may indicate chemical breakdown.

4. Look at the opening along the bottom of the cassette. There should be a small piece of felt attached to a tiny metal plate which supports the tape where it meets the playback head. Note its condition and if it may need to be replaced.

5. Next, examine the tape. Take care doing this because the tape might be damaged and break if handled too aggressively. If the tape breaks or is already broken, see the splicing instructions section. Some cassette cases are clear and damage to the tape may be visible, but it is a good idea to wind a section of the tape using a pencil in one of the reels and watch for signs of damage through the opening at the bottom. For types of damage to look for, see Table 4. Badly damaged sections (because of pest damage, for example) can be removed by cutting to clear edges and then splicing, but creases and folds should be left alone.

6. Determine if the tape is playable. If it is playable, proceed to the next section. If not, set the cassette aside for later treatment. Record in the Condition Report when any restorative steps are taken.

7. Break out write-protect tabs at the top of the cassette to prevent erasing.
Audio Cassette Condition Report

Assessment Date:_______________________________________________________________

Identifier:_____________________________________________________________________

Inspection Results:

☐ Mold present
☐ Pests present
☐ Odor present
☐ Oxide flaking
☐ Particulates (dust, debris)
☐ Foam pad damage
☐ Tape is bent, wrinkled, creased, folded (cinching, cupping)
☐ Loose tension
☐ Previous repairs
☐ Other, specify under Notes

Preservation work undertaken:

☐ Proceeded with digitization
☐ Did not digitize. Isolated in polyethylene bag for conservation or deaccessioning.
☐ Spliced damaged area (removed no more than 12 inches of tape)
☐ Adjusted foam pad
☐ Wound to fix tension
☐ Removed paper, cardboard, and applied label to case

Notes:

(Note how much tape was removed by splicing in this section.)

______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
<table>
<thead>
<tr>
<th>TYPE OF DAMAGE</th>
<th>SIGNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mold</td>
<td>- Fuzzy or hairlike growth</td>
</tr>
<tr>
<td></td>
<td>- Variety of colors</td>
</tr>
<tr>
<td></td>
<td>- Inside of cases and edges of tape are common areas</td>
</tr>
<tr>
<td>Pests</td>
<td>- Living pests or corpses</td>
</tr>
<tr>
<td></td>
<td>- Droppings</td>
</tr>
<tr>
<td></td>
<td>- Urine stains</td>
</tr>
<tr>
<td></td>
<td>- Tracks</td>
</tr>
<tr>
<td></td>
<td>- Gnaing damage</td>
</tr>
<tr>
<td>Chemical Breakdown</td>
<td>- Waxy, dirty socks, or pungent odor</td>
</tr>
<tr>
<td>Foreign Particles</td>
<td>- Dust or other small, foreign objects in the case</td>
</tr>
<tr>
<td>Oxide Flaking</td>
<td>- Particles of emulsion in the case</td>
</tr>
<tr>
<td></td>
<td>- Particles of emulsion coming off the base (tape)</td>
</tr>
<tr>
<td>Cinching</td>
<td>- Wrinkles and folds in tape</td>
</tr>
<tr>
<td></td>
<td>- “Accordion-like” folding in severe cases</td>
</tr>
<tr>
<td>Cupping</td>
<td>- U-shaped curving of tape</td>
</tr>
<tr>
<td>Creases</td>
<td>- Creases in the tape</td>
</tr>
<tr>
<td>Edge Damage</td>
<td>- Tape edges are distorted or damaged</td>
</tr>
<tr>
<td>Stretching</td>
<td>- Width- and/ or length-ways stretching of tape</td>
</tr>
<tr>
<td>Breakage</td>
<td>- Tape is cut or part of the tape is missing</td>
</tr>
<tr>
<td>Gapping/ “Windowing”</td>
<td>- Tension is loose and gaps appear in reels</td>
</tr>
</tbody>
</table>

Look carefully for signs of damage. Consider if cassette is too damaged to play or too dangerous to handle.
Section 18: Workflow for audio digitization

General workflow for audio digitization

Run a checksum initially, so that this can be used later to check on the integrity of the audio file. Digitize the audio cassette and name it, for example 2016-19-dmcdermott-a. This is the raw digitized WAV file which will not be edited. Make a copy of this file to work on, but add the suffix “-sm,” for example 2016-19-dmcdermott-a-sm. (Note: side 1 is given the suffix “-A” and side 2 is given the suffix “-B.” For example, 2016-19-dmcdermott-a-sm; 2016-19-dmcdermott-b-sm.) Edit this copy using Audacity and save it as a WAV file. Make an access copy from the working copy and save it as an MP3 file. See the section on recording for a detailed workflow.

File naming

<table>
<thead>
<tr>
<th>(For the original digitized file – the preservation master)</th>
<th>filename.wav</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preservation master side one</td>
<td>filename-a-.wav</td>
</tr>
<tr>
<td>Preservation master side two</td>
<td>filename-b-.wav</td>
</tr>
</tbody>
</table>

The preservation master, or original scan, has no editing done to it. Editing is done to the service master, which is saved with the suffix “sm.” Access copies have the suffix “ac.”

<table>
<thead>
<tr>
<th>(For the service master)</th>
<th>filename-sm.wav</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service master side one</td>
<td>filename-a-sm.wav</td>
</tr>
<tr>
<td>Service master side two</td>
<td>filename-b-sm.wav</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>(For access copies)</th>
<th>filename-ac.mp3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access copy side one</td>
<td>filename-a-ac.mp3</td>
</tr>
<tr>
<td>Access copy side two</td>
<td>filename-b-ac.mp3</td>
</tr>
</tbody>
</table>
Preparing playback equipment

1. **CHECK EQUIPMENT.** Make sure the playback head (located toward the front of the playback deck, next to the buttons) on the playback device is clean (metal knob which reads the signal). If there are dark spots present, gently wipe them away with isopropyl alcohol on a cotton swab. If the head remains dirty, the stains may have been caused by a damaged tape and cannot be wiped away using this method. Follow these steps:

   a) Wet cotton swab with alcohol and rub the top of the central play head. Clean between the two tape guides that stick up on one side of the head.
   b) Clean the capstan (rotating spindles that move tape) with the cassette door open.
   c) Clean the top of any other tape guide.
   d) Set to “Play” and clean the rubber pinch roller. Only touch the roller on the side furthest away from the heads, otherwise the deck will tear up the cotton swab. It may take several cleanings before brown deposits are removed.
   e) Use a blower to remove lint.
   f) Let tape deck sit to allow alcohol to evaporate. Close lid when finished.

---

11 Audacity, ‘Recording from Cassette,’
http://wiki.audacityteam.org/wiki/Recording_from_Cassette#How_to_Clean_Heads

Image from Indigitization, ‘Digitization Guidelines-Audio Cassette Project Parameters,’
Recording
Testing audio

1. **INSERT TAPE.** Turn the cassette reel to take up slack on the cassette before putting into playback machine, with Side A facing up. Close tape deck. Rewind to the beginning of the tape. Put on the headphones and press “Play” on the tape deck. For this step, you do not want to record anything.

2. **SET GAIN.** Turn “GAIN” knobs to the lowest setting to avoid damaging circuitry. Adjust the knobs on the UR22 audio interface so that “MIX” is in the middle between “input” and “DAW.” The “MIX” knob controls how much of the input signal you hear and how much you hear of what the computer (or “digital audio workstation”) is registering. With the “MIX” knob at halfway, half of what you hear comes from each component.

3. **SET VOLUME.** Turn the “PHONES” knob to the lowest level. The “PHONES” knob adjusts the volume of your headphones only and by starting at the lowest level, you can gradually increase volume to a comfortable level.

4. **ADJUST GAIN, LISTEN, NOTE ON LOG.** The playback device should still be powered on. A) Adjust the volume on the playback device and using the “PHONES” knob on the UR22 interface until the audio can be clearly heard.

   B) While the tape is playing, raise the “GAIN” knobs until the “Peak” indicator light starts flashing, and then gradually lower the knobs in unison again just until the light stops flashing. Make sure the levels for the volume input (gain) are set so the audio does not overmodulate and distort. Levels should never go above 0 and should be between -0.3 and -0.12. The audio can be normalized to -0.3 after the fact, which will bring the peaks to -0.3 and adjust everything accordingly. (Overmodulating is about loudness and pitch.) Sample a few sections of audio by fast forwarding and listening for about 30 seconds.
C) Note in the *Digitization Log* if you find any issues (mechanical noises like grinding or clicking, environmental noises like coughing or traffic, changes in frequency or volume, changes in content like two different interviews on the same recording). Do not make modifications to any equipment or software at this stage, just make observations. In the case that you cannot hear anything, sample a different section of the tape, and see if there is audio. If you cannot hear any audio on the tape, make sure the equipment is set up correctly. If the tape still does not work, there is a chance the tape has been erased or was never recorded on. Note this in the *Digitization Log*.

5. **REWIND.** When you're finished, rewind the cassette to the very beginning, including any silence before the recording begins.

**Using Audacity software**

1. **RECORD USING AUDACITY.** Go to the *Audacity* window. Select “File” >” New” to create a new file.

2. Press the “Record” button in *Audacity* and after 2-3 seconds, press “Play” on the tape deck. (This will give you some extra space in case the audio starts immediately.) A new track will appear. You will start to see a cursor move across the screen and create a blue waveform that represents the audio being captured by *Audacity*. If you do not see this waveform, *Audacity* is not receiving a signal or recording and therefore an audio file is not being created. Unless the audio is of very high quality, there should be some mechanical noise registered which will show up on the waveform, even during apparent silences.
3. If the tape starts squealing or the audio becomes very fuzzy, this may indicate sticky shed syndrome. Stop recording to avoid damaging the tape.

4. **LISTEN AND NOTE ON LOG.** Listen to the entire recording in real time as it is recording and describe any anomalies in the *Digitization Log*, for example tape binding on guides, abnormal sounds, change in content of tape from what is on label, large peaks, etc. Watch as the waveform is created. The run time for one side of a cassette typically lasts between 30 and 45 minutes.
5. **NOTE DURATION.** There are two possible ways that the recording might end: either the tape will run out and stop, or the audio ends before the tape runs out. If the tape runs out first, you can immediately stop recording in **Audacity** by pressing the Stop button. If the audio ends, let the tape continue to play through to the end. Make sure to record the duration of recorded audio on the **Digitization Log. Do not close Audacity or you will lose the recording.**

6. **MAKE PRESERVATION MASTER: DELETE SILENCE AND NOTE ON LOG.**

   **A)** Scroll to the beginning of the track. Remove silence at the beginning (*not* in the middle of the recording) by clicking and dragging on the waveform 3-5 seconds before the audio content starts. To do this, drag the cursor left to the beginning of the audio window, and press “Delete” on the keyboard. Repeat for silence at the end of the recording by selecting a point 3-5 seconds from the end of the audio, dragging right to the end of the recording, and deleting the section. Next, select the whole track by pressing CTRL/CMD plus A.

   **B)** At the bottom of the screen, make sure that the “selection start” counter shows all zeroes. In the second counter, “end” or “length” should both have the same value.
C) Make sure you record the duration of silence that was removed on the *Digitization Log*. Multiply the total minutes by 60 and add the total seconds to this for the original duration. Then multiply the total minutes by 60 and add the total seconds to this for the end/length counter total. Finally, subtract the total given in the end/length counter from the original duration total.

7. **SAVE PRESERVATION MASTER.**

   A) Choose “File” > “Export Audio” to create a 24-bit WAV file preservation master by choosing “Other Uncompressed Files” from the drop-down menu under “Save as Type” and then click “Options.”

   B) Select “WAV (Microsoft)” as the “Header” and “Signed 24-bit PCM” as the “Encoding” from the new window that opens. Click OK.

   C) Name the file “file name-a.wav”. The “A” represents side A of the cassette. Save to a new folder.
8. EMBED METADATA IN AUDACITY. A) You will be prompted to fill in metadata. Data entered here will show up in some BWF MetaEdit fields. The four required metadata fields are: Originator, Identifier, Description, and Coding. The only relevant field that appears in Audacity is Comments. Put the Identifier in the Comments field. Press “OK.” (See Table 5.)
B) Close **Audacity** but do not save an **Audacity** project file when prompted by choosing “No” when asked. Choose Exit to leave the program.
9. **CREATE CHECKSUM IN BWF METAEDIT.**

A) Open your preservation master in **BWF MetaEdit**. Choose “File” > “Open” and select the WAV file you just created.

B) Look at the various fields in the “Tech” metadata window (which is the default when you open **BWF MetaEdit**). The program will automatically create a checksum for these files. Scroll to the far right to find the headings “MD5Stored,” “MD5Generated,” and “Information.” These fields indicate information regarding the checksum. If the field under “MD5Stored” is green, then the checksum has proved that the file has not degraded or been changed. If this field is red, then the “MD5Generated” value (which is created every time a file is checked) does not match the “MD5Stored” value (which represents the original checksum) and the file has undergone some change. Note in the **Digitization Log** if this field is ever red.
10. **CHECK FOR ERRORS**. Under View, select Log of Errors Only to see if there were any errors when the WAV files were imported. If there were, note it in the *Digitization Log*. If the screen is blank, then no errors occurred.

11. **EMBED METADATA IN BWF METAEDIT**. Click on the Core button on the left pane of BWF MetaEdit to change views to Core metadata. Double click on *Originator*, *Originator Reference*, *Description*, and *Coding History* fields (use the “Free Text” option for *Coding History*) and enter metadata which you get from the *Digitization Log* you filled out earlier.

12. **SAVE PRESERVATION MASTER**. A) Save the file from the “File” menu by choosing “Save All Modified Files.” It will be converted to Broadcast Wave format. This is the new version of your preservation master with embedded metadata and a checksum. Choose “Close All Files” and then choose Quit.
B) Reopen **Audacity**. Choose “File” > “Open,” select the preservation master, and click “Open.” When prompted, choose “Read File Directly” rather than “Make Copy Of File.”
13. **MAKE SERVICE MASTER: OPEN IN AUDACITY AND AMPLIFY AUDIO.**
Normalize the audio (this will amplify the audio). Choose “Effect” > “Normalize.” Select “Remove any DC offset.” Select “normalize maximum amplitude to.” Enter “-0.3” into the data entry box. Select “Normalize stereo channels independently”. Click “OK.”

14. **REDUCE NOISE.** Now you want to reduce mechanical noise. A) Select a portion of the recording between content (like a pause in conversation, etc.) where you can hear hissing. Under “Effect” go to “Noise Reduction” and select “Get a noise profile”.

B) Then, select the whole track using CTRL/CMD plus A and go to “Effect” again. Select “Noise Reduction,” this time only clicking on “OK,” and the program will render this effect (might take a few minutes). This will reduce or eliminate mechanical noise in the recording. Listen to parts of the track and make sure this process has worked and not distorted the audio.
15. SAVE SERVICE MASTER. A) Choose “File” > “Export Audio” and name the file “[filename]-a-sm.wav” so that you have a service master (sm) of the edited version.

B) Select “Other uncompressed files”. Click on the “Options” button. Select “(WAV) Microsoft” and “24bit signed PCM.” Click “OK”. Save to the folder created previously.
16. **EMBED METADATA IN AUDACITY.** A) Enter metadata in the window that opens. The fields are *Artist Name* (IART) (dc Creator); *Track Title* (INAM (dc Title, dc Identifier); *Year* (ICRD) (dc Date); and *Comments* (ICMT) (dc Description).
B) Click “OK.” Close Audacity. A window will again appear asking if you want to save an Audacity project file. If you are going back to work on the file later, choose “Yes,” but if you are finished editing the file, choose “No.” Choose Exit to leave the program.

17. EMBED METADATA IN BWF METAEDIT. A) Open BWF MetaEdit. Click “File” > “Open File.” Find the service master file and click “Open.” In BWF MetaEdit, use the toolbar along the left side of the BWF MetaEdit window, and select “Core.” This is where you will enter metadata. BEXT information that should be included is Description, Originator, Originator Reference, Coding History and Origination Date. RIFF INFO fields that must be filled out include Name/Title (INAM), Comment (ICMT), Creator (IART), Creation Date (ICRD), and Copyright (ICOP).

B) Click “Save All Modified Files.” Now you have a service master with embedded metadata. Close BWF MetaEdit. Choose Quit to leave the program.
18. **CREATE ACCESS COPY IN AUDACITY.** Create an access copy using the service master. A) Reopen Audacity and load the service master by selecting “File” > “Open.” When prompted, choose “Read File Directly” rather than “Make Copy Of File.”

B) Then select “File” > “Export Audio,” choosing “Save As Type” MP3, and naming it “[file name]-a-ac.mp3”. Open “Options” and confirm settings as:

- **a.** Bit Rate Mode: Constant
- **b.** Quality: 256 Kbps
- **c.** Channel mode: Joint Stereo
C) Save. When metadata box appears, check metadata. Click OK. Change “Sample Rate” to 48000. Close Audacity but do not save an Audacity project file when prompted by choosing “No” when asked. Choose Exit to leave the program.
Adding metadata: required fields
You can embed metadata in Audacity fields and using BWF MetaEdit. See the metadata chart in Table 5 for crosswalks between Dublin Core, BEXT and RIFF LIST INFO fields. Shaded areas represent potential batched metadata. Choose the program you wish to edit metadata with and load the preservation master, service master, and access copy. Add metadata according to the following guidelines and the metadata crosswalk provided below.

1. In Audacity, under “Edit Metadata”, the fields are Artist Name (IART) (dc Creator); Track Title (INAM) (dc Title, dc Identifier); Year (ICRD) (dc Date); and Comments (ICMT) (dc Description).

![Audacity screenshot](image-url)
2. In **BWF MetaEdit**, use the toolbar along the left side of the **BWF MetaEdit** window, and select “Core.” This is where you will enter metadata. The information entered in **Audacity** should show up under their respective RIFF INFO tags (four-letter identifier). Rolling over the tag headings will give you a description of what to enter in the field and the recommended format. BEXT information that should be included is *Description, Originator, Originator Reference, Coding History and Origination Date*. RIFF INFO fields that must be filled out include *Name/Title* (INAM), *Comment* (ICMT), *Creator* (IART), *Creation Date* (ICRD), and *Copyright* (ICOP). Complete these fields. Save the files.

Repeat this whole process for side B of the cassette. The names for files created for side B will be the same except with a “b” in lieu of “a,” so for example the master will be “[file name] –b-sm.wav”.

---

150
Table 5 Metadata chart

*Highlighted fields are required.

<table>
<thead>
<tr>
<th>Dublin Core</th>
<th>Audacity</th>
<th>BWF BEXT chunk</th>
<th>BWF LIST INFO chunk</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td></td>
<td></td>
<td></td>
<td>Give brief description interview, transcript available</td>
</tr>
<tr>
<td>Identifier</td>
<td>Comments</td>
<td>OriginatorReference</td>
<td>ICMT Comment</td>
<td>Give identifier 2016-19</td>
</tr>
<tr>
<td>Date</td>
<td>Year</td>
<td>OriginationDate</td>
<td>ICRD Creation Date</td>
<td>Give date of original recording YYYY-MM-DD</td>
</tr>
<tr>
<td>CodingHistory</td>
<td></td>
<td></td>
<td></td>
<td>Give sampling frequency, bit rate, equipment Punc=comma space 96000, 24, UR22, Audacity ver. 2.1.1</td>
</tr>
<tr>
<td>Creator</td>
<td>Artist Name</td>
<td>IART</td>
<td>Give name of interviewee(s) Ferris, Margaret</td>
<td></td>
</tr>
<tr>
<td>Rights</td>
<td></td>
<td>ICOP Copyright</td>
<td>Give copyright and privacy restrictions Punc=semicolon space CSJ Canada; publication and other forms of distribution are restricted.</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Track Title</td>
<td>INAM Name/Title</td>
<td>Give identifier and file name 2016-19-dmcedermott</td>
<td></td>
</tr>
</tbody>
</table>
Splicing instructions
Look at the inside of the audio cassette to understand how it is built. This is a typical anatomy of
an audio cassette, but not all cassettes are built the same:

Figure 1: An audio cassette

Don’t open the audio cassette unless it is flat on the work surface. Don’t lift it in the air! Remove
the screws and the top of the cassette case.

Make sure the felt pad is up and in the center of the metal plate to which it is attached. This metal
plate has ends which wrap around the side of another metal plate which is behind it. There are
two rollers at each bottom side which are set into pins. The tape should wind around the outside
of the small pegs that are adjacent to them. Then the tape winds just behind the plastic tabs on
the bottom of the cassette, through the small slits behind each. There is an anti-friction pad,
which is a clear piece of plastic that rests on top of the tape. Remove the anti-friction pad.
Figure 2: Anatomy of audio cassette

Figure 3: Equipment
1. Wear cotton or nitrile gloves and look for the section of tape that needs to be removed or where there is a break in the tape. Hopefully you can splice without removing the front half of the cassette as the tape slips from the reel easily and is difficult to rewind, but if the ends of a broken tape are unreachable through the bottom of the cassette, remove the screws from the front (usually four or five) and carefully remove the front half of the case. Some cases are glued together so do not pull aggressively if it offers too much resistance.

![Figure 4: Broken tape](image)

2. Even up the edges of the tape. Place the tape in the slot on the splicing block so that the base (shinier) side of the tape is facing out. Put the damaged end to the right of the angled slit (where the razor will cut through). Hold firmly with one finger holding the tape on either side of the slit and cut by running the razor at an angle along the groove. Remove about 1 or 2 cm of tape, or 1 to 2 cm away from where damaged tape ends.
Figure 5: Placing tape

Figure 6: Trimming left side
3. Trim the other (right-hand) piece of tape. Base side up, this time put the tape on the splicing block so that the damaged side is to the left and the side that leads to the cassette is to the right. Cut 1 to 2 cm from the broken end on the same angle as before so that the pieces will match when the same side is facing up. Be careful not to twist the tape here or at any step. It is important that the tape remains flat when wound.

![Figure 7: Trimming right side](image)

4. Put both sides of the tape, base side up, into the groove in the splicing block. Match the ends together so that there is no room between them. Remove gloves and cut about 1 cm of splicing tape. Carefully tape the ends together and smooth with a finger to ensure good adhesion. Turn the newly joined tape over and put another 1 cm piece of splicing tape on the back of the joined area. Smooth with your finger.
Figure 8: Matching ends at the angle

Figure 9: First piece of splicing tape
Figure 10: Before smoothing

Figure 11: Reverse side taping
5. Rewind the tape using a finger or empty Bic pen case and gently winding towards the center of the cassette (counterclockwise for the left, clockwise for the right). The tape is now ready to use.

![Figure 12: Winding](image)

Convert a born digital WAV file to an MP3 file

1. Open Audacity and go to “File > Open”, navigate to the DIP folder and double click to open the access copy. Choose “Read Directly.” Once the file has fully loaded (see bottom left corner for this information that on demand waveform calculation is complete), choose “File > Export Audio” and navigate to the correct folder. Choose “Save As Type MP3,” renaming with the suffix -ac. Click on the “Options” button in the lower right corner of the export interface. Ensure the settings are:

   a. Bit Rate: Constant
   b. Quality: 256 Kbps
c. Channel Mode: Joint Stereo

Then click “Save.”

2. When the metadata box appears, just click “OK.”

3. Change “Sample Rate” to 48000. Exit the program but do not save the Audacity project file when prompted.
Section 19: Digital preservation

According to the Canadian Conservation Institute, the longevity of non-analogue media is short. Here are the expected life spans:

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Life Span</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disks (magnetic)</td>
<td>2-5 years</td>
</tr>
<tr>
<td>Floppy diskettes (magnetic)</td>
<td>5-15 years</td>
</tr>
<tr>
<td>Digital tapes (magnetic)</td>
<td>5-10 years</td>
</tr>
<tr>
<td>Analogue tapes (magnetic)</td>
<td>10-30 years</td>
</tr>
<tr>
<td>CD-RW, DVD-RW, DVD+RW</td>
<td>5-10 years</td>
</tr>
<tr>
<td>CD-R (cyanine and azo dyes)</td>
<td>5-10 years</td>
</tr>
<tr>
<td>Audio CD, DVD movie</td>
<td>10-50 years</td>
</tr>
<tr>
<td>CD-R (phthalocyanine dye, silver metal layer)</td>
<td>10-50 years</td>
</tr>
<tr>
<td>DVD-R, DVD+R</td>
<td>10-50 years</td>
</tr>
<tr>
<td>CD-R (phthalocyanine dye, gold metal layer)</td>
<td>&gt; 100 years</td>
</tr>
<tr>
<td>MO, WORM</td>
<td>10-25 years?</td>
</tr>
<tr>
<td>Web page</td>
<td>100 days(^12)</td>
</tr>
</tbody>
</table>

Digital preservation strategies include refreshing, migration, and emulation. Refreshing can be done in two ways: copying from one media to another such as floppy disk to CD or copying to the same media, such as an old backup drive to a new backup drive. Migration means changing the version, such as updating Microsoft Word 2010 to Word 2013 OR it can mean changing the format, a process known as normalization, such as converting a WordPerfect file to a Microsoft Word file. In our archive, we normalize text documents to PDF/A format. Emulation is rebuilding software and hardware so you can run old programs on new computers, like running Pac Man on a Windows 10 system.

---

It is critical to backup files. Backup digital copies should be checked periodically to make sure they can still be accessed. Follow the 3-2-1- rule: make three copies, store on two different media, and store one copy offsite.

**Formats**
Open or standard formats are not proprietary and can be read by most software. Data should be unencrypted and uncompressed. When migrating or normalizing files, check for errors. Always retain the original file along with the normalized file. The various preservation formats are discussed on the next page. In our archive, we use these formats for master and access copies:

<table>
<thead>
<tr>
<th>Preservation</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF (image)</td>
<td>JPEG</td>
</tr>
<tr>
<td>PDF/A-1b (text)</td>
<td>Word docx, PDF</td>
</tr>
<tr>
<td>MSG (Unicode),</td>
<td>MSG (Unicode)</td>
</tr>
<tr>
<td>Options when you</td>
<td>WAV (audio)</td>
</tr>
<tr>
<td>must save</td>
<td>MPEG2 Audio layer 3 (MP3)</td>
</tr>
<tr>
<td>attachments</td>
<td>MPEG4 (MP4)</td>
</tr>
<tr>
<td>separately: MSG (txt), PDF</td>
<td></td>
</tr>
<tr>
<td>WAV (audio)</td>
<td></td>
</tr>
<tr>
<td>MPEG-2 or AVI (video)</td>
<td></td>
</tr>
<tr>
<td>WARC (website)</td>
<td></td>
</tr>
</tbody>
</table>

**Open Archival Information System model**
Our workflow follows the Open Archival Information System model. A submission information package or SIP is sent to the archive by a depositor. This is ingested into the digital preservation system. After processing, an archival information package or AIP is created, which contains the original content, metadata, and additional metadata generated at ingest. Then a dissemination information package or DIP is produced which is a copy of the content and metadata. The AIP is the preservation or master copy which is kept in long-term storage, and the DIP is the access copy.

---


copy which may be shared with archive patrons. The AIP in long-term storage has its integrity checked periodically by running checksum algorithms. It is important to ensure the authenticity of digital records by documenting the chain of custody and preservation actions which are taken.

Section 20: Workflow for digital preservation

Digital preservation system overview
We have three complete copies of all content, with one copy on two different servers, and one copy on a removable external drive. The two servers are in different geographic locations. We perform monthly integrity checks on stored records using QuickHash GUI. We virus check all content and maintain integrity manifests. Only the archivist and I/T staff can read, write, move, and delete files. We store technical, descriptive and preservation metadata, including concerning file formats, with content and keep an inventory of content and storage locations.

Accession numbers
Every accession number assigned must be recorded. Accruals that are received on a regular basis, such as monthly newsletters, will share the same accession number.

For born digital materials created by the archive, such as digital audio or video recordings, the accession number will be assigned as an identifier as part of the process of creating the digital files.

For digitized analogue materials, such as digitized audio tapes, the accession number is assigned during the digitization workflow, but for born-digital materials transferred to the archive, the accession number is assigned during the digital preservation workflow.
Archives submission system
To submit content to the archive, the depositor moves labelled folders containing files onto the Archive Transfer icon on the desktop.

Then, the depositor clicks on the Submit Files icon on the desktop:

After filling out the fields, the depositor clicks on the “Submit” button. The depositor will see a screen that looks like this:
The depositor will receive a file manifest, which is an CSV spreadsheet, by email. It contains a list of files, extensions directory paths, dates, and checksums. Here is an example showing some relevant parts of the file manifest:

<table>
<thead>
<tr>
<th>Name</th>
<th>Extension</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSI_WFR1-2012.JPG</td>
<td>JPG</td>
<td>2760905</td>
</tr>
<tr>
<td>CSI_WFR2-2012.JPG</td>
<td>JPG</td>
<td>2688100</td>
</tr>
<tr>
<td>CSI_WFR3-2012.JPG</td>
<td>JPG</td>
<td>2521152</td>
</tr>
<tr>
<td>CSI_WFR4-2012.JPG</td>
<td>JPG</td>
<td>2491907</td>
</tr>
<tr>
<td>CSI_WFR5-2012.JPG</td>
<td>JPG</td>
<td>3075054</td>
</tr>
<tr>
<td>CSI_WFR6-2012.JPG</td>
<td>JPG</td>
<td>2813896</td>
</tr>
<tr>
<td>CSI_WFR7-2012.JPG</td>
<td>JPG</td>
<td>2893782</td>
</tr>
<tr>
<td>CSI_WFR8-2012.JPG</td>
<td>JPG</td>
<td>2329624</td>
</tr>
<tr>
<td>CSI_WFR9-2012.JPG</td>
<td>JPG</td>
<td>2911512</td>
</tr>
<tr>
<td>wrf-2022.pptx</td>
<td>pptx</td>
<td>48919</td>
</tr>
<tr>
<td>wrf2022_A.docx</td>
<td>.docx</td>
<td>182158</td>
</tr>
</tbody>
</table>
In our archive, new acquisitions are stored temporarily in a submission location on a secure in-house server. These are downloaded and processed on a local drive, and then sent to long-term storage in a preservation space on a network attached storage (NAS) server and backed up on another NAS server.

The submission package looks like this:

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files</td>
<td>12/4/2022 1:29 PM</td>
<td>File folder</td>
<td>1,191 KB</td>
</tr>
<tr>
<td>metadata</td>
<td>12/4/2022 1:29 PM</td>
<td>File folder</td>
<td>255 KB</td>
</tr>
<tr>
<td>checksum verify v1.1</td>
<td>9/22/2022 4:48 PM</td>
<td>Application</td>
<td>1,191 KB</td>
</tr>
<tr>
<td>dhash</td>
<td>10/28/2021 10:16 AM</td>
<td>Application</td>
<td>2,255 KB</td>
</tr>
</tbody>
</table>

Checksums are run on the content when a submission package is created, and these checksums are run again after downloading from the server by clicking on the utility to verify them (Checksum by Corz). This verifies that at the bit level, there have been no changes to the files. The CSV report titled File Manifest can be used to verify the number of files and sizes of the content being deposited to the archive. The CSV report titled Submission Information can be used to get contextual information such as the name of the creator, the chain of custody, and
whether there are any issues concerning copyright, personally protected information, or access restrictions.

The depositor receives a message once the submission package has been sent to the archive. A second message is sent later once the content has been processed, reminding the depositor to purge all files from their drive. At this point, the submission package is purged from the server as well.

Remember that just opening or reading a file can change it. We use a write blocker when migrating content from a USB stick or floppy drive to prevent changes to the original content. This type of legacy media should be removed and then sent to the server using the archives submission system.

**Workflow for digital preservation**
The detailed steps for our workflow are described below:

1. Receive the submission package (which is a tar file) from the depositor which contains checksums, CSV reports, and a folder with content. The directory structure of the submission package looks like this:

   a. Parent folder titled with depositor name and date
   b. Subfolder titled “Files”
      i. Contains files and folders in the original order from the depositor
   c. Subfolder titled “Metadata”
      i. Contains the file manifest which contains file names, directory paths, file sizes, and file formats and extensions and the submission information spreadsheet
      ii. Contains checksum data
This is what the subfolder looks like inside:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Last Modified</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Document</td>
<td>9/22/2022 4:56 PM</td>
<td>1 KB</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>9/22/2022 4:56 PM</td>
<td>1 KB</td>
</tr>
<tr>
<td>Submission Information</td>
<td>9/22/2022 4:56 PM</td>
<td>1 KB</td>
</tr>
</tbody>
</table>

   d. Checksum utility designed to verify checksums

2. The submission package is checked for viruses on the server so there is no need to quarantine it. IF material has come to the archives on a USB stick, floppy disk, or CD, then it will need to be taken off this media using write block protection and submitted using the archives submission system which will move the material to the server to be virus scanned.

3. Assign the accession number for the parent folder with the name of depositor and date (which are supplied in the name of the tar file) and record this information in the accession record.

4. Extract the tar file by right clicking on it and extract it to the name of the folder.

5. Run the checksum utility in the submission package.

6. Preview the tar file in the original submission package and look at both CSV reports in the submission package (File Manifest and Submission Information) to get more data to add to the accession record.

7. Unzip any zipped files in the parent folder sent by the depositor because file formats can’t be identified in a zip file. Don’t save zip files.
8. If there are several parent folders which belong to the same record group, for example several parent folders containing a newsletter series, rename each folder with the month and date. Create a new folder named with the accession number, series title, and year. For example:

```
jan-april2022
may-sept2022
sept-nov2022
```

Record the new file titles and folder titles in the accession record with a note that this arrangement was done. If there is just one parent folder which belongs to a record group, rename that folder with the accession number and file title, for example:

```
M022-12-newsletters-bridging-2022
```

Again, record this new file title in the accession record with a note that this renaming took place. This accession record information will be important later when you describe the digital material.

9. Use Data Accessioner to move the parent folder into the SIP folder. This will include the subfolder with the content and the subfolder with the checksums and CSV reports. Data Accessioner will allow you to rename the parent folder with the accession number and a supplied title. Running Data Accessioner will create an XML report which needs to be moved into the Metadata subfolder using Teracopy.
10. Run the checksum utility again after moving the parent folder to the SIP folder.

11. Run **DROID** on the parent folder and create metadata reports and move these into the Metadata subfolder.

12. Make an access copy by using **Teracopy** to copy the parent folder to the DIP folder.

13. Run **Metadata Transformer** on the XML report in the Metadata subfolder of the access copy.

14. Normalize file formats of the access copy in the DIP folder if needed (e.g., WordPerfect to PDF/A). The original files in the parent folder which is still in the SIP folder will not be normalized.

15. View the access copy and see if there is any personally identifiable information (PII), and if so, note restrictions in the accession record.

16. Use **Bagger** to create a new bag and move the parent folder from the SIP folder to the Long-Term Storage folder on Drive A.

17. Delete any submission folders (tar files) that have been processed from the SIP folder and send a message to the depositor to purge the files from their drive if they have not done so already. At this point the cached files are purged.

18. Run **Checksum by Corz** for integrity checks once per month.

19. If content has changed, it needs to be replaced from a backup which we get from a snapshot on the timeline on the server.
How to use Data Accessioner

This section will explain in more detail how to use Data Accessioner which is software that adds Dublin Core and PREMIS metadata and creates an AIP. Open Data Accessioner.

1. Fill in the top three fields. Supply an accession number and collection title. Click on “Accession to Directory” and choose the location where the file(s)/folder(s) will be stored. This should be the SIP folder on Drive C. Double click to open this folder, and then click only once on the folder. Then click “Set as Accession Directory.”

2. Click “Source Directory” and locate the folder you extracted from the submission package which is still on the server. Click only once on this folder and click on “Set Disk/Directory to Migrate.”

3. Select the folder or file to which you want to add metadata. Select the metadata field, add the metadata, and then click “Add New” after entry. This will add metadata to whatever level is selected, either the whole folder or a folder within a folder or a file within a folder.

4. You can remove a metadata tab by clicking “Remove Selected” button. If you make a mistake, select what you want to fix and click “Remove” button. You can’t edit in Data Accessioner.

The Dublin Core metadata which should be added are Description, Subject, Title, Rights, Creator, Date.

5. When you have finished adding metadata, click on the “Migrate” button. When you see the Success! message in the bottom left corner, you will have migrated the parent folder to the SIP folder along with an XML file that contains file format information, an Md5 checksum, and PREMIS and Dublin Core metadata. Move the XML file into the Metadata subfolder using Teracopy.
How to use DROID
This section will explain in more detail how to use DROID to get file format information and directory locations. DROID uses PRONOM, a registry of file formats maintained by the UK National Archives, to validate file formats using the file signature which is a sequence of bytes.

Make sure DROID preferences are set up as follows:
Make profile
1. **DROID** will automatically create a profile named “Untitled-1” when it is first started. You can create multiple profiles and rename them.

2. Click “New” to create a **DROID** profile.

3. Click the File menu tab and then “Save As” to save the profile.

4. Navigate to where the profile will be located which can be the Desktop, name the profile “digipres”, and click “Save.”

5. Click “Add” to add the parent folder to the profile. (The box “Include subfolders” is checked by default but you can uncheck it if you want to just profile files within a folder and ignore any subfolders. You can also remove a file or folder if you accidentally add it.)

6. Under Folders navigate to the SIP folder and select the parent folder.

7. Then click “OK” and under the File menu tab click “Save.”

Run **DROID**
1. You will save the exported data as a CSV file that can be opened using Excel.

2. Click “Start.”

3. Click “Export” and then click on the check box to the “digipres” profile to export. (When exporting one row per file, each row in the CSV file represents a single file or folder profiled with **DROID**.)

4. Click “Export profiles.”
5. Navigate to and select the folder to store the export – store it in the Metadata subfolder.

6. Name the export file with the name of the parent folder (accession number and title).

7. Click on the “Files of type” drop down menu and choose “Comma separated values.”

8. Then click “Save.”

9. When you get the “Export Complete” message, click “OK.”

Create reports

1. Reports provide statistics on count of items; total size of items; minimum size of items; maximum size of items; and average size of items. Click on the “Report” menu tab and choose “Generate Report.”

2. Select the “digipres” profile by checking the box.

3. Click on “Select report” drop down menu and choose “File count and sizes.”

4. Click “Report on profiles.”

5. Click “Export” to save the report.

6. Navigate to a folder to save the report in – store it in Metadata subfolder.

7. Name the report file with the name of the parent folder (accession number and title).

8. Click on the “Files of type” drop-down menu and choose “Adobe Portable Document Format.”
9. Click “Save.”

10. Click “Close.” Don’t save the profile.

How to make an access copy
This section explains in more detail how to make an access copy or DIP.

1. The parent folder is in the SIP folder and it contains the original Files subfolder and the original Metadata subfolder which now also contains the XML report generated by Data Accessioner and the CSV and PDF reports generated by DROID.

2. Make an access copy by copying the parent folder to the DIP folder on Drive A using Teracopy.

3. Create readable files from the XML file generated by Data Accessioner using Metadata Transformer and store these files in the access copy metadata subfolder.

Run Metadata Transformer
This section will explain how to create an easily readable metadata report from the XML file created by Data Accessioner.

1. Open Metadata Transformer (XSLT Processor) software. This software will generate CSV and HTML reports.

2. Click on “Add Source” and navigate to the access copy in the DIP folder. Select the XML file you created located in the Metadata subfolder using Data Accessioner by clicking it once and clicking on the “Open” button.

3. Click on “Set Output Directory” button to send the generated CSV and HTML files to the access copy folder.
4. Click on the “Run Transforms” button. This will create metadata reports in both HTML and CSV formats.

5. Close **Metadata Transformer**.

6. You will now have three **Data Accessioner** reports (HTML file, CSV file, XML file) in the Metadata subfolder along with the **DROID** reports (CSV file, PDF file).

**Normalization**
If you need to normalize files, convert the files in the parent folder in the DIP folder to a preservation format. For example, convert Word Perfect format to Microsoft Word. Another example of normalization is converting PDF to PDF/A. You can verify the PDF using **Vera PDF** software.

**How to use Bagger**
Run **Bagger** to send the parent folder in the SIP folder to the Long-Term Storage folder. **Bagger** is software that creates a package or “bag” which contains:

1. Data folder which has the content or “payload.”
2. Several text files:
   - metadata about the package called bag-info.txt (a shipping label)
   - bagit.txt which is metadata about the bag
   - manifest-md5.txt which is metadata about the content (a packing list)
   - tagmanifest-md5.txt which is a file created by **Bagger**.

**Run Bagger**
1. Double click on **Bagger**.

2. You will see a command line prompt window and then the **Bagger** start screen.
3. You will bag a copy which creates a copy of the originals, leaving the originals untouched, rather than using the “Create Bag in Place” option.

4. Click on the “Create New Bag” button.

5. Choose the option “Digital Records Accession Generic from the drop-down list and click OK.

6. Some information has been automatically filled out, e.g., the Bag Version is 0.9

7. Required fields have a red “R” next to them and the rest of the fields are optional. A drop-down menu with “???” means you can choose from the list.

8. Fill out these fields: Accession Number, Transferring Institution, Records Retention Type, Records Title/Description, Records Hashed Before Transfer, Hash Signature Type (sha256).

9. Click on the “File” button on the menu bar and choose “Add Data” to add the accession folder you want to bag.

10. Browse to the SIP folder on Drive C and search for the parent folder you want to bag. Double click on the SIP folder, then click once on the parent folder. Then click “Open.”

11. The files to be bagged are added to the “Payload” pane.

12. Click on the “Save Bag As” icon which will bring up the “Save Bag Dialog” screen.

13. Next, click once on the Long-Term Storage folder on Drive A.
14. Name the bag with the accession number and collection title. Click “Save.” Then select sha256 as the Tag Manifest Algorithm and sha256 as the Payload Manifest Algorithm and click “OK.”

15. You will get a popup window that tells you the bag was saved successfully. Click OK.

16. Click on the “Is Bag Complete” option at the top and you will get a pop-up window confirming this.

17. Click on the “Validate Bag” option on the top to make sure the bag is both complete and the checksums are verified. You will get a pop-up window telling you if it is validated.

18. Click on the “Close Bag” option and choose “Yes” to save the bag.

19. When the “Save Bag Dialog” screen pops up again, just click “OK.”

20. The bag is now stored in the Long-Term Storage folder.

We end up with a folder (bag) which contains a subfolder (data) and text files. Within the subfolder (data) is the AIP folder created by Data Accessioner. This contains the parent folder which has the subfolder (files) and subfolder (metadata). We can now delete the parent folder from the SIP folder and purge the submission package from the server.

Describe digital records
Use the access copy for archival description.

First, think about arrangement. Digital accessions are added as a separate digital series or digital subseries to a record group. For example, in our earlier example, the folder containing “Bridging” newsletters for 2022 would be added as a digital subseries to the Associates Program newsletter series, and the donations report for 2022 would be added as a digital subseries to the Donations Committee series. The starred fields shown below are required.
**Dates of creation** (RAD 9.4B): Use the “last modified” date of the files rather than the “created” date.

EXAMPLE: 2020-2022
Digitized 2019

**Physical description** (RAD 9.5): Give the size in GB and the total number of files. For unprocessed material, give the count of the formats.

EXAMPLE: 0.024 GB (15 digital files)
5 unprocessed compact discs
1 sound recording (wav)
1 GB of photographs (TIFF)

**Scope and content** (RAD 9.7D): Note the types of records and note how dates were determined. You can include information about hardware and software here.

EXAMPLE: This sub-series contains born-digital newsletters which are stored on the server. The last modified date of the first and last file in the folder was used to determine the date range.

**Note area: Physical condition** (RAD 9.8B10a): Note how access to the digital material is available.

EXAMPLE: Digital materials must be accessed onsite at the archives. Arrangements must be made in advance of any visit.

**Notes area: Conservation** (RAD 9.8B10b): Note details of digitization, normalization, removal of files, modification of file names, changes to the original file structure, deduplication, since transfer to the archives. Note how material was transferred to the archives and that virus scans were run on the server.

EXAMPLE: This material was received via the archives submission system.
Checksums were run, and preservation copies and access copies were
made as part of the digital processing workflow. WordPerfect files were normalized to PDF/A files for access.

**Notes area: Arrangement** (RAD 9.8B14): Note if the digital files have been put into their own series or arranged into folders and include filename changes and creation of new folders.

**EXAMPLE:** Digital materials were arranged into the appropriate series based on content. The original order of the files has been kept.

*Restrictions on access* (RAD 9.8B17): Give access restrictions.

**EXAMPLE:** Due to sensitive information, these records are restricted for 30 years after death (until 2030).

**Run integrity checks**

1. Monthly integrity checks using **Checksum by Corz** are automatically run.

2. If **Checksum by Corz** reports a changed file, identify the file using the report and replace it with a backup copy. Do this by opening the “version” folder on a backup drive. Look at the timestamp and date. Copy the backup file to the folder with the changed file, delete the changed file, and rename the backup file to match the original name of the file which has been replaced.

3. Use the accession record to record any file migration down the road.

4. If any files in bags are migrated, you must re-bag these files using **Bagger**.

**Creating disk images**

Although this will not be discussed further, another approach is to create a disk image using forensic software tools such as **FTK Imager** and **Bit Curator**. You get the media, such as a computer drive, assign an accession number to it, describe, and photograph the media for the accession record and use a write blocker to connect the media to your computer. The write
Section 21: Archiving websites and social media

Using the Internet Archive Wayback Machine
Web archiving captures the underlying source code and the functionality of a website or social media platform at a specific point in time. An example of an enormous web archive is the Wayback Machine which is the largest publicly available web archive. You can try it out!

• Enter a URL in the Wayback Machine search window.
• It will show you how many times, and when, the webpage was crawled by Internet Archive.
• Click on a date in the calendar, and you can see the saved webpage.
• On the home page, at the bottom is the “Save Page Now” feature. Enter a URL and then click “Save Page.”
• Once it is saved, it will give you a URL you can click to see the archived webpage.

Another tool supported by the Internet Archive is Archive-It. You can use this to build collections. You can control the scope and frequency that a website is captured. You can add metadata to the content, and both the content and metadata are searchable.

How it works is you give a seed (a URL) to a crawler (a robot) to a website and it gathers HTML, images, etc. and makes a WARC (web archive) file. To view this file, you need to use replay. In Archive-It the replay machine is called Wayback.

The crawler follows links from the seed, which can be a complete website or part of it, and then follows the links from these links and so on. You need to set boundaries on how many links the crawler will follow. All embedded content will be captured.
Using Conifer
Another tool to use to capture websites is Conifer. You can try it out!

1. Go to https://conifer.rhizome.org/.
2. Open existing account.
3. Scoping is what we call it when we tell a web crawler what to capture and what not to capture.
4. With Conifer, you are the crawler. Conifer will only record what you are looking at so you should know in advance if there is embedded content or links you should follow.
5. Enter a URL, choose what collection to add it to, choose your browser, and click the “Start Capture” button.
6. Scroll over the web page and mouse over any animations you want to capture. Press play on any videos, audio, or navigate through photo galleries. Remember what you click gets recorded.
7. To end the capture, hover over the “Capture” button until it becomes “Stop” and then press it.
8. You can now click on the URL for the webpage you captured under “Page Title” and view it in your browser.
9. If you click on the drop-down menu on the “Browsing” button and select to either recapture or patch the webpage. You would choose to patch it if there was content missing. To end the patching session, hover over the “Patching” button until it says “Stop” and then click it.
10. To add another webpage, click “Collections Manager” and then “New Session” button. Paste in a URL and hit Enter.
**Metadata fields for websites**

<table>
<thead>
<tr>
<th><strong>Dublin Core</strong></th>
<th><strong>RAD</strong></th>
<th><strong>Notes</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Creator</td>
<td>Access point: Provenance</td>
<td>Give creator of live website.</td>
</tr>
<tr>
<td>Date</td>
<td>Dates of creation, including publication, distribution, etc. area: Dates of creation</td>
<td>Give date of first crawl and frequency of captures after this.</td>
</tr>
<tr>
<td>Description</td>
<td>Archival description area: Administrative history/Biographical sketch Archival description area: Scope and content Notes: Immediate source of acquisition Notes: Accruals</td>
<td>Give reason for archiving website. Indicate that the content is an archived website. Note whether any content on the live site is missing from the archived site. Give administrative history or biographical sketch of creator. Give scope and content note. Indicate whether accruals are expected.</td>
</tr>
<tr>
<td>Subject</td>
<td>Access point: Author Access point: Other non-subject</td>
<td>Don’t give genre in this field. Use LCSH.</td>
</tr>
<tr>
<td>Title</td>
<td>Title and statement of responsibility area: Title proper</td>
<td>Use title given in head of home page and add “archived website(s); blog, Twitter feed; Facebook page” as applicable. If a collection of websites, create name for collection and add organization’s name.</td>
</tr>
<tr>
<td>Rights</td>
<td>Notes: Restrictions on access Notes: Terms governing use and reproduction Notes: Terms governing publication</td>
<td>Use: “The copyright status of this material is not known. Users are responsible for determining whether the material may be re-used for publication.”</td>
</tr>
</tbody>
</table>
Section 22: Records management for archives

Records in the archives are managed according to a functional file classification plan and a retention and disposal schedule.

Here is a summary of the important points:

- Official employee and volunteer files are kept for 15 years after the person leaves the position.
- Supervisor’s files for employees and volunteers are kept for 2 years after the person leaves the position.
- Recruitment files for employees are kept for 2 years after the recruitment period ends.
- Recruitment files for students are kept for 1 year.
- Reference files are kept for current year + 10 years.
- Donation files are kept permanently.

The applicable section from the organization wide integrated classification and retention schedule is given below.

<table>
<thead>
<tr>
<th>I02</th>
<th>ARCHIVES SERVICES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contains:</strong> Records documenting the preservation of records of archival value and the provision of archival services to the Congregation and as permitted, external researchers. Includes acquisition documents, collection management and preservation files, and finding aids. Also includes reference requests, retrieval activity and outreach. Also, while not archival documents per se, also includes records on art and artefacts that are deemed to be of historical value to the Congregation.</td>
<td></td>
</tr>
</tbody>
</table>
| **Excludes:** Legal agreements – see L05  
Emergency planning – see A07  
Records management – see I09  
Privacy protection – see I08  
Library services - see I07 |
<table>
<thead>
<tr>
<th>Title</th>
<th>Retention</th>
<th>Retention</th>
<th>Retention</th>
<th>Disposition</th>
</tr>
</thead>
<tbody>
<tr>
<td>I02-01 General</td>
<td>CY + 2 years</td>
<td>--</td>
<td>CY + 2 years</td>
<td>Destroy Confidentially</td>
</tr>
<tr>
<td>I02-02 Accession/Acquisition Records</td>
<td>SO</td>
<td>--</td>
<td>SO</td>
<td>Preserve in Archives</td>
</tr>
<tr>
<td>I02-03 Collections Management Files</td>
<td>SO</td>
<td>--</td>
<td>SO</td>
<td>Preserve in Archives</td>
</tr>
<tr>
<td>I02-04 Descriptive Finding Aids</td>
<td>SO</td>
<td>--</td>
<td>SO</td>
<td>Preserve in Archives</td>
</tr>
<tr>
<td>I02-05 Reference and Retrieval Records</td>
<td>CY + 2 years</td>
<td>8 years</td>
<td>CY + 10 years</td>
<td>Destroy Confidentially</td>
</tr>
<tr>
<td>I02-06 Outreach and Displays</td>
<td>CY + 2 years</td>
<td>4 years</td>
<td>CY + 6 years</td>
<td>Destroy Confidentially</td>
</tr>
<tr>
<td>I02-07 Art/Artefact Files</td>
<td>SO</td>
<td>--</td>
<td>SO</td>
<td>Preserve in Archives</td>
</tr>
</tbody>
</table>

**Retention Note:** As this primary deals with records already held by the Congregational Archives, the final disposition is expressed as “Preserve in Archives” rather than “Transfer to Archives”.

**Retention Note:** The above retention periods are intended for the Office of Record only. The default total retention period for all others is SO followed by Confidential Destruction, with the proviso that under no circumstances can SO be interpreted to be longer than the active retention period specified for the Office of Record.
### APPENDIX I

#### Common series

**Common Personal Series**

<table>
<thead>
<tr>
<th>Audiovisual materials</th>
<th>Correspondence</th>
<th>Diaries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ephemera, Artifacts</td>
<td>Finance</td>
<td>Genealogy</td>
</tr>
<tr>
<td>Legal</td>
<td>Organizational Files</td>
<td>Photographs</td>
</tr>
<tr>
<td>Print Materials</td>
<td>School Records</td>
<td>Scrapbooks</td>
</tr>
<tr>
<td>Subject Files</td>
<td>Writings</td>
<td></td>
</tr>
</tbody>
</table>

**Common Business Series**

<table>
<thead>
<tr>
<th>Administrative Records</th>
<th>Advertising</th>
<th>Audiovisual Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>Committee Files</td>
<td>Constitutions, charters, bylaws</td>
<td>Conventions and Conference Proceedings</td>
</tr>
<tr>
<td>Correspondence</td>
<td>Executive Board</td>
<td>Finance</td>
</tr>
<tr>
<td>Legal</td>
<td>Meeting Files (background information for meetings)</td>
<td>Minutes</td>
</tr>
<tr>
<td>Personnel</td>
<td>Photographs</td>
<td>Public Relations</td>
</tr>
<tr>
<td>Research</td>
<td>Subject Files</td>
<td></td>
</tr>
</tbody>
</table>

---

14 This discussion benefitted from the Society of American Archivists Arrangement and Description workshop, Pam Hackbart-Dean and Anne Ostendarp, 2021.
APPENDIX II

Types of metadata

1. **Descriptive** – characterizes the nature of a resource and supports its discovery, e.g., title, creator, subject
2. **Structural** – gives information about the relationship between the parts of a resource, e.g., sequence, relation
3. **Technical** – gives technical information about a digital resource, e.g., checksum, file format
4. **Administrative** – gives the information needed to manage a resource, e.g., rights, preservation
5. **Rights** – gives limits on the use of a resource and access restrictions, e.g., copyright holder, license terms
6. **Preservation** – indicates the actions taken to preserve a resource, e.g., preservation events, preservation level

Metadata standards

1. **Data content standards** are cataloguing rules for what to put in metadata fields, e.g., RDA, RAD, DACS, ISAD-G
2. **Data value standards** are controlled vocabularies, e.g., LCSH, LCNAF, MeSH, AAT, MIME types
3. **Data structure standards** define the elements and fields for metadata, e.g., DC, EAD, PREMIS, MARC, HTML, ISO 639.2, MARC Relators
4. **Data format or exchange standards** provide the syntax for metadata, e.g., XML, EAD, METS

We use access points because full text search is not precise. The recall is too great. For example, Amazon is a company but also a place. Using controlled vocabulary leads to consistency and discoverability and more precision in searches.

Using AtoM, the Encoded Archival Description (EAD) tag `<control access>` is where you put controlled vocabulary. Some EAD tags are:
<origination> is the origination of the materials, i.e., the records creator, for example: Janisse, Marie-Celine

<subject> is a subject heading, for example: Religion and religious people

<langmaterial> is the language of the materials, for example: English

<pers name> is a personal name, for example: Marie-Celine Janisse

<corp name> is a corporate name, for example: Fontbonne Hall

<geog name> is a geographic name, for example: South America--Peru

<title> is the name of a work, for example: The Bible

<genre form> is the genre or physical characteristics of the materials, for example, Art

<function> are the activities or processes that produced the records, for example, Teaching

Some places you can search for subject headings you can copy are:

WorldCat https://search.worldcat.org/

VIAF https://viaf.org/

Getty Art and Architecture Thesaurus: https://www.getty.edu/research/tools/vocabularies/aat/

Library of Congress Name Authorities: https://id.loc.gov/authorities/names.html

Library of Congress Subject Headings: https://id.loc.gov/authorities/subjects.html
Library of Congress Authorities

Library of Congress Authorities is where to look for subject headings and authorized forms of names. Here is some guidance on building subject headings.15


- Choose the heading that most closely represents the subject of the materials.
- Don’t add broader headings.
- Use no more than six headings.
- Punctuation and capitalization:
  
  Copy exactly
  
  Use capital letters at beginnings of headings
  
  Start each part of a structured heading with a capital letter
  
  Start the word after a comma in an inverted heading with a capital letter
  
  Separate parts of a structured heading by two dashes

In our archives, we rely on Library of Congress Subject Headings or LCSH. We use subject headings without subdivisions in AtoM. We also rely on Library of Congress Name Authorities or LCNAF. If the name is not found in LCNAF, we build the name following the pattern: surname, name, birth date – death date. In this case, for the authorized form of name, we prefer the first name that the Sister was known by at her death and put other names in the other names field. (Just a note that the Archives Association of Ontario instance of AtoM, Archeion, prefers not to have dates in the Authorized form of name field unlike the example below):

**Authorized form of name:** Hartleib, Mary Anthony, 1924-2008

**Other forms of name:** Sister Mary Anthony Hartleib

Mary Anne Lenore Hartleib

---
Types of subject headings:

For more information on subject access points, visit MARC 21:
https://www.loc.gov/marc/bibliographic/bd6xx.html

**genre** - MARC 155/655 (e.g., Scrapbooks)

**geographic** - MARC 151/651 (e.g., Canada)

**topical** - MARC 150/650 (e.g., Religion)

**uniform title** - MARC 130/630 (e.g., Bible)

Types of subdivisions

For more information on subdivisions visit MARC 21:
https://www.loc.gov/marc/bibliographic/bd650.html

These subdivisions follow the subject heading and are preceded by a dash:

**topical** - subfield |x (e.g., History)

**geographic** - subfield |z (e.g., Ontario)

**temporal** - subfield |y (e.g., 20th century)

**genre** - subfield |v (e.g., Handbooks, manuals, etc.)
• Structured headings can be *topical, geographical, or free-floating* subdivisions.

  o *Topical* – included in main list of headings, valid subdivisions in bold, can have more than one hierarchical level:

    **Mars (Planet)**
    
    -- Exploration
    
    ----Equipment and supplies

    **Mars (Planet)—Exploration—Equipment and supplies.**

• A pattern heading is one that can be copied for other headings of the same type, e.g., Cattle is a pattern for all headings for animals:

    **Cattle**
    
    --Anatomy
    
    ----Atlases

    **Cattle—Anatomy—Atlases.**

    **Horses—Anatomy—Atlases.**

  o *Geographic* – look for instruction (May Subd Geog) or look at 008 coding field, countries can be added directly to heading, other units should have country inserted except for states and provinces, if more than one place is indicated, use separate headings for each place:

    **Raffia work – Belgium.**
    **Floppy disks – Iceland – Reykjavik.**
    **Molecular biology – Manitoba.**
If you are using the web version of Library of Congress Authorities, look at 008 field, position 6 (counting in from 0). If there is a “i,” you can subdivide geographically, but if it is blank, you cannot.

For example:

Prayer
  008 860211i| ananbabn |a ana (can subdivide)

Dioceses
  008 860211i| ananbabn |a ana

Religion
  008 860211 | ananbabn |b ana (cannot subdivide)

Outside Canada, US and Great Britain, the collecting level is the country. Inside Canada, US, and Great Britain, the collecting level is the province, state, or constituent country. For other countries, the collecting level is the country:

Dioceses— Missouri — St. Louis.

Prayer— Ontario — London.

Prayer — Scotland — Dundee.

Dioceses — Germany — Frankfurt.

- Put the geographical subdivision in the correct place if using with topical subdivision:

  Goats (May Subd Geog)

  -- Breeding

  -- Equipment and supplies

  Goats—Scotland—Breeding.

  Goats – Breeding – Scotland.

  Goats – Scotland – Equipment and supplies.
• Put the geographical subdivision before a free-floating subdivision.

  o *Free-floating* – added to improve subject description, most apply to all headings, but some can be used only with certain heading types, make separate headings if need to use more than one free-floating subdivision (don’t combine), you can have geographical and free-floating subdivisions in same heading.

**English language – History – 17th century.**
APPENDIX III ORAL HISTORY

This discussion is based on best practice guidelines from the Oral History Association. 16

Hold a pre-interview meeting
- Obtain the interviewee’s agreement to be interviewed and schedule a pre-interview meeting. During this meeting, give the interviewee information about the topics you will be discussing, why you are doing the interview, how you will do the interview, and have the consent form signed (one for each interview.)
- Make sure the interviewee understands that the interview will be recorded and be preserved in the archive and may be available for others to listen to. Make sure she understands that copyright will belong to the archive.
- Explain that the interview will be 30 minutes long and agree on a quiet location for recording where you will not be interrupted. Try not to exceed 30 minutes.

Prepare for the interview
- Prepare an outline of interview topics and open-ended questions to use as a guide, but do not rely on it. Allow the interview to flow like a conversation and allow the interviewee to make detours.
- Find a quiet location in which to conduct the interview where there will be no interruptions, including visitors knocking at the door or telephone ringing. If necessary, put a Do Not Interrupt – Recording In Progress sign on the door.
- Test your equipment before the interview to make sure the battery is charged, and everything is working.

During the interview

- At the beginning, record the name of the interviewee and your name, the month, day and year, and the location of the interview. For example:

  "Today is Thursday, October 23, 2014, and this is an interview with Sister Jane Smith at her home at 485 Windermere Road, London, Ontario. My name is Beth Brown, and we’ll be talking about Sister Jane’s memories of working as a nurse at St. Joseph’s Hospital."

- Keep the digital recorder or video camera running throughout the interview. It is very easy to turn it off or pause it, and then forget to turn it on again! It is also easy to miss critical information when it has been paused and then the interviewee starts talking again before you can hit the record button.

- Make eye contact and minimize the time spent looking at your outline or adjusting your equipment. Nod to encourage the interviewee to keep speaking and to show you are listening. Listen carefully! You may need to ask probing or follow-up questions.

- If your question triggers another memory, allow the interviewee to move away from your question and talk about something else she remembers. This may lead to exciting new discoveries!

- Respect the right of the interviewee to refuse to discuss a subject. Do not challenge or argue with an interviewee on any topic. Do not voice your own opinions, even if you disagree with the interviewee’s opinion.

- Don’t interrupt. And be careful – sometimes people just pause at the end of a sentence to gather their thoughts or because they are thinking. Give them time before you ask another question. Often, they will indicate that they are finished talking if the pause is too long.

- Try to end the interview at 30 minutes. If the interviewee is tiring before 30 minutes, end the interview sooner.
Have good questions

- The main goal is to encourage a relaxed, conversational atmosphere as opposed to a formal interview.
- Don’t be the one doing all the talking. Just ask questions to get the conversation started, to keep it going, and to clarify any points. Your voice should not be the one that is mostly heard on the tape.
- Ask open-ended questions, not closed questions. Open-ended questions are WH-questions (who, what, when, where, why, how). Closed questions are yes-no questions. Think about this - which question is likely to get a fuller response: “Did you enjoy nursing?” or “What did you enjoy about nursing?”
- Use short questions, not multiple part questions. For example, avoid “Can you tell me about leaving home to enter the convent and how you felt?” Ask instead, “What was it like leaving home to enter the convent?”
- Don’t ask leading questions. For example, avoid “Wasn’t it great to live in Windsor during the boom years?” Ask instead, “What was it like living in Windsor during the boom years?”
- Use follow-up questions to get more detail. For example, “When did that happen?” “What did you think about that?” “Can you give me an example?”
- Make sure you get clarification about anything that is unclear. If the interviewee uses hand gestures or points to something, make sure you follow-up with a question so the information is recorded, e.g., “Do you mean it was a winding road?”
- Make a brief statement at the end of the interview, for example, “This is the end of the October 23, 2014, interview with Sister Jane Doe.”
After the interview

- Fill out the oral history datasheet. This is a written record of the date of the interview, the participants, the length of the interview, and a short summary of the interview. The archivist needs this to accession the recording.
- Listen to each interview afterward to see how you can improve your interviewing techniques.
- Follow procedures for saving digital audio recordings in Section 16.
- If the sound recordings are to be transcribed, it will take six hours for every one hour of sound recording unless you use speech recognition software like Otter.ai. In this case, it takes about three and a half hours to transcribe and check one hour of sound recording.

Using speech recognition software and captioning videos

To make audio transcripts
Log in to Otter.ai (https://otter.ai/)

Import the audio.
Choose the three dots at the top-right corner of the screen and choose “Move” to move imported audio file to the TO DO folder on left menu bar.

Click on desired audio file in TO DO folder.

Click “Edit” button and identify speakers.
Listen to audio and make appropriate corrections as needed.

Shortcuts:

Keyboard shortcuts for Audio playing

- Ctrl-Space or ESC: Play / Pause
- Ctrl-R or Left Arrow: Rewind 5 seconds
- Ctrl-3 or F3: Slow down
- Ctrl-4 or F4: Speed up

Keyboard shortcuts for Transcript editing

- Enter or Return: Insert paragraph break.
- Backspace or Delete: Delete paragraph break and merge with previous paragraph.
- Ctrl-Z: Undo an action.
- Ctrl-Y: Redo an action.

Once all corrections are made, click the “Done” button.
Choose the three dots at the top-right corner of the screen, then “Export text” to export transcript.

Choose DOCX (Microsoft Word) as the “Export format.”

You can select additional options by moving the sliders:
Click “Continue” and save file to computer drive.

Delete any completed files by choosing the three dots at the top-right corner of the screen, then “Delete.”
To make video captions
Import the video in Otter.ai.

Make corrections to the video transcript as you do for audio transcripts.

When finished, choose the three dots at the top-right corner of the screen, then “Export Text.” Select “SRT” as the “Export format.”

Select options by moving the sliders as shown below:
Select “Continue” to export the file and save it to the computer drive.

When you are finished, log out by choosing the C button on the left menu bar.

Adding captions to a video
Log in to Vimeo (https://vimeo.com/) and choose “Videos” under account:
Double click on video you want to add captions to:

Choose “Advanced” from right hand menu:
Choose “Distribution” from left hand menu:

Choose “Subtitles” next:
and then click on + sign and select options. Select SRT file from computer drive:

Make sure slider is moved to right and then “Save” when done:
APPENDIX IV DECEASED SISTERS

When a Sister dies, the Deceased Sisters’ Personal Records Policy and congregational records retention and disposal schedule must be followed. All files relating to deceased Sisters should be transferred to the archive by January 1st of each year at the latest. These records are used to prepare biographies of Sisters.

Recording and storing biographical information
The Congregational Archivist will record the death date, name of Sister, and diocese with which she is affiliated on the table of Deceased Members-Main. Copies of the obituary are printed and placed in the Sister’s personal file and in the obituary binder.

Electronic copies of the obituary and any eulogy or reflection renamed following the format “Obituary-Surname” or “Reflection-Surname,” and is stored as a PDF/A in the Biography-Main folder on the computer, in subfolders organized by year.

The drop file for a living Sister and transferred files relating to a deceased Sister are to be combined by archive staff, who apply a standard order to all files, following the instructions given here.

1. Undertake basic preservation. Make sure small or fragile records are enclosed separately. Replace acidic enclosures. Photocopy newspaper clippings or put in an acid and lignin free sling and discard the original clippings. Paper clip pages together if they belong together. Remove all plastic, sticky notes (copy important metadata first), paper clips, etc. Use a yellow folder for the outside enclosure.

2. Very old or fragile photographs should be enclosed separately, otherwise place several same sized photographs together in an enclosure. All enclosures should be labelled with Sister’s name at the top.

3. Complete the vital records checklist. This will go at the very front of the folder.
4. Organize records as follows:
   a) Vital records checklist.
   b) Data forms (include all duplicates).
   c) Vital records (in a long white envelope labelled with the Sister’s name at the top).
      Include anything that has vital record information, even if it is not on the checklist.
      Do not include duplicates unless small or fragile. Place duplicates with miscellaneous records near the back of the folder. Do not include data forms in the envelope.
   d) Personal health records (in a white folder labelled with the Sister’s name, year of death, and “restricted”). Place any health records that are not indicated on the vital records checklist in the secure shredding bin.
   e) Photographs.
   f) Correspondence (to, from or about the Sister during her lifetime. Correspondence received after death goes with miscellaneous records.
   g) Miscellaneous (including duplicate vital records).
   h) Certificates (in a white folder labelled with the Sister’s name).

5. If combining material from one file folder with another to reduce the number of folders make sure that if there are any accession numbers, these are transferred to the new folder.

For deceased Sisters in the London diocese, three further steps are taken:

1. Update all files in the Biography-London folder on the computer, including the subfolders London Sister Dates and London Sister Names.

2. Using the Obituary Index-London, number and file a print copy of the reflection and obituary in F01-S097 Death Records series.

3. Note the date of death in the binder containing reception and death information.
Preparing biographies
The Congregational Archivist is tasked with preparing biographies of deceased Sisters by mid-January of each year for the Federation *Dictionary of Biography* database. Until the Peterborough archive is consolidated, staff should send biographies for entry into the database directly to the Congregational Archivist, not to the Federation Archivist. All biographies for the congregation will be edited and the data entered in the database by the Congregational Archivist. Following this, biographies for the preceding year will be downloaded and sent to the Federation Archivist.
APPENDIX V PRESERVATION METHODS

Pest control
Practice integrated pest management by checking insect traps frequently. If insects are found, follow this procedure:

For flying insects, spray with Windex until you can catch it.

Using tweezers, carefully place the insect in a clean container that has been half-filled with isopropyl alcohol. Once the insect has sunk to the bottom, slowly add more isopropyl alcohol. Label the jar with the date and location.

Identify using a hand-held microscope.
How to make an L-enclosure

1. Measure the height and width of the photograph or artwork.
2. Cut two sheets of mylar film the same size but allowing 1” extra on all sides.
3. Place one sheet of mylar lined up squarely along the grid lines of a self-healing mat. Put a weight on top.
4. Using the grid lines on the mat, apply a piece of 3M #415 encapsulating tape along the left side and the bottom of one sheet of mylar, leaving a small space between each piece of tape in the corner.
5. Place the other sheet of mylar on top. Carefully, beginning with the top left-hand side, peel the paper away from the tape, pressing down on the mylar as you go.
6. Round the corners.
7. The result is two sheets of mylar sealed in an L-shape with tape. The photograph is inserted from the top right-hand side.
8. **Encapsulation** involves taping all around the item so that it is completely sealed.
How to make a simple phase box
We make phase boxes to protect fragile volumes and help prevent red rot, show in this picture:
1. You can use mapstock or archival board.
2. Measure the height, width, and spine of the book.
3. Take a sheet of map folder stock that is at least 40” x 28”.
4. Measure the height of the book along the top and draw a horizontal line.
5. Cut off the excess above this line.
6. Next, you will be measuring out five measurements across the sheet, beginning from the left side. Draw a vertical line at each measurement.
7. Measure the width.
8. Measure the spine.
9. Measure the width.
10. Measure the spine.
11. Measure the width.
12. Cut off any excess after your last vertical line.
13. Take a second sheet of map folder stock. You can probably use the excess you cut off earlier.
14. Measure the width of the book along the top and draw a horizontal line.
15. Next, you will be measuring out five measurements across the sheet, beginning from the left side. Draw a vertical line at each measurement.
16. Measure the height.
17. Measure the spine.
18. Measure the height.
19. Measure the spine.
20. Measure the height.
21. Cut off any excess after your last vertical line. If you are short on the last measurement, it is okay.
22. Fold along all the vertical spine lines using a ruler and bone folder.
23. Round all the corners.
24. Using 3M #415 encapsulating tape, attach the two parts together. Lastly, fold in, starting with bottom flap, then top flap, then left flap, then right flap.
25. Write any information on the front of the phase box using a pencil.
26. Insert the book.
27. Tie with cotton twill tape.

How to flatten rolled paper items
*Don’t use this technique with soiled items, items with tape or glue, items with friable media like charcoal and pastels, watercolors, or items with water soluble media like felt markers.

Supplies:
Plastic box with lid, plastic risers, plastic grating OR plastic garbage can with lid, small garbage can
Spun polyester (Reemay) Blotting paper
Weights
**Box type humidifier**

1. Add water to midline of risers.
2. Line rolled items with spun polyester or use weights to hold open.
3. Place on grating.
4. Cover with lid. The time will vary from a couple of hours to a few days. Check each day.
5. Remove lining, place item on spun polyester on top of blotting paper. Cover with spun polyester and another blotting paper. Weight.

For photographs, put spun polyester on edges of photo and weight edges. DO NOT put anything on top of gelatin emulsion.
Rolled items with spun polyester

Items removed from humidifier
Items under weights

**Horton type humidifier**

1. Wet blotting papers and place on sides of large garbage can.
2. Line rolled items with spun polyester.
3. Line small garbage can with spun polyester.
4. Place items inside small garbage can and cover with spun polyester.
5. Put on lid.
6. Change blotting papers every day.
Simple display mats

Supplies:
Acid and lignin free paper              3M #415 tape
4 to 8 ply cotton rag white mat board   Polyester (Mylar)
Weights

Paper channel support
1. Cut two strips of paper 3”-4” longer than the width of the item and 1” wide. Fold in half along the length to make two channels.
2. Center the item on the mat board and insert it into the channels. Close the channels and tape to the mat board across the ends of the channels.

Polyester wrap
1. Lay the item on mat board and mark the board outside the item. Remove the item.
2. Cut the mat board slightly larger than the item dimensions.
3. Cut a sheet of Mylar 4” larger than the mat board in all directions.
4. Center the mat board on the Mylar and weight it. Cut the corners of the Mylar in V-shapes.
5. Center the item face down on the Mylar and put the mat board on top. Weight it.
6. Fold over the Mylar flaps on two adjacent sides and tape to the back of the mat board.
7. Remove the weight, check the item’s position, and tape the other sides.
How to clean and repair paper

*Do not use these steps to clean pastel, pencil, charcoal, or items with flaking paint.

**Supplies:**

- Natural bristle brushes (fine, for pasting, and for dusting)
- Vulcanized rubber dry cleaning sponges (store in airtight container in the dark)
- Creped rubber adhesive pickup
- Vinyl eraser
- Powdered eraser
- Kozo paper
- Bone folder
- Corked back ruler
- Blotting paper
- Spun polyester (Reemay)
- Methyl cellulose (mix 1 T powder with ½ c distilled water, stir, let stand several hours then thin to consistency of mayonnaise with distilled water)
- Tweezers
- Weights

**Cleaning paper**

1. Remove plastic envelopes, acidic wrapping paper, cardboard backings, dried adhesive tape, and metal fasteners.
2. Don’t clean the actual media, just the paper support around it.
3. Brush with a soft brush, and after a few strokes, brush on blotting paper to remove dirt. Brush both sides of paper.
5. Gently clean small dirty areas with vinyl eraser, rubbing randomly in different directions.
6. In dirty areas, rub powdered eraser with fingertips in circular motion and brush away.
7. Use vulcanized rubber sponge by gently rubbing randomly in different directions and brushing away.
8. Dirty sponge and erasers can be cut away.
9. Don’t erase any notes on the margins or back of paper.
Repairing tears

1. Make a crease in Kozo paper using a bone folder and ruler. Draw a line with a brush dipped in water. Pull strip away from paper along this crease.
2. Cover blotting paper with spun polyester. Place artwork on top.
3. Put piece of blotting paper under Kozo paper and apply methyl cellulose with a brush.
4. Lift with tweezers and put over the back of the tear or on the side without the art or text if possible.
5. Brush with dry brush. Cover with spun polyester, blotting paper and weight.
How to clean photographs
You can use a 50:50 mix of distilled water and isopropyl alcohol and a cotton swab for cleaning water soluble dirt. These are the guidelines given by Greg Hill of the Canadian Conservation Institute:

Dampen a cotton swab with the alcohol/water mix. Roll the swab lightly across a piece of blotting paper to absorb a lot of the liquid. Then, gently roll the swab across the surface of the print. Do a small test in a corner first to make sure the emulsion/gelatin layer is not sensitive to water. If you are cleaning color photographic prints, the image can go slightly milky on the surface, but that will disappear when the gelatin dries. Try not to scrub the surface. Some prints will also curl if the emulsion is wetted out in any way, another reason for using only a small amount of moisture. You should consider putting the prints between blotters under weights immediately following cleaning. If the surface is tacky after cleaning, let it dry somewhat before putting it between blotters. You may need to repeat the cleaning a couple of times to make sure it doesn't end up looking streaked.
APPENDIX VI TEMPLATES AND FORMS

All templates and forms you will need are included in this section.
SEPARATION SHEET

Items:

Original location:

Current location of items:

Reason for removal:
## Photographs

<table>
<thead>
<tr>
<th>Fonds and series title</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>--</td>
</tr>
<tr>
<td>Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>--</td>
</tr>
<tr>
<td>Extent</td>
<td></td>
</tr>
<tr>
<td></td>
<td>--</td>
</tr>
</tbody>
</table>
WITHDRAWAL SHEET

In the review of this file, the item(s) identified below are restricted to access:

Fonds and series number:

_______________________________________________________________

Title: __________________________________________________________________________________________

What is restricted (list all series and files. If single items only, list them):

Who is allowed access:

___________________________________________________

Authority for the restriction:

_____ (1) Protection of the privacy of living persons

_____ (2) Information restricted by statute or court order

_____ (3) confidential business and financial information

_____ (4) confidential decision making

_____ (5) request made in deed of gift or by transferring office

Date: _________________________________________________________________
CONDITION REPORT

Assessment Date: _____________________________________________________

Object Name: _________________________________________________________

Identifier (Accession Number): __________________________________________

Purpose of assessment:

☐ Accession  ☐ Exhibition  ☐ Loan  ☐ Inventory

Inspection Results:

☐ Excellent condition  ☐ Good condition  ☐ Fair condition  ☐ Poor condition

Materials (check all that apply):

☐ Leather, parchment, vellum, fur  ☐ Textile  ☐ Ceramic  ☐ Metal  ☐ Plastic
☐ Wood  ☐ Glass  ☐ Paper  ☐ Stone  ☐ Other material

Conditions Noted:

☐ Alterations  ☐ Breaks  ☐ Burns
☐ Chips/dents/flakes  ☐ Corrosion  ☐ Cracks
☐ Creases/wrinkles  ☐ Discoloration/fading  ☐ Fraying
☐ Holes  ☐ Loose/missing parts
☐ Mold  ☐ Active mold  ☐ Mold stains
☐ Pests  ☐ Active pests  ☐ Pest damage or residue
☐ Scratches  ☐ Stains
☐ Tears/ rips  ☐ Warping/buckling
☐ Dirty/dusty  ☐ Other, specify under Notes on reverse
Notes:

______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

Recommendations for Treatment

☐ No treatment needed
☐ Treatment needed by conservator
☐ In-house treatment

Recommendations for Exhibition and Storage

______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

______________________________________  _____________________________
Signature                          Date
RELEASE FORM

I _________________________________ grant to the Congregation of the Sisters of St. Joseph in Canada (the Archives) the right and permission in respect of the photographs, or videotape or sound recordings and their captions and transcripts, that it has taken or has had taken of me, or in which I may be included with others, to copyright the same and use it in whole or in part in any media for publication, display, education, research, promotion, or any other purpose that befits the mandate of the Archives, and to use my name if it so chooses in connection with this.

I release the Archives from any and all claims and agree that the Archives may assign and transfer these rights. I understand that I will not be compensated. I am of full age of consent and have read this and agree to it. This release is binding on me and my heirs, executors, administrators, successors, and assigns.

_____________________________    __________________________
Name        Date

______________________________    __________________________
Witness        Date
Oral Histories Datasheet

*Please fill out this form for each interview conducted.*

<table>
<thead>
<tr>
<th>Identifier</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name(s) of interviewer(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name of interviewee(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location of interview</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date of interview</th>
</tr>
</thead>
<tbody>
<tr>
<td>(year/month/day e.g., 2014/08/04)</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Duration of interview</th>
</tr>
</thead>
<tbody>
<tr>
<td>(hour:min:sec e.g., 01:05:26)</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Keywords</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

Summary of interview (attach extra sheets if needed):
**Vital Records Checklist**

**NAME____________________________________________________________**

<table>
<thead>
<tr>
<th>Record</th>
<th>Check ✓ if in file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Birth certificate (envelope)</td>
<td></td>
</tr>
<tr>
<td>Baptism certificate (envelope)</td>
<td></td>
</tr>
<tr>
<td>Confirmation certificate (envelope)</td>
<td></td>
</tr>
<tr>
<td>Agreement and Release (envelope)</td>
<td></td>
</tr>
<tr>
<td>Patrimony records e.g., green (dowry) slip and index card (envelope)</td>
<td></td>
</tr>
<tr>
<td>Data forms</td>
<td></td>
</tr>
<tr>
<td>Last will and testament (envelope)</td>
<td></td>
</tr>
<tr>
<td>Power of Attorney for Personal Care (envelope)</td>
<td></td>
</tr>
<tr>
<td>Death certificate (envelope)</td>
<td></td>
</tr>
<tr>
<td>Obituary (envelope)</td>
<td></td>
</tr>
<tr>
<td>Reflection/Eulogy (envelope)</td>
<td></td>
</tr>
<tr>
<td>Passport – <strong>Cut off top right corner of cover</strong> (envelope)</td>
<td></td>
</tr>
<tr>
<td>Personal health information (includes records related to physical or mental health including family history, health care provider, health care payments, body part donations, health number, substitute decision maker) (<strong>white folder labelled with name, “restricted” and year of death</strong>)</td>
<td></td>
</tr>
</tbody>
</table>
Glossary

**Accession:** Materials transferred to the archive as a unit at a single time, also known as an acquisition. Also, to take legal and physical custody of a record group and document their receipt, either through transfer, donation, or purchase.

**Access copy:** a digital surrogate that is a lower resolution and saved in a compressed format for use in printing or on the web.

**Accrual:** Records that are added to an existing fonds or series.

**Acidic:** When the pH level of material is below 7, the material is acidic. Acid in a material may migrate to other materials. Paper becomes acidic due to the acids used to break up wood fibers during manufacture, the lignin in the ground wood pulp base, the chlorine added to bleach it, and the alum rosin used for sizing.

**Archival processing:** The arrangement, description, and housing of archival materials for long-term preservation and for access by patrons.

**Arrangement:** The process of organizing materials with respect to their provenance and original order, to protect their context and to achieve control over the materials. Records are organized hierarchically into fonds or group, sous-fonds or sub-group, series, subseries, file, and item.

**Artifact:** An object which is not text, an image, audio recording or moving image. Usually refers to an object made by a person, such as a vase or tapestry.

**Bit depth:** For audio digitization, this refers to the dynamic range. The higher the bit depth the more data. 8-bit is how image data is stored electronically. Each pixel is made up of one 8-bit byte. Bit depth is measured in 8, 16, 24 or 48-bits. If compared to a staircase, bit depth is the number of steps. For image digitization, bit depth is the number of bits used to represent the color of a pixel.
**Channels:** For audio digitization, sound may be recorded in one channel or mono, or in two channels or stereo.

**Checksum:** An MD5 checksum is produced by software that reads the bits in a file and generates a unique 32-character alphanumeric string or a “hash value.” This string can be compared with a string resulting from running the software again at a later point. If the strings are the same, the file has not been changed. In BWF MetaEdit software the checksum is run on the audio data so that editing metadata does not change its value.

**CMYK:** Cyan, magenta, yellow and key (black). This is a color model used for printing. The three-color inks plus black are combined on white paper to form images.

**Collection:** A group of objects or records artificially brought together which have different provenance. Often the objects or records are organized by subject, as in a library collection of books.

**Color depth:** known as bit depth. The number of shades of grey or colors in a pixel measured in bits. A bitonal (black and white) image is made up of one of 1-bit (2^1 or 2 colors) per pixel. Grayscale images are made up of one of 8-bit (2^8 or 256 colors) per pixel. Color images are made up of one of 24-bit (3 colors, 8-bits per color, 256 x 256 x 256 =16 million colors) per pixel.

**Color profile:** The range of colors or gamut that can be displayed or printed. Adobe RGB is a wide gamut space that allows more color information to be captured.

**Conservation:** The repair or stabilization of materials through treatment; the act of restoring damaged materials.

**Description:** The process of analyzing, organizing, and recording information about the elements of a record or record group such as creator, title, dates, extent, and administrative history or biographical sketch, to facilitate management and accessibility of the records. This process generates an archival description, also known as a descriptive inventory. Records may be described at the fonds level, the series level, the file level, and the item level.
**Disk image:** this is a way to copy an entire drive. Besides copying files, it will also copy empty space, deleted files, and hidden files. A disk image can be created using software like **FTK Imager** or **Guymager** in **Bit Curator**.

**Dot gain:** this describes how much ink will spread on paper when printing.

**Dynamic range:** This is the ratio between the largest and smallest value in an image (brightest and darkest pixel) – if compared to a staircase, it is the height of the steps. A scanner should have a dynamic range or DMax (darkest black measurement) of 4.0

**Enclosure:** A container used for storage, for example an envelope, a phase box, a folder, or a box.

**File:** Records which are organized at a level below that of the series; the basic unit of the series. At the file level, records may be organized alphabetically, chronologically, geographically, or some other way.

**Finding aid:** A tool that helps the patron discover information about records, for example a list of folders in a box, a list of series and files within a fonds, or an archival description of a fonds or series.

**Fonds:** The whole body of records created by an organization, family or individual that have been created or kept by that entity during regular activity and which reflect the functions and activities of the entity. Also known as a record group.

**Grayscale:** A grayscale image has a single channel, with tones ranging from black to white. It may be either 8-bit (256 levels) or 16-bit (65,536 levels). A color image has three 16-bit grayscale channels (R, G, B) for color and brightness. These are 48-bit images which can be downsized to 24-bit images.

**Item:** The individual records contained within a file; the basic unit of a file. An item is complete, although it may have separate parts, such as a letter and its envelope.
**Logical copy**: this means copying selected files only, and no deleted files, no file system features, and no empty space. A logical copy can be created using software like **Data Accessioner**, **Bagger**, and **Teracopy**.

**Metadata**: Information about the record that describes its context, content, and structure. This information is critical for future preservation.

**Migration**: Converting material from one software or hardware to another, for example, converting Word Perfect files to Microsoft Word files.

**OCR**: Optical character recognition is the electronic conversion of an image into readable text by identifying characters as computer code and saving as a text file.

**Original order**: The organization and sequence of records established by the creator of the records.

**pH level**: A scale from 0 to 14, where values below 7 are acidic and above 7 are alkaline. Buffered materials contain calcium carbonate to raise the alkaline level.

**PPI**: stands for pixels (picture elements) per inch which is how to properly talk about image resolution. DPI or dots per inch is how to talk about printer resolution.

**Preservation**: Keeping materials safe by providing non-invasive, reversible treatment, environmental control, and planning for emergencies; the act of preventing damage to materials.

**Preservation master**: a digital surrogate which has had minimal adjustment made and which is high resolution, uncompressed, non-proprietary format, and contains metadata.

**Provenance**: The origin or source of something, or the person or body that created, acquired, used, and kept records during daily activity.

**Record**: Information recorded in some form which provides evidence of activity and can help ensure accountability for future actions and decisions.
Reformat: To make a copy with a format or structure different from the original; to migrate information from one carrier to another. Reformatting typically means making analogue copies, for example, by microfilming the originals, or making copies on non-resin coated, acid and lignin free paper.

Refresh: To copy material on a specific storage media onto a new version of the same media e.g., to copy material on a DVD-R onto an archival gold DVD-R.

Resolution: this determines the quality of an image and is described by the pixel dimensions (height and width) of an image or by its size (PPI). Higher resolution images contain more information and are bigger in size.

Respect des fonds: The duty of an archivist to keep fonds separate depending on their provenance, and to maintain the original order of the records within the fonds as much as possible, to ensure the integrity, reliability, and authenticity of records.

RGB: Red, green, and blue. This is a color model where colors are added to get the correct color. White is all three-color channels at full intensity, and black is the lack of light across all three-color channels. This is a common color space used to view images on computer monitors.

Sample rate: For audio digitization, the number of samples per second is measured in Hz. The sample rate may be 44.1 kHz or 96 kHz.

Series: A group of similar records that are arranged according to a file plan, and are related as the result of being created, received, or used in the same activity; the basic unit of a fonds or sous-fonds.

Service master: a digital surrogate which has had some adjustments made and which is saved in an uncompressed, non-proprietary, high-resolution format. The adjustments which may be made include cropping, rotating, optimizing tone levels, managing color, cropping out color target, converting bit depth (16 > 8 for grayscale; 48 > 24 for color), and deleting dead air at beginning and end of audio file.
**Sous-fonds:** A smaller record group within a larger fonds, with a distinct creator who is subordinate to the creator of the fonds. For example, the records of an individual within a family. Also known as sub-fonds or sub-group.

**Subseries:** Records within a series that can be differentiated from the series by filing arrangement, type, form, or content.\(^{17}\)

**Tonal dynamic range:** this is the color space between pure black (0) and pure white (255). It is shown as a histogram in Photoshop that represents the number of pixels in an image at selected values from black to white.

**24-bit RGB:** This refers to 24-bits per pixel in which three 8-bits between 0 and 255 represent red, green, and blue colors.

Index

abbreviations, 21, 28
Access copy, 131, 233
access points, 59
Accession, 28, 233
Accrual, 233
Acidic, 233
Archeion, 56
archival description, 44, 55, 59
Archival processing, 233
Arrangement, 233
Artifact, 28, 233
artifacts, 11
authority record, 50, 52, 56
bit depth, 234, 238
Checksum, 234
CMYK, 88, 234
Color depth, 234
Description, 9, 52, 124, 138, 141, 150, 151, 152, 234
DPI, 236
Encapsulation, 213
file, 24, 26, 28
File, 28, 89, 124, 125, 131, 134, 137, 140, 142, 145, 147, 148, 163, 235
Finding aid, 235
fonds, 24, 26, 28, 40, 44, 55, 56, 59
Fonds, 26, 28, 235
Item, 28, 236
Metadata, 9, 123, 124, 150, 236
migration, 162
Migration, 162, 236
Optical character recognition, 236
Original order, 236
photographs, 11, 15, 56, 57
PPI, 88, 236, 237
Preservation master, 131, 236
Provenance, 237
RAD, 9, 21, 40, 41, 42, 56, 59
Reformat, 237
Refresh, 237
refreshing, 162
Refreshing, 162
Resolution, 89, 237
respect des fonds, 9
Respect des fonds, 237
RGB, 88, 89, 237, 238
series, 23, 24, 26, 28, 38, 41, 43
Series, 26, 28, 237
Service master, 131, 238
Sous-fonds, 238
Subject Headings, 32
subseries, 23, 24, 26, 38
Subseries, 238